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A Note on Versions
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Text pertaining both to the 32-bit and 64-bit versions of The
Animation Stand appear as does this paragraph.

32 bits:  Text pertaining only to the 32-bit version appears as does
this paragraph.

64 bits:  Text pertaining only to the 64-bit version appears as does
this paragraph.

Before You Begin

Before proceeding with this manual, you already should be
thoroughly familiar with how your machine works.  If you are not,
study the manuals that came with your machine.  You should know
how to:

•  use the mouse, trackball, or tablet,

•  access menus, and

•  use the shell.

It is not necessary to have a 32-bit display to do 32-bit work, or a
64-bit display to do 64-bit work.  The Animation Stand is capable
of using monitors of any depth for any type of work.

You should also be familiar with and know how to use all of the
peripherals and add-in units connected to your system.
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Also, it is important that you consider what you want to accomplish
using The Animation Stand.  If you are just getting into
animation, the answer is simple.  The Animation Stand will allow
you to begin learning about the animation process.  As your
knowledge increases, The Animation Stand will provide the tools
to explore each new element.  If you are using this product to
augment an existing animation studio, however, you will most
likely use The Animation Stand to increase productivity, lower
production costs, or give your product a better look.  If this is the
case, please pick just one of these noble goals, and stick with it;
you'll find great success.  Trying for two of the above, or all three is
a road likely to lead to disaster.

Installing The Software

To install The Animation Stand on your hard disk, from CD,
execute /CDROM/install.  To install from tape, execute tar xv.

Installing an external controller

If you are using an external recorder controller, you must also do
the following:

Step 1 Connect the RS-422 port of your recorder to the RS-422
port of the controller, as you usually do.

Step 2 Connect the output of your main video card to the video
input jack of your recorder.

Step 3 Connect the video output jack of your recorder to your
main monitor.

Step 4 Connect the controller to a serial port.
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If you are using the Abekas recorder, you must also do the
following:

Step 1 Cable the computer to the A60 or A64 recorder so that
the computer modem transmit pin is connected to the
GPI input pin, and connect ground to ground.  If using
an A66, connect with a null-modem cable.

Step 2 Set the A60 or A64 recorder to record a single frame on
a GPI pulse using the recorder’s macro facility.  Set A66
to REMOTE.

Step 3 Connect the output of your main video card to the video
input jack of your recorder.

Step 4 Connect the video output jack of your recorder to your
main monitor.

Installing a Sony Video Disk

If you are using a Sony video disc recorder, you must also do the
following:

Step 1 Cable a serial port to the disc recorder controller's
external control input.

Step 2 Set the recorder to Remote operation.

Step 3 Connect the output of your main video card to the video
input jack of your recorder.

Step 4 Connect the video output jack of your recorder to your
main monitor.

Step 5 Set the LVR controller to a baud rate of 9600 baud.
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If you are using the Hitachi time-lapse recorder, you must also do
the following:

Step 1 Connect a serial port (data transmit and data ground) to
the external trigger connector in the recorder.

Step 2 Connect the standard video output of your display card
to the video input jack of the recorder.

Step 3 Set the recorder time mode to 00 (on demand).

Installing a Sanyo Deck

If you are using the Sanyo recorder, you must also do the following:

Step 1 Connect the RS-232 port of your recorder to a serial
port.

Step 2 Connect the output of your main video card to the video
input jack of your recorder.

Step 3 Connect the video output jack of your recorder to your
main monitor.

Product Support

If you have any questions about The Animation Stand and you
can't find the answer in the manual, call your dealer, or our
technical support personnel at 714-552-1904.  When you call, please
have the following ready:

• your program serial number

• your The Animation Stand manual

• your machine

Alternatively, you may fax a Software Problem report to Linker
Systems, Inc., at 714-552-6985, eMail it to linker@linker.com, or
mail the report to us at 13612 Onkayha Circle, Irvine, California
92720.
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All of the files listed here appear in /usr/TASfiles

Tutorial Files Included
mountain.rgb and skier.rgb files are used throughout this tutorial.
Once you are through with the tutorial, these files may be erased.

Palette Files Included
These files each contain a palette.

• 256ColorPalette contains the standard 256 Color Palette.
Should you be working in the 256 color mode and ruin your
standard palette, you may switch back to it simply by opening
this document.

• 8ColorPalette contains the colors used in 8 color printing:
White, Black, Red, Green, Blue, Cyan, Yellow, and Magenta.
This palette is useful when preparing documents for 8 color
printing, such as with the ThinkJet.

• grayPalette  contains 256 shades of gray.

• NTSCPalette is a palette consisting entirely of NTSC-legal
colors.  Using this palette, you should not have any
displayability problems on NTSC.

• marblePalette, metalPalette, earthtonePalette, rainbowPalette,
forestPalette, and skySeaPalette each contain color sets which
should be most useful in painting certain kinds of pictures.

You are not limited to the palettes and patterns which we supply.
You can save any palette and/or pattern set at any time, and place
them into the folders with the palettes and patterns which you
already have, or put them in any folder on any disk you like.

Pattern Files Included
Two pattern files are included.  colorPatterns and colorPatterns#2
each contain 32 color patterns, and is the default set of patterns.
bwPatterns and bwPatterns#2 each contain 32 black-and-white
patterns.

Image Files Included
There are a number of texture files supplied with The Animation
Stand.  These textures are useful as surfaces of objects (see
information on the “Wrap” tools in subsequent chapters) and in
supplying basic or underlying textures in partial color component
modes (see information on these in the Modes chapter).  There are a
number of texture disks, each with about three textures on them.
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Texture Files Included
There are a number of bump-map files supplied with The
Animation Stand.  These bump-map files are useful as drawing
surfaces (see information on “Bump mapping” tools in subsequent
chapters) and in supplying basic or underlying textures in partial
color component modes (see information on these in the Modes
chapter).  There are a number of bump-map disks, each with a
number of bump-maps on them.

Aborting an Operation

Any time-consuming operation can be canceled.  To cancel an
operation, use escape

Where to Go From Here

Where you go from here depends on how you like to work, what you
want to do, and how you like to learn programs.  You should first go
through the animation portion of the tutorial section of this
manual.
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Start-up options

To start The Animation Stand, type TAS.

When the program starts up, it will look in /usr/TASfiles, and load
a file named Color.pats.  In this file, it  expects to see its default set
of patterns.  If this file is not present, you will get an error message.
Then, it looks for a file named Default_prefs.  If this file is found, all
of the preference items in the file, including palettes, PF keys, etc.,
will be loaded.  Thus, if you want to set up any system-wide
preferences, place them into t /usr/TASfiles/Default_prefs.
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The Steps in
Animation

This drawing represents a simplified version of the various steps in
producing an animated production.  The process of animation
begins with an idea.  From this idea, the characters and story are
developed.  Once that's done, you can write your script or scripts.
After the script is written, the cast needs to produce a sound-track,
and have it recorded onto tape or film.  The artist also needs to
begin drawing the cel and background art.  This normally begins
with line art and ends with completed character and background
art.  The chief animator writes an Exposure sheet, which correlates
motion, sound, and art.  Once the Exposure sheet is written, and
line art has been drawn, it is possible to run a pencil test, to get an
idea of what the final product will look like, and how the characters
move.  Optical press and other special effects may be added by
specifying them on the Exposure sheet.  Last, the final result is
placed on tape or film.

Concept/
Storyboard Script

Record
Sound-track Line Art

Write
Exposure Sheet

Ink & Paint Pencil Test Write Optical
Notes

Output
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The Script
The script is a real script, or story-board.  Using the script, you first
decide what you are up to, what you are doing, and where you are
going with the animation.  No program can produce a good
animation for you — you need a good script.

The Sound-Track
The sound-track is usually prepared directly from the script.  You
place the sound-track on tape or film, annotate the Dialog field of
the Exposure sheet from the sound-track, and animate to that.
When you work this way, and then lay the animation onto the same
tape, you always get perfect synchronization between picture and
sound.  For on-screen uses, you can digitize sound files using any
sound program you like, and add sound files into the Exposure
sheet.  This is called "comp" (for "comparable" sound), since the
sound output seen during on-screen playbacks cannot exactly be
frame accurate on the computer.  Note, though, that everything else
the program does is frame-accurate.

Line Art
Line art and Ink
& Paint are
handled through
the Paint
module.

The cel layers are the artwork which are layered over the
background.  What you see in each frame is the stack of cel art and
whatever background can be seen through the cel art.  By using
these cel layers, you alleviate the need to redraw the entire frame
— you need only draw what changes from frame to frame.  No
redrawing is needed to compensate for motion, rotation,
magnification, or change of aspect ratio.  Cel layers differ.  You can
be stored with transparent areas, thus, in effect, storing non-
rectangular documents.  There is no requirement that the cel layers
and backgrounds be at the same color depth, resolution, or size.
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Writing the Exposure sheet
Exposure sheets are handled in the animation module.  An
Exposure sheet is a form used by the animation industry to denote
what happens during scenes in an animation.  The Exposure sheet
describes each exposure, or frame, of the animation.  The
background and each layer of the animation is called out, along
with a sound-track reference, positions and other information for
each piece of art, and notes for special effects, the multiplane
camera, the lab, the cutting room, and anywhere else work is done
on the film.  You can get a more detailed explanation of the
Exposure sheet in the sections which describe how to run the
program, or how to build a sample animation.  The Animation
Stand provides three views of the film.  If you change the position of
a layer in the Current frame window, the Exposure sheet
automatically updates.  If you change the Exposure sheet or the art,
the Current Frame window will automatically reflect these changes.
The Exposure sheet Window has two possible views.  In the primary
view, you get a list of frames, top to bottom.  Each frame consists of
a list of layers, background to foreground, top to bottom.  In the
alternate view, you get thumbnail sketches of the background and
each cel layer used in each frame listed, left to right.  You can
switch between these two views by clicking in the top line of the
Exposure sheet.  The Current Frame window shows you what the
current frame looks like at all times.

Pencil Testing
Pencil test mode allows you to see your animation on the screen at
up to 60 frames per second.

Writing Optical Notes
The optical press emulation module allows a full range of optical
and special effects to be added to the animation.

Output
You have a wide variety of output devices available, including the
screen, tape, film, disk files, and video disk, all frame-accurate.
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The object of these exercises is to build an animation of a ball
bouncing, taking some time to explore some side-avenues.
Although there are a lot of steps in the examples below, don't be
alarmed.  There are so many steps because we're showing you an
entire set of techniques, covering most, if not all, of what you will go
through to put a typical film together.

There are two interfaces provided.  The spreadsheet interface (very
close to the traditional animation interface) provides you with the
most detailed information about your work.  The iconic interface
allows you to see time and layers independently.  Please read both
sections, as you will need information presented in the spreadsheet
interface text whether using the spreadsheet or the iconic interface.

Spreadsheet Interface:  Creating the Elements

Step 1 Press ALT-N (New cel from the File menu) to get a
new paint window.

See Paint
Section for an in-
depth
description of
how to create a
sphere.

Step 2 We'll first paint a floor for the ball to bounce on.  Select
the filled polygon tool by mousing down (using the left
mouse button) on the open polygon tool and holding it.

Step 3 The polygon tool list will appear in the status window.

Step 4 Left-click the filled polygon tool.
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Step 5 Select a color suitable to be a floor by clicking in the
color/pattern selection area.  The palette will appear.

Step 6 Left-click on a color you'd like to use for drawing a floor.

Step 7 Paint a polygon as follows:

This will be your “floor”.
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Step 8 Select Save as from the File menu.  A standard Save
dialog will appear.

Step 9 Enter Floor as the file name and click Document.  The
Save dialog will disappear, and the file will be saved.

Step 10 Press ALT-W (Close from the File menu) to close the
file.

Step 11 Press ALT-N (New cel from the File menu) to get
another new paint window.
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Step 12 Select the circle tool to paint a ball.  Do this by mousing
down on the circle tool set marker, and holding the
mouse:

Step 13 The circle tool palette will appear in the Status window.

Step 14 Click on the filled circle tool.

Step 15 Select another color or pattern for the ball.

Step 16 Paint a circle to be the ball.

Step 17 For some things we'll do later, we'll need to have a
registration point at the center of the ball.  Select the
registration point tool by clicking on it:

Step 18 Click at the center of the ball.  The registration
crosshairs appear.

Step 19 There's no reason for us to keep looking at the
registration crosshairs.  Let's hide them.  Center-click on
the registration point tool, and the + mark vanishes.

Step 20 Use the marquee tool to roughly outline the image of the
ball, and release the mouse.  The marquee will shrink
down and only the ball will be selected.

Step 21 Press ALT-= (Save area from the File menu) to save
the selected area.  A standard Save as dialog will
appear.

Step 22 Enter the name Ball and  click on Document.  The
dialog will disappear, and the document is saved.

Step 23 Press ALT-W (Close from the File menu) to dismiss the
ball window.
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Step 1 Press ALT-R (New film from the File menu) to create a
new Exposure sheet.

Step 2 Center-click the number 1, under the Frame header
and to the left of the End of film marker.  This will
open a new frame, of one layer.

Step 3 Center-click the number 1, under the Frame header
and to the left of the new, empty layer.  This will open a
new layer, at the beginning of the frame, giving you a
single frame of two layers.  The first of these layers
shown to you is the background layer.  The second one
is, in this case, the foreground layer.  At this time, both
are empty.
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Step 4 Center-click in the first, empty File field, to insert a
picture into the background layer.  The Open dialog will
appear.

Step 5 Shift-click on the file Floor.  This will load the file Floor
into the first File field, and move the selected area down
one layer, and leave the Open dialog present.

Step 6 Center-click on the file Ball.  This will take down the
Open dialog and insert the file name into the Exposure
sheet as the first foreground file.  You should now have
an Exposure sheet that looks like this:

Spreadsheet Interface:  Manipulating the Elements

Step 1 Now you've got the files you'll need, and they're in the
right order, but the pictures are not in the right place.
To get the pictures in the right place, it's easiest to work
with the Current Frame window.  Click in the drag bar
of the Current Frame window.  The Current Frame
window will move in front of the Exposure sheet
window.

Step 2 Let's get the floor into position first.  The floor should be
at the bottom of the frame, centered.  To move the floor,
which is the first cel layer in our stack, click in the 1 of
the layer selector.  The 1 will highlight.  Shown below is
the selector.

Step 3 Mouse down on the floor.  Move the floor to the desired
position and release the mouse button.
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Step 4 Now, let's get the ball into position.  The ball should be
resting on the center of the floor, in its bounce position.
What we're really trying to do here is to set up an
animation with key frames showing a ball in a high
position, a low position, and a high position again.  So
far, you've set up the ball into the low position, which
should look something like this:

Step 5 You have now set up your first frame.  Now, let's set up
a ball in an “up” position.  Mouse down over the 1 in the
frame number field, and keeping the mouse button
depressed, move the cursor one line down, then release
the mouse button.  This will select (blacken) both layers
of the first (and only) frame.  Alternatively, you could
have used ALT-A (Select all from the Edit menu) to
just select everything.

Step 6 Press ALT-C (Copy from the Edit menu) to copy the
whole thing into the clipboard.

Step 7 Click on the 2 in the frame number field, selecting the
End of film marker.

Step 8 Press ALT-V (Paste from the Edit menu) to insert
another copy of the frame.  The End of film marker is
not destroyed by the Paste operation, since there is
always an End of film marker.  You now have two
identical frames, numbered 1 and 2.

Step 9 We want to raise the ball to its terminal (after bounce)
position, which is also going to be the initial position.
Select the second frame by clicking the 2 in the frame
number field.

Step 10 Let's switch to the Current Frame window.  Now,
mouse down over the ball, and drag it up to a good
ending (as well as starting position).  Notice by
manually moving the ball, you have probably not placed
the ending position in exactly the same position as the
beginning.  Don’t worry.  In the next few steps we will
explain how to correct this.
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Note:  We could have avoided this problem by using the
center mouse button to constrain movement to the
vertical direction, but then you would have missed out
on the following example of using the numeric fields to
correct the position.

Step 11 Switch back to the Exposure sheet window again.  If
the Left field of your two Ball layers have the same
numerical values, please still review these next two
steps  We want the last Left field (Ball of frame 2) to
have the same value as the second Left field (Ball of
frame 1).  Click on the last Left field.  It will highlight
to indicate selection.

Step 12 Enter the same numeric value as that of the other Ball
frame.  As soon as you press any key or mouse click, the
edit will end, and the picture in the Current Frame
window will reflect this change.

Step 13 Now, it's time to get a copy of this last frame, so that we
can also make it the first frame.  Mouse down on the 2
in the Frame field. While still holding down the mouse
button, drag the cursor down one line, then release it.
This will select the second frame.

Step 14 Press ALT-C (Copy from the Edit menu) to copy the
second frame into the clipboard.

Step 15 Click on the 1 in the Frame field, selecting the first
layer of the first frame.

Step 16 Select Paste before from the Edit menu.  This will
insert a copy of the selected frame before the current
first layer.  We use Paste before, rather than Paste,
because Paste replaces the selected item(s) with the
new item, and Paste before pastes layers in before the
selected layer.  At this point, your Exposure sheet
should look something like this:
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Step 17 You now have the three key frames:  The up position, the
down position, and another up position.  It's time to
create the movement.  We will insert an accelerated
move between frames 1 and 2, and a decelerated move
between frames 2 and 3.  Whenever we insert a
movement marker, it is inserted before the marked
frame, and after the frame before the marked frame.  To
begin, mouse down on the right arrow in the Status
window:

Step 18 Drag the Move tool onto the first line of the second
frame.

Step 21 The Move dialog will appear, asking you to enter the
number of frames over which you want the move to
occur.  Type 10 into the Slow in field, and click OK to
enter a 10 frame accelerated interpolation (9 new
frames, plus the existing end point).  The dialog will
disappear, and the Exposure sheet will show a new 9-
frame marker, with the frames renumbered to 1, 11, and
12.  There is nothing magic about the number 10.  It's
just a number being used in this example.

Step 22 Drag the Move tool onto the first line of frame 12.

Step 23 Type 10 into the slow out field and click OK to enter a 9-
frame decelerated interpolation.  The dialog will
disappear, and the exposure sheet will show a new 9-
frame marker, with the frames renumbered to 1, 11, and
21.  The exposure sheet should look something like this:
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Step 24 Press ALT-S (Save from the File menu) to save the
Exposure sheet.  Any time you finish a logical set of
operations, such as entering the Exposure sheet, it's a
good idea to save your work.  The Save dialog will
appear.

Step 25 Enter a file name, such as Bouncing ball, and click
Document.  The dialog will vanish as the file is saved.

Spreadsheet Interface:  Testing the Animation

Step 1 Now, let's look at a test.  To do that, you'll have to bring
the Current Frame window forward, or you'll only see
a very narrow sliver of the test going by in a mostly-
obscured window.  Click in the Current Frame
window's drag bar.

Step 2 Press ALT-J (Play or Record from the Animate
menu).  All 21 frames of the file will be shown in the
Current Frame window.

Step 3 Let's try it again with looping, and on the full screen.
Press ALT-MINUS (Set playback from the Animate
menu).  The controlling dialog will appear.

Step 4 Click on Loop to turn on looping.

Step 5 Mouse down with the right mouse button and select on
Full screen from the Where menu.  A menu will
appear showing a list of playback locations.  This
determines where output will be sent.
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Step 6 Click OK to accept the edit.

Step 7 Press ALT-J (Play or Record from the Animate
menu).  All 21 frames of the file will be shown, this time
full screen, and looping.  Playback will continue
indefinitely.

Step 8 Press escape to stop playback.

Spreadsheet Interface:  Adding Special Effects

At this point, you've completed the animation.  Now, it's time to
spice it up with special effects.

Step 1 Now, let's add squash (as in “squash and stretch”).  Click
on the Exposure sheet window's drag bar to bring it
forward.

Step 2 Click on the V.Mag field of the last layer of the middle
frame.  It will show a red zero.

Step 3 Enter 10 into the vertical magnification field, meaning
that the ball's vertical dimension will be shown at 10%
of its normal size.  Because this frame is preceded and
followed by interpolation sets, this squash will actually
affect frames 2 through 20.

Step 4 Similarly enter 100 into the other V.Mag fields.  This
means that we’re going between 100% and 10%, rather
than 0% to 10%.

Step 5 To see how the animation looks now, press ALT-J (Play
or Record from the Animate menu) again.
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Step 6 When you want to end the looped play-back, press
escape.  By changing the horizontal and vertical
dimensions of the appropriate layers or frames, you can
adjust the squash and stretch any way you choose.

Step 7 Press ALT-S (Save from the File menu) to save the
Exposure sheet again.  This brings up the Save dialog.

Step 8 Click on Document only and your file is saved.

Step 9 Select Save as Full-Speed Run from the Animate
menu to ask that a full-speed run file be generated onto
disk.  The Save dialog will appear.

Step 10 Enter a name, such as Bounce.  Click OK.  Some time
will pass as the file is created and packed.  While this is
occurring, you will see intermediate results on the
screen.  The program is using the screen storage to save
on overall storage requirements.

Step 11 Now, let's look at the full-speed run.  Press ALT-O
(Open from the File menu).  An Open dialog will
appear.

Step 12 Click on Bounce (or whatever you named the file).  The
animation will play.  Playback will be continuously
looping, since we had looping set.

Step 13 Press escape  to stop the playback.
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Creating animation & playing it      25

Step 1 Now, having seen that everything is just right, we can
set our parameters and create our final output.  For the
purpose of this tutorial, we will create a Full-speed run
as our final output.  This is by no means the only output
method available using The Animation Stand!  If you
would like your final output to be to video tape, video
disk or film, please refer to the appropriate sections
later in this manual.  Press ALT-MINUS (Set playback
from the Animate menu) to set the parameters.

Step 2 Notice that the Framing rate is set to 30.  You can
leave it at 30, or enter in any Framing rate you desire.
Click OK.  Your parameters are now entered.

Step 3 Select Save as Full-speed run, under the Animate
menu.  The Save as dialog will then appear.

Step 4 Enter in a new file name for your full-speed run and
click OK.  You will see your animation displayed one
frame at a time while the run is being created.

Step 5 To see your run, open it.
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Step 1 Last, let's take an accounting of what we've done.  Click
on the Exposure sheet window's drag bar  to bring it
forward.

Step 2 Select Document info from the File menu.  The output
shows the frames we've used, and information about the
film just created, including how long it took.

Bouncing ball

Current edit:  0:03
Total editing time:  0:03
Running time:  0:00:21
Framing rate:  30 FPS
Control sheet lines:  9
Cells in use:  2, as follow:

/usr/people/amala/Ball.Animation/Ball
/usr/people/amala/Ball.Animation/Floor

Congratulations — You’ve finished your first animation with The
Animation Stand.

Iconic interface:  Setting Up the Exposure sheet

This section assumes that you have already done the art, as
directed in the text covering the spreadsheet interface.

Step 1 Click in the columns headings bar to change from the
spreadsheet format to the iconic format.

Step 2 Center-click the number 1, under the Frame header and
to the left of the End of film marker.  This will open a
new frame.  You may use as many layers in the frame as
you like.

Step 3 Center-click in the first, empty File field, to insert a
picture into the background layer.  The Open dialog will
appear.

Step 4 Click on the file Floor.  This will load the file Floor into
the first File field.

Step 5 Center-click in the second, empty File field, to insert a
picture into the foreground layer.  The Open dialog will
appear.
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Step 6 Click on the file Ball.  This will take down the Open
dialog and insert the file name into the Exposure sheet
as the first foreground file.  You should now have an
Exposure sheet containing an iconic area that looks
like this:

Iconic interface:  Manipulating the Elements

Step 1 Now you've got the files you'll need, and they're in the
right order, but the pictures are not in the right place.
To get the pictures in the right place, it's easiest to work
with the Current Frame window.  Click in the drag bar
of the Current Frame window.  The Current Frame
window will move in front of the Exposure sheet
window.

Step 2 Let's get the floor into position first.  The floor should be
at the bottom of the frame, centered.  To move the floor,
which is the first cel layer in our stack, click in the
thumbnail image of the floor in the Layer Selector
portion of the window.  The thumbnail will highlight.
Shown below is the selector area.

Step 3 Mouse down on the floor.  Move the floor to the desired
position and release the mouse button.
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Step 4 Now, let's get the ball into position.  The ball should be
resting on the center of the floor, in its bounce position.
What we're really trying to do here is to set up an
animation with key frames showing a ball in a high
position, a low position, and a high position again.
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Step 5 You have now set up your first frame.  Now, let's set up
a ball in an “up” position.  Click on the 1 in the frame
number field.  This will select both layers of the first
(and only) frame.  Alternatively, you could have used
ALT-A (Select all from the Edit menu) to just select
everything.

Step 6 Press ALT-C (Copy from the Edit menu) to copy the
whole thing into the clipboard.

Step 7 Click on the 2 in the frame number field, selecting the
End of frame marker.

Step 8 Press ALT-V (Paste from the Edit menu) to insert
another copy of the frame.  The End of film marker is
not destroyed by the Paste operation, since there is
always an End of film marker.  You now have two
identical frames, numbered 1 and 2.

Step 9 We want to raise the ball to its terminal (after bounce)
position, which is also going to be the initial position.
First, we have to select the frame.  Click on the 2 in the
frame number field, selecting the second frame.

Step 10 Now, we want to place the art.  Click on the Current
Frame window's drag bar, bringing it forward.

Step 11 Now, mouse down over the ball, and drag it up to a good
ending (as well as starting position).  In all probability,
you have moved the ball to a horizontal position which is
not 100% directly over the position in frame 1.  Use the
center mouse button to constrain movement to the
vertical direction.

Step 12 Click on the Exposure sheet window's drag bar to
bring it forward again.
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Step 13 Now, it's time to get a copy of this last frame, so that we
can also make it the first frame.  Click in the 2 in the
Frame number field.  Thus, you have selected the second
frame.

Step 14 Press ALT-C (Copy from the Edit menu) to copy the
second frame into the clipboard.

Step 15 Click on the 1 in the Frame number field, selecting the
first frame.

Step 16 Select Paste before from the Edit menu.  This will
insert a second copy of the copied frame before the then-
first frame.  We use Paste before, rather than Paste,
because Paste replaces the selected item(s) with the
new item, and Paste before pastes layers in before the
first selected frame.  At this point, your Exposure
sheet's should look something like this:

Step 17 You now have the three “extreme” (or “key”) frames:
The “up” position, the “down” position, and another “up”
position.  It's time to create the movement.  We will
insert an accelerated move between frames 1 and 2, and
a decelerated move between frames 2 and 3.  Whenever
we insert a movement marker, it is inserted before the
marked frame, and after the frame before the marked
frame.  To begin, mouse down on the right arrow in the
Status window:

Step 18 Drag the Move tool onto the first line of the second
frame.
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Step 19 The Move dialog will appear, asking you to enter the
number of frames over which you want the acceleration
to occur.  Type 10 and click OK to enter a 10 frame
accelerated interpolation (9 new frames, plus the pre-
existing terminal frame).  The dialog will disappear, and
the Exposure sheet will show a new 9-frame marker,
with the frames renumbered to 1, 11, and 12.  There is
nothing magic about the numbers 9 or 10.  They’re just a
number being used in this example.

Step 20 Drag the Move tool onto the first line of frame 12.
Remember:

Step 21 The Move dialog will appear to ask what is to appear in
the move.  Type 10 into the Slow out field and click OK
to enter a 10 frame decelerated interpolation (9 new
frames, plus the existing end point).  The dialog will
disappear, and the Exposure sheet will show a new 9-
frame marker, with the frames renumbered to 1, 11, and
21.  The Exposure sheet should now look something
like this:

Step 22 Press ALT-S (Save from the File menu) to save the
Exposure sheet.  Any time you finish a logical set of
operations, such as entering the Exposure sheet, it's a
good idea to save your work.  The Save dialog will
appear.
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Step 23 Enter a file name, such as Bouncing ball, and  click
Document.  The dialog will vanish as the file is saved.

Iconic interface:  Testing the Animation

Step 1 Now, let's look at a test.  To do that, you'll have to bring
the Current Frame window forward, or you'll only see
a very narrow sliver of the test going by in a mostly-
obscured window.  Click in the Current Frame
window's drag bar.

Step 2 Press ALT-J (Play or Record from the Animate
menu).  All 21 frames of the file will be shown in the
Current Frame window.  If you have very little caching
in effect, this will take a while.  If you have a fair
amount of caching, these frames will be composed and
painted quickly.

Step 3 Let's try it again with looping, and on the full screen.
Press ALT-MINUS (Set playback from the Animate
menu).  The controlling dialog will appear.

Step 4 Click on Loop to turn on looping.

Step 5 Mouse down with the right mouse button and select
Full screen from the Where menu

Step 6 Click OK to accept the edit.
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Step 7 Press ALT-J (Play or Record from the Animate
menu).  All 21 frames of the file will be shown, this time
full screen, and looping.  Playback will continue
indefinitely.

Step 8 Press escape to stop playback.

Iconic interface:  Adding Special Effects

At this point, you've completed the animation.  Now, it's time to
spice it up with special effects.

Step 1 Now, let's add squash (as in “squash and stretch”).  Click
on the Exposure sheet window's drag bar to  bring it
forward.

Step 2 Click on the middle frame to select it.

Step 3 Click on the Current Frame window to bring it
forward.

Step 4 Click on the animation tool portion of the Status
window:

Note:  Some of the icons used in the animation tool portion of the
Status window look very similar to the icons used for the paint
movement tools.  In addition to being contained in different tool
boxes, the  animation tools use blue lines, and the paint tools use
black lines.

Step 5 The animation tool palette will appear.  Click on the
Squash/Stretch tool.

Step 6 Mouse down and move the mouse so that the ball image
is squashed.

Congratulations — You’ve finished your first animation with The
Animation Stand.

Note::  Creating Final Output and Management Reporting are fully
covered in the final sections of the Spread Sheet Format instructions
above.
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Animation

In this section of the manual, you will learn the basics of the
Exposure sheet.  The Exposure sheet is where you create your
animation.  That is, you tell The Animation Stand which pictures
(or cels) to put in the frames in your animation, and how to move
those pictures from frame to frame.   You'll learn about the special
effects you can create for your films later in this tutorial, but for
now, just remember that the Exposure sheet is where you'll do most
of your animation work.  You'll learn how to save and name files
later in this tutorial, too.

The Exposure sheet can appear in three forms.  In the initial,
default form (spreadsheet format), frames are displayed top to
bottom, and within the frames, cel layers are displayed top to
bottom.  In the other (iconic & studio) formats, frames are still
listed top to bottom, but layers within the frames are listed left to
right.  If you prefer to use the other interface, just skip ahead to
that section.



Exposure sheet:  Spreadsheet Format
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To open a new film, select New film from the File menu.  An
empty Exposure sheet window (in spreadsheet format), with a
Current Frame window behind it, appears:



Relationship of the Exposure Sheet & Current Frame
Windows
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The Exposure
sheet window
describes every
frame of the film
being created.  It
shows all frames
in textual form,
a spreadsheet of
sorts.

The Current
frame window
shows the
contents of the
current frame,
graphically.

The Exposure sheet window describes every frame of the film
being created.  It shows all frames in textual form, a spreadsheet of
sorts.  Changes made to the Current frame window will change
the Exposure sheet immediately.

The Current frame window shows the contents of the current
frame, graphically.  The current frame is always defined as the
frame containing the spreadsheet cell being edited, if any, or the
frame containing the first selected layer, if any.  Barring that, the
“current frame” is usually the frame that last fit one of those
criteria.  Changes made to the Exposure sheet, or any file
appearing in the current frame will change the Current frame
window immediately.  This includes changes made to artwork made
through other programs, on your machine or another machine on a
network.  Changing your selection in the Exposure sheet may
change the definition of the current frame, and may thus cause the
Current frame window to update.  The Current frame window
will not update if Caps Lock is down.

At the top of the Current frame window is an area which shows
which layers are selected for modification in the Current frame
window, as a series of numbers, highlighted for selected layers.

Both of these windows can be used to edit the film.  The Exposure
sheet window is used for textual, spreadsheet edits, while the
Current frame window allows direct moves of picture elements.

Fields

While some things are true of all fields, some basic differences exist
between the fields.  Fields break up into three categories, and each
category behaves differently.

• Control fields (Title Area and Frame field) control selection
and format only.  No data can be entered into these fields, and
clicking in these fields have effects as discussed on the sections
on the individual fields.

• The File field uses an Open dialog to edit its contents, placing
file names (or pictures of the files) into the Exposure sheet.
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• The remainder of the fields are text edit fields, following the
normal text editing procedures.  These numbers & text strings
control how & for how long the various images will be
displayed.

When you select a File field or a text editing field, the entire field is
selected.  If the field selected is a text editing field, subsequent
mouse clicks in the field can be used to position the cursor, select an
entire word, or to drag out an area.  To move between text editing
fields, you may use the mouse to move directly to a field, or use
Enter or Tab to move to the next field, or use the arrow keys to
move in the indicated direction.



Title Area
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If you click in
this field, the
format of the
Exposure sheet
changes format.

At the top of the Exposure sheet window is the window’s title
area.  Currently, this Exposure sheet is called “Untitled Exposure
sheet” because we haven't  told the system to call it anything else
yet.  If your Exposure sheet does have a name (for instance, most
likely it will be the title of your movie), it will display in this area.

Within the window proper is the Exposure sheet itself.  The
Exposure sheet has its own title area:

If you click in this field, the format of the exposure sheet changes,
from spreadsheet format to iconic format.

Frame Field

The leftmost field, the Frame field, contains the frame number.
Each frame has one or more lines or layers.  The frame number is
automatically inserted and maintained. You need do nothing to set
up frame numbers.

Frames consist of one or more layers.  A simple frame consists of
one layer containing the frame number, the layer data, and a
positive Hold Time.

Note:  Iconic format can handle up to 36 layers per frame.  If you
need more than 36 layers for your animation, use the spread-sheet
format

In the alternate format, the Left, Top, Hold, Mag., V.Mag., °R, +,
and Mod fields are not displayed.

A more complex frame may consist of one layer containing the
frame number, layer data, and a zero Hold time; a second layer
containing layer data and a zero Hold time; and a third layer
consisting of later data, and a positive Hold time.
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You may have an unlimited number of frames in your film and an
unlimited number of layers in your frames.  In the alternate
Exposure sheet formats, the first 36 layers are shown.  If you
need to or add more than 36 layers, you must do so in the top down
format Exposure sheet.

Selecting Frames

If you click on the Frame field when using the spreadsheet format,
the entire layer displayed on that line is selected.  If you release the
mouse, your simple selection is made.  If you drag on this field,
either upwards or downwards, the selection is extended to cover
multiple layers and/or frames.

If you hold down shift while clicking, and there was another layer,
frame, set of layers, or set of frames selected, then the previously
selected layers or frames remain selected, the newly clicked layer or
frame becomes selected, and all of the intermediate layers and/or
frames are also selected.

Layers

Each frame is composed of one or more layers.

Adding a layer before another layer is extremely easy:  Using the
spreadsheet Exposure sheet format, center-click in the Frame
field.  Notice that a new layer has been inserted before the clicked
layer.

Inserting lines
If you center-click the Frame field when using spreadsheet format,
a new layer line will be inserted before the line on which you
clicked.  The Hold field will be zero, so a new frame will not
normally be created.

The End of Film Marker
The last line of the film is always the End of film marker.  Since
insertions always occur before the selected line or group of lines, we
need to guarantee that there is always a line past the end of the
film, which the End of film marker does.  The End of film marker
also shows the film’s running time (unless the film shows at the
rate of one frame per mouse click).
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Deleting Lines
At some point, you may have a frame or layer in your film that you
don't want.  Deleting a frame is very easy:

Step 1 Using the Frame field, highlight the layers to be
deleted.

Step 2 Press Backspace on your keyboard, or select Clear
from the Edit menu.  Notice that the layer(s) are gone,
and that frames are renumbered as required.

Adding a Layer to the End of a Frame
This technique is only required for the spreadsheet Exposure
sheet format.  The iconic Exposure sheet format makes this
process automatic.

Very often, you will find yourself wanting to add a layer to the end
of a frame.  In this case, do the following:

Step 1 Center-click in the Frame field immediately following
the frame to which you are adding the layer.

Step 2 Enter 1 into the Hold field of the newly created layer.

Step 3 Enter 0 into the Hold field of the layer immediately
above the newly created one.

Special Effects Lines
There is a set of lines which each represent one or more frames of
special effects or other actions.  These lines have no editable fields;
otherwise, they act much like any other line.  The special effects
lines are:

Move, xxx frames
Pantograph, xxx frames
Spline, xxx frames

These markers are created from the Animated tools, and are
discussed more fully in the section covering the Animated tools.
Move is a computed movement.  Pantograph and Spline are
curve-controlled moves.

Label Field

The Label field is a text field, which is not actually used by The
Animation Stand.  Normally you will put the portion of the dialog
associated with this particular frame in this cell, for your own
reference and assistance.
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Step 1 Create a frame by center-clicking on the End of Frame
marker’s Frame field.  A new Frame 1 appears.

Step 2 Click on the Label field.  The field will highlight.

Step 3 Type in the phoneme — “ah” for instance.

In classical animation, the sound track is recorded first, and then
the animation track is placed over it.  In desktop computer
animation, sound and pictures are handled at the same time by the
computer.  This program allows you both options.  To have sound
handled by the computer, read the section on the File field.  To
handle sound in the classical method, do the following:

For Video
Step 1 Write your script.

Step 2 Record your script directly onto your master tape, which
will later have the animation edited in over it.
Remember to use black burst and to record any required
timing tracks.

Step 3 Create an Exposure sheet.

Step 4 Create enough frames of enough layers each in the
Exposure sheet to handle your animation.

Step 5 Frame by frame, or sound by sound, play your sound
track back.  For each sound that must have animation
matched to it, make a note in the Label field for the
appropriate frame.  Use the frame number (or SMPTE)
read-out of your recorder.

Step 6 Create your animation to match what is shown in the
Label field.

Step 7 Record your animation directly onto the tape as an edit-
in.  Be sure to have the animation start on the tape in
the same frame as the sound starts.  Synchronization
will happen as a matter of course.

For Film
Step 1 Write your script.

Step 2 Record your script onto tape.

Step 3 Transfer this tape to a film sound-track.

Step 4 Create an Exposure sheet.

Step 5 Create enough frames of enough layers each in the
Exposure sheet to handle your animation.
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Step 6 Frame by frame, or sound by sound, play your sound
track back.  For each sound that must have animation
matched to it, make a note in the Label field for the
appropriate frame.  Use the frame number feet-and-
inches marks of the film.

Step 7 Create your animation to match what is shown in the
Label field.

Step 8 Shoot the animation to film.

Step 9 Optically combine the two films (sound and picture).
Once the first frames are aligned, synchronization will
happen as a matter of course for the rest of the film.

File Field

The File field has several uses:

• To show or use a picture  file as a frame, normal layer, partially
transparent layer, matte, or the like.  It contains the name of
the picture file that appears in this layer of this frame.

• To execute a link to another Exposure sheet file, it contains
the name of the Exposure sheet file that will be executed next.

• To execute a filter file, it contains the name of the filter file that
will be executed next.

• To play a sound file, or any file containing a sound resource,
starting with the current frame, and continuing until the sound
has played out.

Note:  When using certain Notes field commands, this field is
unused.
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Under some
circumstances,
updates of the
Current Frame
window can be a
time consuming
nuisance.  To
keep the
Current Frame
window from
updating itself,
depress Caps
Lock.  When you
want the
Current Frame
window to bring
itself up to date,
release Caps
Lock.

In top down Exposure sheet format, there is one File field per
layer.  In the left to  right formats, there are multiple File fields
displayed per frame.  The leftmost File field controls the
background, and subsequent File fields are loaded over it.  Thus,
the rightmost picture field of the left to right format is equivalent to
the last listed File field of the top down Exposure sheet format.

For Pictures:
Step 1 Center-click on the File field.  The Open dialog appears.

Step 2 Click a file.

The Open dialog will disappear.  The file selected now appears in
the File field in frame 1 of the Exposure sheet.  Also, the
Current Frame window will update to show the contents of the
file.  The name of the file in use will appear in the edited field of the
Exposure sheet.

For Links to Another Exposure sheet:
First, a note about why you would want to link to another
Exposure sheet:  When a piece of animation is being recorded or
played, you are generally playing or recording one scene.  The
ability to link allows an Exposure sheet to specify which
Exposure sheet logically follows it.  When you set the Allow links
flag in the Set playback dialog of the Animate menu, this link
will cause The Animation Stand to load the next Exposure
sheet, and all of its associated art, even if the sheet and/or the art
are stored on another machine, drive, network, and/or removable
media.

Step 1 Center-click the picture field, as above.

Step 2 When the dialog box appears, select the name of an
Exposure sheet.  The Exposure sheet file name will
appear in the File field, and the Hold field will appear
as an asterisk:
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For filters:
Filters are executed according to their placement in the exposure
sheet, after composition listed before the filter in the frame, and
before the items in the frame listed after it.

Step 1 Center-click the File field, as above.

Step 2 When the dialog box appears, select the name of a file
containing a filter.  The filter file name will appear in
the File field.  Filters may be any executable program or
shell script.  Each program or shell script must take its
arguments as follow:

programName inputRGBFile outputRGBFile

For Sound Files:
Note:  Sound files are used for “comp” sound.  The computer can't
play back animation and sound together with absolute frame
accuracy.  Thus, showing tests with sound and pictures will give you
a good approximation of synchronization, but not broadcast quality.

Step 1 For sound files, just center-click on the File field.

Step 2 Click a sound file.  The Open dialog will disappear.
Notice that the file selected now appears in the File
field in Frame 1 of the Exposure sheet.

The name of the file will appear in the edited field of the Exposure
sheet.

NOTE:  The exposure sheet tracks files based on their full path
name.  If you move or rename a file or directory, the exposure sheet
will no longer know where to find the file.

Loading Multiple Files

Very often, you will want to load more than one file at a time.
When selecting a file after center-clicking in the File field, you can
use the shift key and center mouse button to modify how file
selection works.

As you know, the left mouse button loads the selected file into the
Exposure sheet cell marked.

Shift-click loads the file into the cell marked, and also selects the
next File field cell, leaving you in the Open dialog.

Center-click loads all files in the sequence into the selected File
field, starting with the item selected, and the following File fields.



Top & Left Fields
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IMPORTANT!
You should
actually read
this section!

The Top and Left fields define how far from the top and left edges
of the frame to place the registration point of a picture.  Pictures
generated by programs other than The Animation Stand, or
generated by The Animation Stand without having had a
particular registration point set are registered at their upper left-
hand corners.  If you explicitly gave the item a registration point,
then that point is placed at the given frame coordinates.  Zero is the
default setting for the Top and Left fields.  Thus, to decrease the
amount of things for you to look at, the Top and Left fields will be
displayed in gray when their values are zero.

Changing the Top and Left Fields:
You can change the Top and Left field settings in two ways.  The
first way is by directly editing the Top and Left fields:

Step 1 Click on the Top  field.

Step 2 Enter 100.  The Top field value is now 2, but this won't
affect the Current Frame window until you’re done
editing the field.

Step 3 Tab to the Left field.

Step 4 Enter 100.  The Left field value is now 2, but this won't
affect the Current Frame window until you’re done
editing the field.

Step 5 Click in the File  field.  Your highlighting moves from
the Left field to the File field, and you can now see that
the picture, as seen in the Current Frame window, is no
longer at (0,0), but has now moved to (100,100).

Note that the
Current Frame
window will not
update if Caps
Lock is down.

Step 6 Click the Current Frame window to see what has
happened.

Editing the picture position via the Current Frame window is the
second way to change the Top and Left field settings.  But before
we can do this, we need to add a new layer so that the examples
below will be complete.

Step 1 Click on the Exposure sheet window's drag bar to
bring it foreword.

Step 2 Center-click in Frame field of Frame Number 1.  This
will open another layer in frame 1, before the other
layer.  The layer that appears first is the layer in back,
and the layer that appears second is the layer in front.

Step 3 Center-click in the File field of the first layer of Frame
Number 1.  This will bring up the Open dialog.
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Step 4 Click on the Blue skier file name.  This will place “Blue
skier” into the Exposure sheet.  You will also note that
the Blue skier picture appears in the Current Frame
window.

Now we have this example's requisite layers.  The following shows
position editing using the Current frame window.

Step 5 Click on the Current frame window's drag bar.  This
brings the Current Frame window foreword.  Note that
Red skier (the topmost layer, layer 2) is already selected
in the control portion of the Current Frame window.

Step 6 Mouse down on the red skier.  Move the mouse.  The red
skier will follow the mouse, because you are dragging
the red skier picture around.  Notice that on the
Exposure sheet, two lines have become selected.  This
is because you are modifying Frame 1, which appears
on the Exposure sheet as two lines.  In this step, you
are moving the front-most layer.  The default is that the
front-most layer is the one moved.

Step 7 Now, let’s move the blue skier.  Click on the 1 in the
control portion of the Current Frame window.  It will
highlight, and the 2 will cease to be highlighted.  This
means that layer 1 in the frame is selected for
modification.

Step 8 Mouse down and drag the blue skier.

Step 9 Now, let’s move them both.  Hold down Shift and click
on the 2 in the control portion of the window.  Layer 2
will highlight, without deselecting layer 1.

Step 10 Mouse down and move both layers.

So far, in these examples, all of the coordinates have been entered
in pixels.  For instance, 100 means 100 pixels.  Anywhere distances
are entered, you can enter other forms:  xxx is a number of pixels.
xxxpt is a number of points.  xxxpi is a number of picas.  xxxmm is a
number of millimeters.  xxxcm is a number of centimeters.  xxxm is
a number of meters.  xxx" is a number of inches.  xxx' is a number of
feet.

Note that positions of items in the frames can be affected by the
FRAME and # notes commands, which affect the position of the
virtual camera.



Hold Field
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≥1
This field contains the number of frame times you wish to display or
shoot each frame, for normal frames (or an asterisk for frames
which contain a link to another Exposure sheet).  For example, if
your framing rate is 24 frames per second, and you wish your frame
to be shown for one second, then you want the frame shot 24 times.
Entering a hold time of 24 would give you this one-second time.
You may enter feet and frames.  For instance, 1'8 is 1 foot, 8 frames,
or 24 frames.

0
A Hold field value of zero means that the line is just a layer in a
frame, and not itself the end of a frame.

Step 1 Click on the Hold field.

Step 2 Enter the number 15, for example.

Merge/Split
You can change the end-of-frame to be just part of a larger frame by
changing its Hold field value to zero, and you can change a layer at
the end of a frame, breaking a frame into two frames, by changing a
Hold field value from zero to another value.

Display
Hold field values of zero are not shown.  Other values are shown in
black.

*
If a Hold field contains an asterisk (indicating a link to another
Exposure sheet), you may not edit the field.  When the
corresponding File field is cleared or changed, this field may again
become editable.

Magnification Field

You can magnify or reduce the size of each of your layer pictures by
changing the setting in the Mag field.  The numbers in this field
indicate percentage of magnification.  If the V.Mag field is 0, then
the Mag field determines the actual magnification.  If the V.Mag
field is nonzero, then the Mag field determines horizontal
magnification only.
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Step 1 Click in the Mag field.

Step 2 Enter 200 to change the magnification to 200% of drawn
size.

Step 3 Click on the Current Frame window's drag bar.

Notice that the layer’s picture is now twice as big as before.

Magnification values of 100 are not shown, as that is the default
value.

Vertical Magnification Field

Using this field, you can change the aspect ratio of an item shown
as a layer, or “squash” and “stretch” a piece of art.  This allows you
to make an object thinner or fatter, taller or shorter.

When the Vertical Magnification, or “V.Mag.” field is zero, the
Magnification, or “Mag.” field controls both the vertical and
horizontal magnification.  When the Vertical Magnification field
is nonzero, the Magnification field controls horizontal
magnification, and Vertical Magnification shows the vertical
magnification.  Thus, the following shows an object at normal size:

The following also shows the object at normal size:

The following shows an object twice as tall, and three times as wide
as it would normally appear:

Magnification always occurs around the layer’s registration point.
This means that when the object is resized, the registration point
will not move.
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Note:  If you want a cell layer to go from a normal aspect ratio to a
50% squash during a Pan move, you can’t use a magnification of
100% and vertical magnifications of 0 and 50, because this will
expand improperly to 0% (which will act as 100%), 25%, and 50%.
You have to use vertical magnifications of 100% and 50%, which
will expand properly to 100%, 75%, and 50%.

Rotation Field

Using this field, you can rotate a piece of art.  Specify the degrees of
clockwise rotation as a positive number, or use a negative number
for counterclockwise rotation.  Rotation always occurs around the
layer's registration point.

Note:  Because of the nature of computed rotation, drawing of
layers using rotation will take a long time.  This is because we take
the time to handle layers with pieces which sometimes extend off
the end of the screen, have registration points, antialias, use sub-
pixel computations, and a host of other good-looking, time-
consuming operations.  During the computational period, files are
generated to hold the rotational pictures.  If the original file is
named XYZ, for instance, the new files will be named XYZ:001
through XYZ:359.  These files are never deleted by The Animation
Stand directly.  If you want these files deleted or recomputed, you
must delete them through the shell.

For example, to show a ball rolling down a hill, top left to bottom
right, taking 10 rotations in 120 frames, do the following:

Step 1 Create an empty frame of two layers.

Step 2 Load a background into the first of the layers.

Step 3 Load a foreground layer of a ball.  Later in this example,
we'll assume the file is named Ball.

Step 4 Move the ball to the upper left corner of the background.

Step 5 Copy frame 1 over the end of frame marker to become
frame 2.

Step 6 Move the ball to the lower right corner of the
background.

Step 7 Set the •R field to 3600, signifying 3600° of rotation, or
10 complete revolutions.

Step 8 Insert a 118 frame Move marker between the two
frames.
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Step 9 Bring the Current Frame window forward.

Step 10 Invoke Play or Record from the Animate menu, using
ALT-J.  Frame 1 will show very quickly, since no
rotation need be computed.  Frames 2 through 11 will
each take some time to come up, while Ball:030 through
Ball:330 are generated.  Frames 12 through 120 will
also come up very quickly, as they will be using files
which will already exist.

Step 11 Invoke Play or Record again.  This time, all the
frames will come up quickly, since all the required files
have been generated.

+ and Mod fields

The + and Mod fields provide a powerful method to insert cycles
and sequences of animation with variable timing.

Using a series of Picture files
Let's assume that we wanted to have a series of frames, in which
art named B1 through B30 appeared, and that we have 30 files
named B1 through B30 all stored in a folder together.  If we want to
insert these files as 30 frames into the exposure sheet, there are
several ways to do it.  Some of the ways have already been
discussed in the topic "Loading Multiple Files".  A faster technique
for this type of work, however, is to use the + field to define offsets.

The concept here is that we can think of files B1 through B30 as
B1+0 through B1+29.  We can enter these offset values into the
exposure sheet in the plus field.  Thus, to insert the use of B1
through B30 into the exposure sheet, using BG as a background, we
would do the following (assuming an empty exposure sheet):

Step 1 Create a frame containing two empty layers.  (center-
click on the 1 in the frame field, creating a new frame.
center-click on the new 1 in the frame field, creating a
second layer.)

Step 2 Edit the first File field so that it references BG.  (center-
click on the first File field.  Use the Open dialog to
select BG.)

Step 3 Edit the second File field so that it references B1.
(center-click on the second File field.  Use the Open
dialog to select B1.)  At this point, we have one complete
frame.
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Step 4 Using the Copy and Paste before functions, duplicate
this frame.  (In the Frame field, drag out both layers of
the frame.  Use ALT-C to copy, and ALT-] to paste in a
new copy.)  At this point, we have two identical frames.

Step 5 In the second layer of the second frame, change the +
field to 29.  (Click in the field.  Type 29.)  At this point,
we are specifying two frames, one using BG and B1, and
one using BG and B30.

Step 6 Insert an interpolation marker calling for the remaining
28 frames.  (Click on the right-facing arrow in the
Status window, which brings up the animated toolbox.
Drag the interpolation tool [first one on the second
column] to the first layer of the second frame.  Tell the
dialog that you want 0 frames of slow in, 29 frames of
constant motion, and 0 frames of slow out.  Click on
OK.)  At this point, you have an interpolation set calling
for the 30 frames.

Using a  variable-timing picture file set
Sometimes, you will want to use a picture files set with variable
timing, or missing file numbers.  Normally, this will occur when an
animator or tweener gives you a series of drawings.  Often, the
pictures will be numbered something like B1, B3, B4, B7, etc.  This
means that B2, B5, B6, etc. are missing.  The sequence that the
animator means you to show (or shoot) is B1, B1, B3, B4, B4, B4,
B7, etc.  Thus, you could enter this as B1 with a Hold of 2, B3, B4
with a Hold of 3, etc.  Using the + field, you could just enter B1,
with + values ranging from 0 to 6.  When The Animation Stand
looks for a missing item, such as B2 (when you specify B1+1), it will
fall back and use B1.  This can greatly increase the speed of
building an exposure sheet.

Inserting a cycle
You can use the + and Mod fields in combination to insert multiple
cycles of a move.  Mod stands for modulus, and is used to define the
number of cels in a cycle.  For instance, if you wanted to insert 3
cycles of a 6 frame cycle, you want to insert 18 frames total, so the +
values will range from 0 to 17.  Thus, frame 1 would have ART1 +0
Mod 6, through ART1 +17 Mod 6.  In this example, you are using
the files ART1, ART2, ART3, ART4, ART5, ART6, ART1, ART2, …
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The Notes field is just a free format field where you can write notes
to yourself about your film, or place special optical press
instructions.  Optical press instructions must be a single word in all
upper case.  Words in upper and lower case, or all lower case are
ignored by The Animation Stand.  To use this field, just click in it
and type whatever you like.

Note:  The Notes field will activate your commands only when they
are entered in upper case. Otherwise, it will act mostly like the
Label field — in which you store notes regarding sound.

Exposure sheet:  Iconic Format

The iconic format of the Exposure sheet has two components.  At
the top of the Exposure sheet is a single spreadsheet format line.
Following this line, are the iconic lines defining the frames:

Thus, this format is a superset of the Exposure sheet's
spreadsheet format, and you should read the preceding articles on
the spreadsheet format.

In this section of the manual, we will deal only with the differences
of the two Exposure sheet formats.
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The Exposure sheet can appear in three forms.  In the initial,
default form (spreadsheet format), frames are displayed top to
bottom, and within the frames, cel layers are displayed top to
bottom.  In the other formats, frames are still listed top to bottom,
but layers within the frames are listed left to right.  In the third
format, words are used instead of icons for file names, but the
format is otherwise the same as the iconic format.

To switch between the formats, click in the header bar at the top of
the window: (Not shown here, there is the third format.)

Frames consist of one or more layers, in a single line.

The following descriptions involve only changes to the meaning and
usages of fields between the iconic format and the spreadsheet
format.

The Frame Field
If you click on the Frame field, the entire frame displayed on that
line is selected.  If you release the mouse, your simple selection is
made.  If you drag on this field, either upwards or downwards, the
selection is extended to cover multiple frames.

If you hold down Shift while clicking, and there was another frame
or frames selected, then the previously selected frames remain
selected, the newly clicked frame becomes selected, and all of the
intermediate frames are also selected.

Inserting Lines
If you center-click the Frame field, a new frame line will be
inserted before the line on which you clicked.  The Hold field will
be 1.

Deleting Lines
At some point, you may have a frame in your film that you don't
want.  Deleting a frame is very easy:

Step 1 Using the Frame field, highlight the frames to be
deleted.

Step 2 Press Backspace on your keyboard, or select Clear
from the Edit menu.  Notice that the frames are gone,
and that remaining frames are renumbered.

Adding a Layer to the End of a Frame
No special technique is required.



Animation      55

Special Effects Lines
There is a set of lines which each represent one or more frames of
special effects or other actions.  These lines have no editable fields;
otherwise, they act much like any other line.  The special effects
lines are displayed as icons.  Movement icons are:

                              
                                     Move              Pantograph     Spline

These icons may be followed by modifiers, indicating changes
occurring in the following:

                                                        
                 Position         Cycling          V.Mag            Mag               °R

Label Field
No changes.

The File Field
In this Exposure sheet format, there is one File field per layer,
listed left to right.  The leftmost File field controls the background,
and subsequent picture fields are loaded over it.  Thus, the
rightmost picture field of this format is equivalent to the last listed
File field of the spreadsheet format.

In the File field, a picture of the file in use is displayed, rather than
its name.  If there is something unusual about the layer, such as
magnification other than 100%, a note, or a hold field value higher
than 1, the picture is displayed with a red border.

Click in a picture field to select that layer.  Center-click in a picture
field to edit it, using an Open dialog.  When a layer is selected, the
data for that layer is displayed at the top of the window in the
single spreadsheet line.  Data in that line is editable.

If you Cut, Copy, Clear, or Delete a File field in the iconic
format, you are dealing with an entire layer, rather than just the
picture name.

Once you click on the File field, the 0, -, and +  (or =) keys get
special meanings:  0 copies the marked file name down to the same
position in the next line.  - and +  do the same thing, except that the
previous or next file name in the sequence (respectively) is used.
This allows you to rapidly set up exposure sheets.

All other fields are not displayed in this format.
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The animated tools palette allows use of several types of functions,
each of which modifies the Exposure sheet in some way.  These
tools apply to both the spreadsheet format and the iconic format of
the Exposure sheet.  When examples are shown below, they are
shown in spreadsheet interface, or in the iconic interface.  These
depictions are for example only, and each function shown works in
both formats, unless otherwise specified.

To use the animated tools, follow these simple steps:

Step 1 Click on the Animated tools pop-up button in the
Status window:

Step 2 The Animated tool icons appear in the Status window.
Drag an animated tool from the Animated tool palette
onto a frame or layer of the Exposure sheet.  The
Exposure sheet will be immediately affected.
Normally, only the layer you release the mouse over will
be affected.  However, if you use the center mouse
button, all of the layers in the entire exposure sheet on
that level will be affected.

Shoot frame:  Drag this tool onto a layer.  It will change the layer's
zero Hold time to a Hold time of 1.  If the layer had a positive
Hold time, then the layer is unaffected.

Insert empty layer:  Drag this tool onto a layer.  It will insert an
empty layer into the Exposure sheet before the existing layer.

Insert empty frame:  Drag this tool onto a frame.  It will insert an
empty frame into the Exposure sheet before the existing layer.

Interpolations:  Each of these tools will insert an interpolation set
between two existing, similar frames.

Transitions:  Each of these tools will insert an interpolation set
between two existing frames.

Everything else:  All of the other tools are quick ways to place
Notes commands into the Exposure sheet and are further
explained in the following pages.
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Interpolations, or interpolation markers, are used to represent a
smooth transition from one frame to another.  In any interpolation,
we always have a starting frame and an ending frame.  The starting
and ending frames are normal frames, but they are related to one
another.  They represent a sequence, with a start and an end.  The
starting and ending frames in an interpolated set must have the
same number of layers, and in each layer, they must call out the
same file names.  The numeric values involved are expected to
change over time.  How these values change is determined by the
type of interpolation marker used.

Move:  Motion from each layer's start point to the end point is
linear, but the speed may vary over time.

Pantograph:  A pantograph is a drawing which shows how one or
more layers will move.  Use of pantographs in The Animation
Stand allows you to insert one of these pantograph drawings as a
Pantograph marker in your Exposure sheet.  This function can be
used to insert a Pantograph marker between two similar (as defined
previously) frames, to edit an existing Pantograph marker, or to
convert a Spline marker to a Pantograph marker.

Spline:  A spline is a curve which shows how layers will move,
using a minimum of points.  Use of splines in The Animation
Stand allows you to insert one of these curves as a Spline marker
in your Exposure sheet.  This function can be used to insert a
Spline marker between two similar (as defined previously) frames,
or to edit an existing Spline marker.

Move, Pantograph, and Spline must be from one similar frame to
another, or surrounded by similar frames.  This means the two
frames differ only in the values of their numeric arguments.

For example, if you were to want to insert a 5 frame walk cycle,
using 5 character files, with names Fawn01 through Fawn05, you
could just enter frames 1 & 5, with a 3 frame Move set between
them.  Thus,

and
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are equivalent.

Usage of each of these tools is similar — These tools perform
various types of moves and numeric interpolations.  All numeric
fields, other than Hold, are affected.  When an interpolation set is
inserted between two frames, only one line of the Exposure Sheet
is taken up by the interpolation marker to perform the move, no
matter how many actual frames or layers are involved.

Step 1 Create a frame using Mountain as a background, and
Blue skier as a foreground.

Step 2 Switch to the Current Frame window and position the
two layers into a good starting position.

Step 3 Switch back to the Exposure Sheet.

Step 4 For the spreadsheet format exposure sheet, mouse down
on the first layer in the first frame, drag down to mark
the second layer, and release the mouse button.  This
selects both layers.  For the iconic format of the
exposure sheet, just click on the first frame, selecting it.

Step 5 Press ALT-C to copy the frame into the clipboard.

Step 6 Click on the End of Film marker's frame, to say that
you’re going to insert at the end of the film.

Step 7 Press ALT-V to paste a second copy of this frame over
the End of Film marker.  The End of Film marker is
indestructible, so there’s no need to worry.  If you were
doing this work before other frames, you would most
likely use Paste before from the Edit menu.  At this
point, a second copy of the frame appears.

Step 8 Modify the positions of both layers of the second frame,
either using the Exposure Sheet window or the
Current Frame window.
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Step 9 Drag one of the interpolation tools (differentiated below)
from the Animated tool palette onto the first layer of the
second frame for spreadsheet format exposure sheets, or
anywhere onto the second frame for iconic format
exposure sheets.  The following dialog appears for
Move:

Step 10 If this move is to be logarithmic, turn on the
Logarithmic zoom checkbox.  If a zoom is logarithmic,
then the time to double an image size is constant.  For
instance, if we go from 100% to 25% in 10 frames, we'll
go from 100% to 50% in 5 frames, and from 50% to 25%
in 5 frames.  With linear zooms, we would decrease (in
this example) 7.5% each frame.  Logarithmic zooms are
more real-worldly.

Step 11 Enter the number of frames involved in the slow-in
(acceleration), the hold (constant speed motion), and the
slow-out (deceleration).  The sum of these three values
forms the time of the move, including the ending frame,
but not including the beginning frame.  For instance, a
Move with values of 10, 20, and 5 would involve a total
of 36 frames:  The initial frame, 10 accelerated frames,
20 constant frames, and 5 final frames, concluding with
the frame following the Move on the exposure sheet.
The Move marker will show 34 frames:  The preceding
frame + 34 frames + the following frame also = 36
frames.
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If you requested an effect other than Move, the dialog
will be:

Enter some number of frames.  The number you are
entering is the number of intermediate (or “in between”)
frames, not the total number of frames involved in the
movement.  Thus, if you enter 10, the first frame will be
numbered 1, the interpolation marker will be numbered
2, and the last frame will be numbered 12.

Step 12 Click OK to insert the marker.

For Moves, you're done.  For Pantographs and Splines, there's an
edit to perform.  But first, an explanation is due as to what each of
the interpolation tools does.
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Once you have established the length of the Pantograph set, or
when you are re-editing a Pantograph set, you are presented with
the pantograph edit screen:

The circles represent points which can't be moved — the points in
the frame before and after the Pantograph set.  The squares
represent the locations occupied by the layer's registration point for
various frames (3 in this case).  You may drag the “shoot squares” to
any desired position.

If you select Drawn path, rather than drag a shoot position, you
draw the motion of the layer.

There is also a Layer menu which allows you to choose which layer
will be affected.
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Once you have established the length of the Spline set, or when you
are re-editing a Spline set, you are presented with the spline edit
screen:

The circles represent points which can’t be moved — the points in
the frame before and after the Spline set.  The squares represent
the curve's control points.  You may create new control points and
drag them to any desired location (using the Add point function),
drag existing control points about (using the Move point function),
or delete control points (using the Delete point menu function).
All of these functions are available from the Function pop-up
menu.

There is also a Layer menu which allows you to choose which layer
will be affected.
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Each of the transition tools create a transition between two frame
images.  The transition takes a user-specified number of frames, not
counting the controlling frames, before and/or after the transition
marker.

Wipes transition between two images, by wiping one image (the
“After” frame) over the other (the “Before” frame).  Wipes are
indicated by an icon which itself constantly wipes from “A” to “B”.

Fades transition between two images, by fading or dissolving from
one to the other.  Fades are indicated by an icon which itself
constantly fades from “A” to “B”.

To use any of these tools, you drag the tool onto the Exposure
sheet.  For the spreadsheet Exposure sheet format, drag one of
the wipe tools onto the first layer of the transition’s “After” frame.
For the iconic format, drag onto the frame itself.  Then, a dialog will
appear asking how many frames are in the set.  Answer with the
number of intermediate frames, not counting the “Before” or “After”
frame.
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When you drag the wipe tool onto a frame, you are creating a wipe
between that frame and the previous frame.  You need to establish
the number of frames, the stating position, ending position, and
shape.  The result is actually a traveling matte, controlling the
wipe.

The Wipe insertion dialog is as follows:

There are a number of displays and controls in this dialog.

The Insert frames field determines how many frames of wipe will
be inserted.  Note that this does not count to 100% "A" (before) or
100% "B" (after) frames.  You must fill in this field before you can
OK the insertion.

The numeric fields, labeled in groups Start and End, with fields
Top, Bottom, Left, & Right serve to control the position of the
wipe.  For rectangular wipes, these eight positions define the
coordinates of the wipe at the start and end of its cycle.  By default
(default values shown here), the wipe starts in the upper left corner
(all zeroes), and progresses to fill the entire screen.  You can enter
any control values you like here.  For round wipes, these values
define the boundaries of an oval.
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The "A/B" box, shown in the figure as "B" in a shaded box, starts off
showing "A" (signifying the original image), and wipes to "B".  The
format of the wipe shows what the result will look like on the
screen.  Each time you make a change to the parameters, this A/B
wipe sample will change to show you the current wipe.  Clicking in
the A/B box establishes a wipe from the indicated point.

Clicking on Round changes to round wipes or back to square wipes.

OK and Cancel have the usual meanings.  Once the insertion is
OK'd, a traveling matte set is built.  Traveling mattes can be used
at any resolution, and can take advantage of sub-pixel movement
and sub-pixel antialiasing.  Wipe sets always use a pseudo-file,
named "*Rectangle" or "*Oval".  These markers draw a black
rectangle or oval at the coordinates specified by the Top, Left, Mag
(right), and V.Mag (bottom) fields.

Fades

When you drag the Fade tool onto a frame, you are creating a Fade.
This fade may be between two existing frames (the one before your
fade marker, and the one you dropped the fade tool on), fading out
from a frame (from the frame before the marker), or fading into a
frame (the one you dropped the tool onto).

The Fade insertion dialog is as follows:

The Insert frames field determines how many frames of wipe will
be inserted.
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Cross dissolve will insert a fade set which fades from the
preceding frame to the frame you dropped the fade tool onto.

Fade to black and Fade to white will each insert a fade set,
fading from the previous frame to the indicated color, without
affecting the frame you drop the tool onto.

Fade in from white and Fade in from black both insert a fade
set, leaving the previous frame untouched, while affecting the
frame the tool was dropped onto.

Notes

Each of the remaining items on the Animated tools palette is a
shortcut for a Notes command.  To put the note into a layer, drag
the icon from the tool palette onto a layer.

The equivalencies are as follow:

FRAME GEL COMPOSITE COMPOSITE* COMPUTE MATTE

MINIMUM MAXIMUM PIC-ONLY GLOW FADER OFF

WHITE BLACK SHADOW BLEND BLENDLEVEL SUBTRACT

ALPHA-BG BLACK-BG AND OR XOR LOAD

Each of these notes command is explained fully, along with all of
the other Notes commands, in the Optical Press section.
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The Current Frame window is open whenever an Exposure
sheet is open.  This window always shows the currently selected
frame.  If more than one frame is selected, then the Current
Frame window displays the first selected frame.  When an
Exposure sheet is played (not full-screen), it is played into the
Current Frame window.

The Current Frame window tracks changes in the Exposure
sheet, and in the art.  If you change the Exposure sheet, you see
the changes reflected immediately in the Current Frame window.
Also, if you change art which appears in the Current Frame
window, using any program on any machine,  you will see the
changes immediately reflected in the Current Frame window.
You can prevent the Current Frame window from updating to
match the Exposure sheet and new art by depressing Caps Lock.
While Caps Lock is down, no updating will occur.  When Caps
Lock is lifted, the Current Frame window will catch up to the
current state.

Conversely, the Exposure sheet tracks the Current Frame
window.  If a change is made to the Current Frame window, then
the Exposure sheet changes to match.  Changes to the contents of
the Current Frame window are made using the window’s control
bar (just under the Title bar), the drawn area, and the Current
Frame tools.

Content Area

The content area of the Current Frame window is the large area
where the picture appears.  Here, you see the currently selected
frame of the Exposure sheet.  You can drag the selected layer(s)
around (using the default Move tool), by mousing down on the
selected layer(s), and moving it.

When you drag an image around, you will see a red image tracking
the movement of the mouse.  When you release the mouse, the
frame is redrawn.
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The control bar is located at the top of the Current Frame
window.  It controls which layers are to be affected by any action.
Layers which are not highlighted (shown with a white background)
are not affected.  Layers highlighted in yellow are affected in the
current frame only.  Layers highlighted in red are affected in all
selected frames of the exposure sheet.  (This is sometimes called
hierarchical editing.)  For the spreadsheet format of the exposure
sheet, the layers are displayed numerically:
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For the other formats, the layers are displayed as they are in the
exposure sheet:

To highlight a layer, click on its number or icon.  All the other
layers will lose their highlights.  To select additional layers
concurrently, hold Shift and click on additional layers.  You can
also use the number keys to highlight layers 1 through 9.  If you
click on a white (unhighlighted) item, it turns yellow (highlighted).
If you click on a yellow item, it turns red.  If you click on a red item,
it turns white again.
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By default, mouse actions in the content area of the Current
Frame window move images.  By selecting other Current Frame
tools, you can perform other actions in the current frame window.

First, you'll need to get the Current Frame tool palette.  Click the
Current Frame tool area on the Status window:

Click on the Current Frame tool area.  The Current Frame tool
palette appears in the Status window.  To pick a tool, click it.  The
Status window will reflect this tool pick.

Move:  This tool allows you to move the selected layer(s) in the
frame.  Choose this tool, choose your layer(s), and then mouse down
and drag in the content area of the Current Frame.  With this
tool, as with all others, the frame will redraw as soon as you mouse
up.

Copy:  This tool is the same as the Move tool, except that the
layer(s) are moved and copied.

Stretch:  This tool modifies the Vertical Magnification field.
Mouse down in the content area, and drag to reshape the layer(s).

Resize:  This tool modifies the Magnification field.  Mouse down
in the content area, and drag to resize the layer(s).

Rotate:  This tool modifies the Rotation field.  Mouse down in the
content area, and drag to rotate the layer(s).

Send back and Send forward.  Each of these tools immediately
affects the last selected layer, sending it forward or backwards in
the layer stacking.

Add layer:  This tool immediately adds an empty layer before the
last selected layer.

Remove layer:  This tool immediately removes all selected layers.

Rewind:  This tool immediately changes your selected frame.  The
first frame in the Exposure sheet will be selected.
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Fast forward:  This tool immediately changes the frame selected.
The End of film marker at the end of the Exposure sheet is
selected, and the Current Frame window will become blank.

Step back and Step forward.  These tools immediately affect the
frame selected.  Either the frame before or the frame after the
current frame will be selected, and the Current Frame window
will update to show that frame.

Play:  This tool immediately plays the film into the Current
Frame window.

Recolor:  This tool adds a RECOLOR note at the end of the frame.
When the frame is drawn, all pixels the color of the clicked-on area
are recolored to the current draw color (as of the time of the tool
click).  This tool can be used to change palettes on a set of
documents.  For instance, you design a scene, and show it to the
customer.  The customer tells you that he wants all the blue
changed to green, and all the orange changed to red.  Select the
Recolor tool.  Select green (the first change-to color).  Click on a blue
area in the frame.  A RECOLOR note (which changes blue to
green) is added to the end of the frame.  Select red and click on
orange to make the second change.  You may Cut, Copy, and Paste
the RECOLOR layers just like any other layer.

Apply shadow:  This tool acts immediately to apply a shadow to
the selected layer(s).  It does this by duplicating the last layer,
moving the new copy 10 pixels down and to the right, and then
adding the SHADOW notes command to it.  See the description of
the SHADOW notes command in the Optical Press section for a
more detailed description.
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This chapter defines a number of general topics, special techniques,
and trade-offs, all too general to discuss in any less-broadly defined
chapter.

High Resolution Painting & Scanning

There are basically two ways to get a high resolution look.  One is
called sub-pixel antialiasing.  Using the sub-pixel method, you can
scan in a 1-bit mode without having to worry about any sort of edge
effects, and then composite.  Using the line weight method, you
scan in 8 bits.  Using this technique, there are fewer pixels to deal
with, but you have to correct for unwanted edge effects if you make
a mistake.  We suggest that you try both of these schemes on two or
three frames, and see which you like best.

Sub-pixel antialiasing

You can get a very good look from scanned line-work by following
these steps:

Step 1 Handle your backgrounds as you normally would.

Step 2 Scan your line work as 1-bit black-and-white, at the
twice the largest size it will be needed.  For instance, if
the art is to be shown at up to 100% magnification, scan
it at 72 DPI x 2 = 144 DPI.  If it will be shown at 400%
magnification, scan it at 72 DPI x 4 x 2 = 576 DPI.  This
should not be a problem, as most scanners go easily to
600 DPI.

Step 3 Paint your cel.

Step 4 Use Next Cel from the File menu ( ) to get to the
next cel, even if this is the last cel in the set.  That will
save the document with white transparency.

Step 5 Build your exposure sheet.  Set each layer painted at
double size to 50% magnification.



Scan-based antialiasing
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You can get approximately the same look from scanned line-work by
following these steps:

Step 1 Handle your backgrounds as you normally would.

Step 2 Scan your line work as 8-bit gray-level, at the largest
size it will be needed.  For instance, if the art is to be
shown at up to 100% magnification, scan it at 72 DPI.  If
it will be shown at 400% magnification, scan it at 288
DPI.

Step 3 Set up the  paintbuckets to expand by 1 pixel:  Center-
click the paintbucket tool, enter , and press .

Step 4 Select the Minimum (red over pink) or Gel (gray over
gray) mode.

Step 5 Paint your cel.

Step 6 Select the Alpha invert tool (the last paint bucket,
showing a black and white background).

Step 7 Paint each background area black using this tool.  An
alpha mask channel is built.

Step 8 Save the file and go on to the next.

Step 9 Build your exposure sheet.  To composite one layer onto
another, use the COMPOSITE command in the Notes
field.
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Normally, you will draw your cel outlines outside the system on
Acme-peg-punched paper, and then scan the art in, using a scanner
with Acme pegs  glued to it.  You may have to drill holes in the
scanner cover to accommodate the pegs.  If all else fails, you can get
the pegs and the paper from Cartoon Colour, 310-838-8467, 9024
Lindblade St, Culver City, California  90232.

Here are the formulas:

Let S be the Scan DPI

Let W be the image width (for instance, 640 for TV)

Let B be the field basis (for instance, 12 fields)

Let F be the tightest field (for instance, 6 fields)

Let D be the drawing width, in inches

S = (W x B) / (D x F)

For instance, let's say we have a screen width of 640, a 12-field
basis, a 6-field shot, and a set of 10" drawings…

S = (640 dots x 12 fields) / (10 x 6 fields),

Thus,

S = 256 dots/inch

Character shading

There are a number of ways to shade a character.  Some of the
techniques involve doing all the shading in the cel layers, others do
all the shading at the optical effects stage, and some divide up the
work.  Here is a sampling of the methods:

3D:  The use of 3D shading involves The Animation Stand’s shading
heuristics to determine what an object looks like, and to apply the
shading.  Fortunately, you need not do any 3D design.

Step 1: Draw your cel without shading.

Step 2: Use any combination of selection tools to get the area to
be shaded selected.  There are separate sections on each
selection tool in the Paint chapter.
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Step 3: Use the lighting edit of the sphere tool (also in the Paint
chapter) to set up your lighting.  Note that the angles of
light appear in the Status window, and can help you
vary the lighting frame to frame.

Step 4: Use the Extrude/Relight tool (last 3D tool, explained in
the Paint chapter) to relight the object.  If the object
does not look right, adjust  items in steps 2 and 3, and
try again.

Step 5: Repeat this process for each shading area.

Step 6: Deselect everything (by clicking the simple draw tool) or
select whatever you need to select, and so a Save or Save
area, as appropriate.  No action need be taken in the
exposure sheet.

Circular wash:  The circular wash modes allow you to paint two
colors at once with a selectable highlight direction.  For instance,
let’s say that you want to paint something orange, with a highlight
and shadow.  One way to do this might be…

Step 1: Select dark orange or brown as a background color, to
represent shadowed orange.

Step 2: Select yellow or a similar color to represent highlighted
orange.

Step 3: Go to the Preferences dialog and set the Wash to
menu to Background color, so that both of these colors
selected will be used in a single paint operation.

Step 4: Edit the circular wash mode to select the fall-off pattern
you want.  In special circumstances, you might use the
user-defined wash mode.

Step 5: Paint your cels.  No special action will be required in the
exposure sheet.

GEL and GLOW:  This is a conventional animation technique in
which the line drawing is annotated using color to show how the
character will be shaded.  The glow and shadow layers are
constructed as separate cel layers.

Step 1: Scan the colored-line drawing.

Step 2: Using the Finder, make a duplicate of the scans.

Step 3: Open the scan.

Step 4: Use the eraser to erase the non-character lines (the
highlight and shadow note lines)

Step 5: Paint the image the usual way.
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Step 6: Save the cel.

Step 7: Do the rest of the cel art this way.

Step 8: Open the first scan again.

Step 9: Use New cel from the File menu to create a new cel
which will be the gel layer.

Step 10: Set the scan up as a light table image.

Step 11: Draw a gel, using shades of gray (usually) to control the
shading.  White means No effect, Black means Black,
and shades of gray will darken the art.  The limits of the
grays and black must conform exactly to the outline of
the character.

Step 12: Save that

Step 13: Repeat steps 9 through 12 to create a glow layer.  The
glow layer will be different in that black represents No
change, white represents White, and shades of gray (or
sometimes yellows or other colors) will represent
varying amounts of light to be added to the art.  Again,
the extent of the glow mask must conform to the edge of
the character.

Step 14: Repeat steps 8 through 13 for the rest of the art.

Step 15: Build the exposure sheet.  The gel and glow layers must
follow the character art, and bear either the Note GEL
or GLOW.  For a diffuse backlight effect, you may
replace the use of GEL with BACKLIGHT.  In this
case, you may also be using the PIXLEVEL Notes
command.

OVER-GEL and OVER-GLOW:  These functions are much like
GEL and GLOW above, with the following exceptions:

Change 1: Rather than saving any way you want, use Save area.

Change 2: You need not conform the shape of the masks to the
shape of the character.  The masks may extend past the
edge of the character, allowing you to slop on colors
much more quickly.  However, the masks may not fall
short of the edge of the character.

Change 3: Rather than using GEL and GLOW, use OVER-GEL
and OVER-GLOW.
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Self-colored line:  Self-colored lines are easy:

Method 1: Use the Line coloring tool to paint the line the right
color, and then paint as normal.

Method 2: Set the paintbucket to expand by 1 pixel (or your line
width), and paint.

Self-colored line with blur or smudge:  This gives a smoother
transition.

Step 1: As before, you do a self-colored line cel.

Step 2: Select the line and the area around the line, using the
Lasso tool.

Step 3: Set the Blur tool to blur by an appropriate number of
pixels.

Step 4: Blur the line using the Blur tool.  Alternatively, you can
use other blur and/or smudge. tools.

Airbrush with frisket:  This allows you to smooth shade a
character in an artistic manner seldom used in films.  Note that
using this method, the shading will jitter around as if drawn by
hand.

Step 1: Paint the cel as normal.

Step 2: Use the Paint with Protection bucket to protect areas
which are not to be airbrushed.

Step 3: Set up and use the airbrush.

Step 4: Deselect the airbrush using  if you need to do other
painting.

Flow of Work

Before you read this section, you should have already read the
chapter describing the steps in animation.  This section defines the
major steps used in The Animation Stand in actual production.

For productions involving one person:

Step 1: Write the script.

Step 2: Do all the sound recording.

Step 3: Find out at what time the sounds in the soundtrack
occur.
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Step 4: Do the key and line art.

Step 5: Scan in the line art.

Step 6: Do the background art (scanning if required).

Step 7: Create an exposure sheet using the line art and
backgrounds.

Step 8: Do a pencil test on-line and repeat steps 4, 5, and 7 as
required.

Step 9: Color the cels

Step 10: Annotate the exposure sheet for special effects

Step 11: View a color test on-line, and repeat steps 9 & 10 as
required.

Step 12: Commit to tape or film (unattended).

For productions involving one person:

Step 1: Write the script.  One group proceeds to step 2A while
other groups proceeds to steps 2B and 2C.

Step 2A: Do all the sound recording.  This group proceeds to step
3A.

Step 2B: Do the key and line art.  This group proceeds to step 3B.

Step 2C: Do the background art (scanning if required).  Proceed to
step 4A.

Step 3A: Find out at what time the sounds in the soundtrack
occur.  Proceed to step 4A.

Step 3B: Scan in the line art.  Proceed to steps 4A and 4B.

Step 4A: When steps 2C, 3A, and 3B are complete, create an
exposure sheet using the line art and backgrounds.
Proceed to steps 5A and 5B.

Step 4B: Color the cels.  Proceed to steps 5A and/or 6.

Step 5A: Do a pencil test on-line.

Step 5B: Annotate the exposure sheet for special effects

Step 6: View a color test on-line.

Step 7: Commit to tape or film (unattended).  The crew is free to
start on the next episode.



Focus Effects
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There are varying levels of layering you can use to provide the effect
of three dimensions.

Without careful layering, your 2D animation will seem flat.  This is
fine for most purposes.

If foreground layers are larger and move at a differing rate (more
X/Y distance during moves), you get some feeling of 3D.

If the main character action is in focus, and the action and static
objects in front of the characters and behind are out of focus, lens
effects are emulated, and attention is drawn away from layers out
of focus, and onto layers which are in focus.  If there is a single
background layer which is to be blurred by a certain amount, it is
best to blur the background in the paint stage, using the Blur tool.
If the background is to be composited with other items before
defocusing, or if the defocus level on the background changes, it is
best to blur the items during the compositing stage.  After all
background layers are called out in the frame, call out an additional
layer in the exposure sheet, with nothing in the File field, but with
BOTH in the Notes field.  The Mag field should contain a blur
factor, usually between 1 and 8.  This will have the effect of
blurring everything composited to this point.  Next, composite the
character action layers.  If you do nothing special to them, they will
be in focus.  Foreground layers which will be out of focus should
have RACK in the Notes field.  The RACK command uses blurring
levels passed to it by the Mag field of layers containing PIXLEVEL
in the Notes field.

To add extra depth, you can blur multiple times at differing blur
levels, and bring in multiple rack focus layers at differing rack focus
amounts.

To add even more depth (with even more work), you can move and
zoom at the same time, giving the effect of zooming into the frame.
This will be especially true if you use the Logarithmic zoom
setting of the Move dialog.  To emulate long focal lengths, have the
BLUR’s Mag field and the PIXLEVEL’s Mag field vary during the
move.

You can shift focus (in both senses of the word) from one character
action level to another while bringing one layer into focus at the
expense of another layer’s focus.  To do this, have the Mag fields
described above shift values during a Move operation in which only
these values are changing.  This effect should last between 1 and 3
seconds, and should not be used more than twice in an episode, or it
loses its excitement and starts to look odd.

80      The Animation Stand



When to Composite

General topics      81

When animation and/or special effects are to be composited against
live action, there are a few ways of going about this:

Method 1: Lay out the animation to a QuickTime movie or series of
Picture or other files, with alpha channel.  Some other
machine or program will composite with the live action
or 3D work.

Method 2: Lay out the work with a blue or green background, and
have Ultimatte™ or some other device mix with the live
action.

Method 3: Lay out the work twice, once normally, and once with
Set Playback’s Display menu set to Mask or
Reversed mask, normally onto tape.  This mask and
image tape set will later be used to control external
compositing.

Method 4: For 3D, bring the 3D layers into The Animation Stand’s
exposure sheet.  Have the images generated with an
alpha channel and use COMPOSITE in the Notes field.
Alternatively, use a reversed alpha channel and the
COMPOSITE* command.

Method 5: For compositing with live action, load the live action
onto the system using the Diaquest controller or some
other means.  Use the live action as a background in the
exposure sheet.  Have The Animation Stand perform all
the compositing.

Methods 4 and 5 give the best overall look, by far.
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Under some circumstances, you will see “jitters” during a move.
These jitters occur when an uneven movement is made.  Movement
is uneven when the number of pixels moved in each frame is not
constant.  This inconstant movement comes from round-off error.
For instance, if we direct a layer to move 30 pixels in 9 frames, at
normal resolution, you are really asking that the layer move 3.3333
pixels per frame.  What will really happen is that the layer will
move 3, 3, 4, 3, 3, 4, 3, 3, and 4 pixels.  Thus, in frames 3, 6, and 9,
the layer will appear to jerk by one pixel.

There are several solutions to this matter.  By increasing
resolution, you can decrease the amount of the jitter.  By going to
4:1 resolution, you have pixel positions available which are a
multiple of 0.5.  This means that the movements for the above
example would be 3, 3.5, 3.5, 3. 3.5, 3.5, 3, 3.5, and 3.5.  Thus, in
frames 2, 5, and 8, there will appear to be 0.5 pixel jerks.  By going
to 256:1 resolution, the movements will all vary slightly, and there
will be very small jerks observed in each frame.

Another means of avoiding jerk or jitters is to use a movement
which eliminates the possibility of jitters in the first place.  You can
do this by adjusting the movement to a number of pixels which will
work well with the number of frames over which the movement
occurs, or you can do this by adjusting the number of frames in the
move to work well with the number of pixels being moved.  Use the
following table to determine which will work best:

Resolution Best moves are multiples of…
Normal 1 pixel per frame
4:1 0.5 pixels per frame
16:1 0.25 pixels per frame
64:1 0.125 pixels per frame
256:1 0.0625 pixels per frame

Advanced Techniques

In this article, we describe a special technique our customers have
been kind enough to teach us.  Let us know if you come up with
something new.  We’ll be publishing new ideas in the future.
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Starburst Fade
The following describes a method of making a transition from one
scene to another using a starburst-shaped transition which appears
at the center of the frame and grows until the transition has been
made.  For this example, we’ll assume two pictures, Before and
After:

Step 1 Open a new document of the same size as your frames.

Step 2 Select a black color

Step 3 click the User wash mode icon to edit and select
the mode.

Step 4 Click on the Center button to select a star wash.

Step 5 Press  to complete the edit.

Step 6 Select the Fill selected area tool, which will paint the
starburst.

Step 7 Place a registration point at the center of the frame.

Step 8 Save the file as Starburst.

Step 9 Edit the Exposure sheet to show a transition, as
follows:

In this example, 240 and 320 place the starburst in the center of a
640 by 480 frame.  If you are using another frame size, you will
have to use different numbers.  Note that if you have set the
Centered reg. checkbox of the Set playback dialog of the
Animate menu, these numbers will always be 0.

In the iconic format, the presence of a special effect (matte) would
be shown as a red box around the starburst image.



Setting up a Junk Matte
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If you'd like an animation to be able to go behind something in an
image, but be in front of the rest of the image, a junk matte should
be used.

Step 1 Open the art that needs a junk matte built for it, using
Open from the File menu.

Step 2 Create a new cel document, using New cel from the
File menu.

Step 3 Select the old picture into the light table, using Light
table from the Options menu, then selecting the first
document from the Light table A menu, then clicking
OK.

Step 4 Select the Free draw tool, the Free draw tool with a big
nib, and/or the Paintbucket tool.  Draw black over the
matting portion of the item.

Step 5 Save the item as a matte, using Save from the File
menu.

Step 6 Use it in the exposure sheet with BWMAT as the Notes
command.
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Menu items

The following menus appear when you use the right mouse button:

General   File   Edit   Options   Effects   Fonts A-M  Fonts N-Z
Size   Animate   Notes   Statements  Functions  Variables

General — Allows certain information features about the
Animation Stand.

File — Allows operations on files and windows.

Edit — Allows editing and clipboard operations.

Options — Controls various facets relating to how The
Animation Stand will act.

Effects — Performs various optical effects on paint windows.

Fonts A-M — Allows you to choose any font from A-M for use in
paint windows.

Fonts N-Z – Allows you to choose any font from N-Z for use in paint
windows.

Size — Allows you to choose any font size available for use in paint
windows.

Animate — Controls all facets of animation.

Notes–  Lists all the possible notes commands. Selecting an item
from this menu will enter data into the exposure sheet.

Statements–  Lists all the statements in the PF language and will
enter the statement in a text window.

Functions–  Lists all the functions in the PF language and will
enter the function in a text window.

Variables– Lists all the variables in the PF language and will
enter the function in a text window.
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The following menu items apply to the General menu:

About the Animation Stand— Gives serial number and contact
information.

Calculate — Enter an item in hours:minutes:seconds:frames,
feet'frames, or frames, and it will be translated to the other two
formats..

File Menu

The following menu items apply to the File menu:

New Cel — Creates a new paint window.

New film — Creates a new Exposure sheet and Current Frame
window.

New text — Creates a new text window.

Open… — Opens file and creates any appropriate windows.

Open as palette… — Opens a picture file as a floating palette

Scan… — Scans one or more pictures, and may build an exposure
sheet

Revert — Restores the frontmost window to its original, on-disk
version.

Close — Closes the frontmost document window.

Save  — Saves the contents of the frontmost document window.

Save area — Saves selected part of the document

Next cel — Closes a paint window and opens the next in
succession.

Previous cel — Closes a paint window and opens the previous in
succession.

Document info — Gives a report on a document.

Regionize — Performs paint-flow calculations on a series of files
as specified by the exposure sheet
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De-regionize — Removes regionization information from a file

Quit — Exits program.

New Cel

Use this selection to open a new paint document.  The new cel will
be determined by the current cel size preference.  The default for
the size is the size of the main monitor.

New Film

Use this selection to open a new film document, which will be
displayed as an Exposure sheet window and as a Current Frame
window.

This menu item is not available if you already have an Exposure
sheet open.

New Text

Use this selection to open a new text document, either for notes, or
to create a PF-key program.

Open

Use this selection to open a file that already exists on the disk.

• If you open a paint, draw, or cel document, a paint (cel) window
appears.

• If you open a The Animation Stand preferences file, then only
your preferences are loaded, and no added windows display.
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• If you open an Exposure sheet, then an Exposure sheet
window and a Current Frame window is opened.  Exposure
sheet files will not appear on the list if an Exposure sheet is
already open.

• If you open an animation file, then the animation is played
back.

• If you open a text file, a text window appears.

When a file is opened, absolutely every data item in the file is used.
Thus, if you open a picture file, and that file contains a cel image, a
registration point, a palette, patterns, preferences, and who knows
what else, all of those data items will be used.  You can prevent
extra data, such as preferences, palettes, and the like from being
loaded by center-clicking to select the file.
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There are three steps in this process:

1) Select Open from the menu or use ALT-O.  The
following dialog appears:
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2) Click on one of the type selector buttons.  If the file
name contains one of the known types (see table below),
then the file name will appear in green, and you can
skip this step.

EXT Type
RSRC Animation Stand Resource file
TAS Animation Stand Picture file
TXT Text file
XSH Animation Stand Exposure sheet file
FSR Animation Stand Full-speed run file
TGA Targa file
EXE Executable code
BAT Batch file
RLA rla file
AIFF AIFF file
AIFC AIFF-C file
TIFF TIFF file
RGB RGB file
RGBA RGBA file
ALIAS Alias file
BIN Binary dump file
CUBE Cubicomp file
DI Dithered image file
FACE Faceserver file
GIF GIF file
PNT MacPaint file
BYU B.Y.U. file
PPM P.P.M. file
SUN Sun format file
X X bitmap file
XMD X.M.D. file
YUV Abekas Y.U.V. file

3) Click on a file or directory.  If you click on a file, that file
is opened.  If you click on a directory, the open dialog
does a “cd” to that directory and continues at this step.

Note:  If you center-click the File field in the Exposure sheet, you
also get this dialog box.
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This selection Opens a picture file into a window, but now for
editing.  The picture is Opened as a palette window.  The new
palette window will show the name of the file it came from, but  the
file does not remain Open.  Clicking in the palette window will
select a color for drawing.

Scan

This menu item allows you to scan one or more images.  First, you
are presented with a dialog.  The dialog you get will depend on the
scanner connected.  The following is the dialog for HP scanners.

This dialog contains several options, each of which affects the
scanning process:

View:  This button does a quick low-resolution scan of the
document in grayscale, but otherwise using the current settings.
The scan is placed into the Preview & Crop sub-window.
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Cancel:  Cancels the operation without performing a scan or saving
the values.

Scan:  Performs the requested scan(s), and retains the values
entered.  Once entered, verified, and used, the values become part
of the preferences, and can be stored with and loaded from a
preference file.  Preferences may be modified by the scanner.  For
instance, if you choose 30 DPI, and the scanner connected can’t go
under 38 DPI, the DPI stored in the preferences would be 38.

Learn:  Scans a blank document, to determine where the peg holes
are, and what the bounds of the paper are, setting the crop area.

Preview & Crop:  This area is used to set up the scanning area.
Use View to get a document image into this sub-window.  Then,
drag out a rectangle to show which areas of the document are to be
scanned, or click to indicate that the entire document is to be
scanned.  Shift-drag or shift-click to indicate which parts of the
scanned area are to be saved.  The reason you would want to scan
an area, but not save it, is that part of the document might have
registration peg images and/or a cel ID in it.  You would want to
scan those items so that they could be used in alignment and
naming, but not save them as part of the art.

Clipping levels:  This double slider indicates the minimum and
maximum values to be considered significant.  Any pixels darker
than this slider’s dark setting are set to black.  Any pixels lighter
than this slider’s light setting are set to white.

Intensity:  This slider controls the scanner’s light/dark setting.  At
the center position, you get what the scanner sees.  As the slider
moves right, the document appears lighter.  As the slider moves
left, the document appears darker.

Contrast:  This slider controls the scanner’s contrast setting.  At
the center position, you get what the scanner sees.  As the slider
moves right, colors get closer to white and black.  As the slider
moves left, colors get closer to gray.

DPI:  This field determines the DPI at which the image will be
scanned, within the scanner’s limits.

Hold:  When the scanner is building an exposure sheet, the Hold
field determines how many times the scanned image will appear.  If
the Hold field is 1, the image will be scanned once, and dropped
onto disk once, and loaded into the exposure sheet in one cel.  If the
Hold field is greater than 1, the image will still be scanned and
stored once, but will be called into the exposure sheet in multiple
frames.  This field may be overridden by OCR data.
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Multiple scans:  When this item is not checked, one image is
scanned.  When this item is checked, the item is scanned, and then
the automatic sheet feeder is signaled to load the next sheet of
paper.  So long as all goes well, the scanning process will continue.
If a file name was specified, the file name is changed to reflect the
Hold field.  For instance, if a file name of C-17 was used, and a hold
value of 2 was used, the next automatic name used would be C-19.
These automatic names can be overridden by OCR data.

Declutter:  If this item is checked,  a declutter operation will be
done, as if the Declutter operation was chosen from the Effects
menu.

Patch holes: If this item is checked, hole patching operation will
be done, as if the Patch operation was chosen from the Effects
menu.

Portrait mode:  Normally, cels are scanned in landscape mode.
When Portrait mode is checked, the image orientation changes.

Regionize:  If this option is selected, a Regionize operation will be
done when scanning is complete.

Depth:  This menu determines the scanning depth:

Black and white:  When this setting is used, the scanner is
directed to scan in black and white only.  When the file is
used in the exposure sheet, it will load into the frame as if it
had the WHITE Note.  This will remain true until the file is
rewritten by a Save operation.

Grays:  When this setting is used, the scanner is directed to
scan in grayscale mode, using as many grayscale bits are
available in the scanner.  When the file is used in the
exposure sheet, it will load into the frame as if it had the
MINIMUM Note.  This will remain true until the file is
rewritten by a Save operation.

Color:  When this setting is used, the scanner is directed to
scan in color mode, using 24 bits.
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Register by:  This menu tells The Animation Stand how your art
is to be registered:

Pegs:  This means that your art is placed securely against
the document guide, or on a pegbar.  It assumes that the
documents are scanned at exactly the same location each
time, and that no changes need be made.

Dies:  This means that the document is held securely in
guides, and can slip only in one direction, and can't rotate.
To use this setting, you must use Acme-punched paper.  The
Animation Stand will find the holes, and use their positions
to set the coordinates for the registration tool.  This process
takes virtually no time.

Feeder:  This means that the paper can both shift and
wobble.  To use this setting, you must use Acme-punched
paper.  The Animation Stand will find the holes, and use
their positions to set the coordinates for the registration tool,
as well as rotate the document into alignment.  Rotating the
document takes some time.

Filter:  This menu presents a list of the various filtering techniques
available in the scanner.  See your scanner manual for details.

Name:  If this field is not filled in, all scanned items appear in a
paint window(s).  None of the special modes mentioned above are
set up, since those modes apply only to files saved on disk by the
scanning process.  All files so scanned will be untitled, with the
newest scan being the frontmost document.  If this field is filled in,
documents will be saved to disk as soon as they are scanned and
ready.  When multiple scans are done, the file name will advance by
the value of the Hold field.  For instance, a Name of C-17  with a
Hold field of 2 would result in the next file being named C-19.  This
field can be overridden by OCR data.

If an exposure sheet is open, file names are also placed into the
exposure sheet.  The location used in the exposure sheet is the first
cel of the first frame marked.  When a cel is scanned, it is stored
onto the disk as a picture file.  Its name is then placed into the
exposure sheet at the specified location.  If the Hold field so
specifies, the file name may be repeatedly placed in this manner.
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OCR:  OCR stands for Optical Character Recognition.  If the OCR
checkbox is set, this processing is performed.  If not checked, this
step is skipped.  To use this function, you must use printed paper,
or affix printed labels to your documents.  If using labels, paste in
the label just to the right of the center registration peg.

The first two digit  slots hold the layer number, 0 (layer 1 in the
exposure sheet) for background, and 1 through 99 for layers over
that (layers 2 through 100 in the exposure sheet).  The next four
digit slots hold the frame number.  Together, these six digit slots
are assembled into a file name.  Layer 0 is coded as BG, and other
layers are coded as A  through Z.  Then a dash appears, and then
the numbers appear.  The two digit slots in the brackets allow you
to override the dialogs Hold time for this drawing.  Thus,

would result in a file name of C-17.  The name entered here will
override any use of the Name field, and the Hold would override to
2.

The symbols used in OCR must be drawn as follow:

Close

This selection closes the front-most document window.  If the front-
most window is the Current Frame window, then the Exposure
sheet window is closed with it.  If the front-most window is the
Exposure sheet window, then the Current Frame window is
closed with it.  This selection does not close the Status window or
any of the Tool windows.
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If a document is being closed, rather than just a window into a
document, and the document has been modified but not saved, you
are presented with a dialog asking what you want done with the
file:

Pressing OK begins a Save process on the file.  Save is discussed
in more detail later.

Pressing Discard closes the file without first saving it.  All of your
work on the file will  be lost.

Pressing Cancel aborts the closing process, and neither the file nor
the window is closed.

Save

32 bits:  This function saves the current document window.  You
may save the document in any format, the palette, the patterns, the
compiled PF key code, the preferences, or all of the above.  A dialog
appears to give you these choices.

64 bits:  This function saves the current document window.  You
may save the document in either 64-bit format, the palette, the
patterns, the compiled PF key code, the preferences, or all of the
above.  A dialog appears to give you these choices.  Only The
Animation Stand’s own format, and RGB format can hold 64 bit
data.

Save area is the same as Save, with two major differences:  First,
this command is only available on paint windows with a selected
area, and second, only the selected area is saved.  This will
generally result in a nonrectangular document.  When compositing
layer upon layer in the Current Frame window, only the saved
areas will have any effect.  The edges may also be taken into
account by various edge processing commands and settings
described elsewhere.
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The following dialog appears:

Save all Saves everything in the document, including the pens,
color and pattern palettes, and special settings you have used.

Document Saves everything in the front-most window, but nothing
else relating to it (such as the palette).

Palette Saves the color palette only.

Patterns Saves the patterns only.

PF keys Saves the compiled PF key code only.  PF-key text files
themselves are not saved by this button, only the compiled
executable PF key.  To save the PF text file itself, use Save when
the PF document window you wish saved is front-most.
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Preferences Saves the preference settings, such as pen shapes and
sizes, the results of tool edits, the results of mode edits, etc.  Items
set by Set playback are not saved by this button, but are saved as
part of an Exposure sheet.

Other buttons save the picture data in the indicated format.

Next Cel

This function saves the current cel window, closes it, and then
opens the next cel in succession.  This is used to paint multiple cels.
For instance, if you have scanned in a series of cels, named SCAN01
(or SCAN1) through SCAN35, you could open SCAN01, paint it,
save it, close it, and then open SCAN02 in the usual way.
Alternatively, you could open SCAN01, paint it, and then invoke
Next cel, which would go through the above process, and would
automatically open SCAN02.  For another example, X-1B follows X-
1A.

When automatic painting is used, this function must be used to
finish one cel and start the next.

There is also a Previous cel function, which goes back one cel.

Document Info

For the Exposure sheet window, the Document info function
outputs text with a full management report and statistics on the
Exposure sheet.  For paint windows, it outputs text which gives
statistics on the document and window.
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Regionization is a method of precomputing all the painting that has
to be done.  Without regionization, The Animation Stand must
compute where paint can flow, from the point you click at in a
document, to the extent of the flow.  When a document is
regionized, all possible flow patterns are analyzed, and when you
click in the document, all the program has to do is to redraw the
area.  Also, you can tell that a document has been regionized when
it's loading:  You'll see a happy-face.

Regionize
To regionize a group of files, follow these steps:

Step 1: Create a new exposure sheet.

Step 2: Add all files to be regionized into the exposure sheet.
Order and framing is unimportant, just so the names
appear in the sheet.

Step 3: For each file that is to have lines patched, place PATCH
into the Notes field for that layer.  The regionizer does
not actually patch the holes in the lines, but it acts as if
the lines have been patched.  Thus, you get your lines
just as they looked, and you get paint that does not flow
through.

Step 4: Select Regionize from the File menu.  All files in the
sheet will be regionized. The Status window will show
the number of files thus batch processed.

Step 5: When the process is complete, paint the cels as you
normally would, but faster.  Regionized files flash a
happy face on the cursor when loading.

De-regionize
If, for some reason, you wish to de-regionize a file, so that paintable
areas need to be recomputed, select De-regionize from the file
menu.  Changes are applied to the in-memory copy only.

Print

This function outputs the contents of the Exposure Sheet window in
a printable format.
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This function is used to exit the program.  Any open files go through
the saving process, asking if it should be saved.

Edit Menu

The following menu items apply to the Edit menu:

Undo — Undoes the preceding operation.

Cut — Removes the selected area or item, and places it into the
clipboard.

Copy — Copies the selected area it item into the clipboard

Paste and Paste before — Inserts an item from the clipboard
into the document.

Insert — A special form of Paste, described later.

Clear — Clears the selected area

Clear all — Clears the entire document and/or auto-paint list.

Select all — Selects the entire document, regardless of settings

Change functions — Changes values in the exposure sheet.

Show clipboard — Shows the clipboard as a full-screen window.
Click the mouse to return to normal operation.

Undo

This function undoes the last action, assuming that the last action
was not itself some form of undo.  For instance, the Magic eraser
tool is a partial undo, and thus cannot be undone.  Also, the ability
to undo an action depends on the amount of memory available.  An
action can’t be undone if there was no room for an undo buffer.

Usually, you can undo an undo, “re-doing” an action.
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Cut removes whatever area is selected, and places it into the
clipboard.

Copy

Copy places whatever area is selected into the clipboard.

Paste

The operation of Paste depends on the current mode of operation.
Whenever there is a text edit in progress, and if the clipboard
contains text, the clipboard's text replaces the marked text.  If there
is no text marked, then the clipboard's text is inserted at the
current flashing cursor position.

For paint documents (without an active text edit), the picture in the
clipboard is pasted in as a floating image, in its own layer above the
rest of the document.  This layer may be moved or erased.  Any
action which changes or saves the document will cause the floating
paste layer to be stamped onto the document at its current location.
You may also use the Merge command from the Effects menu to
merge the floating paste layer in using some special mode or
setting.  If there is no picture in the clipboard, but there is text, the
text is formatted into a picture using the current font settings.
Normally, the floating image will appear in the size and location
from which it was cut.  If there is some reason that the image can't
be pasted into its original location, such as the original location
being off the end of the document, then the new floating layer
appears centered over the document.  If there is a selection in effect,
the new floating layer is scaled to the size and position of the
current selection.  This technique can be used to scale an old
document to a new size:  Create a new document, select it, and
paste in the old document.
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For Exposure sheet documents, the Exposure sheet contents of
the clipboard are inserted, replacing the currently selected area.
Note that the End of film marker cannot be destroyed or
overwritten.  If there is no Exposure sheet item in the clipboard,
but there is text, the text is taken to be tab-delimited spreadsheet
storage, and is converted to Exposure sheet format, and then
pasted.

Paste before is equivalent to Paste (for the Exposure sheet
only), except that instead of replacing the selected area, the
clipboard contents are pasted in before the selected area, and no
data is lost.

Insert

Insert is an extremely specialized form of Paste.  When the
clipboard contains a copy of some or all of an Exposure sheet,
insert will insert a number of layers as follows at the beginnings of
a series of frames, more or less as a vertical column.

This is best shown by example:

Let's say that the following section of Exposure sheet is copied
into the clipboard:
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And the following section of an Exposure sheet is then selected:

This will result in the copied area being inserted into the Exposure
sheet, resulting in:

This technique allows easy set-up of large numbers of varying
actions in one scene, since all motions can be worked out
independently, and then merged into a single scene, by inserting
each movement set into the scene with the Insert function.



104    The Animation Stand

In order for the Insert function to operate, the following conditions
must be true:

• The clipboard must contain Exposure sheet data.

• The clipboard must contain layers only.

• The clipboard may not contain any interpolation sets or
markers.

• A layer, layers, or frames in the Exposure sheet must be
marked or selected.

• If there are a certain number of frames in the clipboard, then
there must be room for that many frames in the Exposure
sheet between the first marked layer and the end of the film, or
the first Exposure sheet or marker.

Any deviation from this set of criteria will prevent Insert from
functioning.

Change functions

The Change text fields, and Change numeric fields functions
are similar.  The Change dialog allows you to specify and change
values in the exposure sheet, acting all selected layers, or on the
entire exposure sheet if no selection has been made.

Here, only the Change text fields dialog is shown, since Change
numeric fields is a simple subset of the Change operation.
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Change and To fields control what is to be found, and what it is to
be changed to.  Note that the exposure sheet’s File field contains
more text than is shown.  For instance, if file File is in path /path,
then its actual text is /path /File.

If Exact match is on, “Cat” matches “Cat”, but not “Cataract”.
When off (the default), “Cat” matches “Cataract”.

The most common use of the Change text fields function is to
correct an exposure sheet to reflect new file positions.  If you move a
file or set of files or directory, the exposure sheet will not be able to
locate the files.  It will still be looking for the files in their old
locations.  Thus, you would use the change function to redirect the
search.  For instance, if we had our files in a path named  /path,
and then renamed the path to /newpath, we would have to use
Change to change path to newpath.

Options Menu

The following menus items apply to the Options menu:

Set new cel size — Sets preferences for new windows

Preferences — Sets general preferences.

Set DPI — Opens a new window into the current paint document
at a specified DPI setting.

Snap to grid — Turns this mode on or off.

Visible grid — Turns this mode on or off.

Compile — Compiles the current text window into a PF-tool.  You
are presented with a dialog asking where (into which PF tool) to
store the compiled code.

Lightbox — Sets lightbox preferences for a single picture window.

Field guide overlay — Allows you to post or remove a field guide.
You may specify the number of fields.  Specify 0 for no field guide
overlay.
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This option allows you to change the size and/or depth of the new
cells which the New cel and New film options of the File menu
will create.  There's a standard size:  648 x 486.  You may also use
custom sizes.  To set the new cel size and/or depth, bring up the
dialog from the menu:

Each of the following items describes an item in the dialog.

Width and height fields:  This is the height and width of the
document, in pixels, or any other form of measurement..  Anywhere
sizes are entered, you can enter other forms:  xxx is a number of
pixels.  xxxpt is a number of points.  xxxpi is a number of picas.
xxxmm is a number of millimeters.  xxxcm is a number of
centimeters.  xxxm is a number of meters.  xxx" is a number of
inches.  xxx' is a number of feet.

648x486 button:  This button can be used to set the height and
width fields to match the height and width to the size of a standard
ßcam NTSC screen.

DPI field:  This is the number of DPI (dots per inch) in the
document.  This is not the display DPI.  Rather, it is the print DPI.
You will always see one document pixel per screen pixel onscreen.
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Open document at …% size field:  When this field is set to 100,
documents will be opened at their normal size, and in the position
they last occupied.  When this field is any other number, the
document will be opened at some other percentage of its normal
display size, and the window will automatically position and size
itself without regard to the last known location stored in the file.
This resizing will not affect the stored off-screen data, only the
displayed size.

Preferences

This item changes to the ways in which the program works.  Each
of the items will be explained on subsequent cards of this article.
To set the prefs, bring up the dialog from the menu:

Grid size:  This field allows you set the number of pixels between
the cyan (printer's blue) lines of the grid.  This applies to both paint
cels and the Current Frame window.  Note that you may use pixel
counts, or units, such as points (pt), picas (pi), metric (mm, cm, and
m), and English (" and ') units.

32 bits:  Color slop:  This item is used to control color matching.
The preset, or default, setting is 0, which means that colors must
match exactly.  127 means that colors any even close will match.
Settings between these two values lead to different color match
tolerances.  The setting of this field affects the functioning of the
Paint Bucket tool, the Bounded Fill tool, and the color comparison
performed by the three selection tools, when they are using an
Ignore or Only color match criterion.
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64 bits:  Color slop:  This item is used to control color matching.
The preset, or default, setting is 0, which means that colors must
match exactly.  32,767 means that colors any even close will match.
Settings between these two values lead to different color match
tolerances.  The setting of this field affects the functioning of the
Paint Bucket tool, the Bounded Fill tool, and the color comparison
performed by the three selection tools, when they are using an
Ignore or Only color match criterion.

Note:  The setting of this field affects the functioning of the Paint
Bucket tool, the Bounded Fill tool, and the color comparison
performed by the three selection tools, when they are using an
Ignore or Only color match criterion.

Let's take an example.  Say you have a white cloud against blue sky
in your cel, and you wish to repaint the cloud, making it darker.
The color you are really seeking is any color which is sort of white,
and not any color which is sort of blue.  Let’s try an example:

Step 1 Press ALT-O to open a new document.  The Open dialog
will appear.

Step 2 Double-click on the file Cloud.  The dialog will
disappear, and the cloud and the sky will appear in a
new window.

Step 3 Press ALT-2 to bring up the Preferences dialog.

Step 4 32 bits:  Enter 127 into the Slop field.

Step 4 64 bits:  Enter 32767 into the Slop field.

Step 5 Press Return to end the Preferences edit and accept
the changes.

Step 6 Now, let’s set up a darkening effect, using black at a
10% blend percentage.  Mouse down on the Mode Box.
The Mode list will appear.

Step 7 Center-click on the Blend mode icon.  The Blend dialog
will appear.

Step 8 Enter 10 to set a 10% blend level.

Step 9 Press Return to end the edit and accept the changes.

Step 10 Select the Paint Bucket tool.

Step 11 Click in the cloud.  The painting will be analyzed, and
The Animation Stand will find that the cloud should
be filled.  It will be filled with 10% black, darkening it.
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Edge antialiasing:  This menu is used to control how much
antialiasing is used during drawing operations.  The more
antialiasing used, the longer drawing takes, but the smoother the
edges appear.  Conversely, at low antialiasing values, drawn items
will look jagged, but draw quickly.  At 1:1 antialiasing, antialiasing
is off, and you will get exactly what you are drawing, with no post-
draw smoothing.  At antialiasing values of 4:1 through 256:1, The
Animation Stand will draw each pixel using 4 times as many
subpixels through 256 times as many subpixels as there are pixels,
taking 4 to 256 times as long to draw offscreen, too.  Assuming that
you are going to use antialiasing, the most reasonable values to use
are 4:1 and 16:1.  To find out just what antialiasing will do for you,
try the following steps:

Step 1 Press ALT-N to Open a new paint document.

Step 2 Select the circle tool.

Step 3 Draw a circle.

Step 4 Press ALT-2 to bring up the Preference dialog.

Step 5 Select 16:1 antialiasing.

Step 6 Press Return to close the dialog.

Step 7 Draw another circle.  You'll see the difference in line
quality.

Wash to:  This menu is used to control how the various partially
transparent paint modes work.  It has four settings:  Underlying
image (the default), White, Black, and Background color.  Each
of the menu items describe (on a pixel-by-pixel basis) how
transparency works in various modes, such as blend, and the
various "watercolor" modes.  For instance, if a particular portion of
the area being drawn into is 75% opaque and 25% transparent, then
75% of the new image (at the current pixel, at least) comes from the
current color or pattern.  25% comes from somewhere else.  This
preference menu determines where that somewhere else is.

Underlying image means that the other 25% (for this
example) comes from the underlying, existing image.

White and Black mean that the draw color or pattern is
mixed with white or black, regardless of the underlying
image.  These settings can also affect paint-time edge-pixel
antialiasing.

Background color means that the draw color or pattern is
mixed with the chosen background color, regardless of the
underlying image.
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Icon animation:  When this item is checked (the default), the
animated tools animate.  Otherwise, they will appear as normal,
static icons.

Pressure affects width:  When this preference is off, all tools
work with the specified pen size.  When this preference is on (the
default), the operation of the Free draw tools, the Constrained free
draw tools, and the Airbrush tool are all affected by stylus pressure
when using a pressure-sensitive tablet.  At the minimal pressure
(threshold stylus pressure, as defined by the stylus-controlling
control panel item), the tools all paint at single pixels widths.  At
the maximum pressure, the tools all paint with the selected pen or
flow pattern.  For points in-between, a linear interpolation is made.
Thus, if a 20x20 pixel pen was selected, and the force used on the
stylus was halfway between the stylus threshold pressure and the
maximum pressure, a 10x10 pixel pen would be used.

Note:  Pen sizing is changed only for rectangular and round pens.
The clipboard pen is not affected.

Pressure affects flow:  When this preference is off (the default),
all tools work with the specified ink type.  When this preference is
on, the operation of the Free draw tools, the Constrained free draw
tools, and the Airbrush tool are all affected by stylus pressure when
using a pressure-sensitive tablet.  At the minimal pressure
(threshold stylus pressure, as defined by the stylus-controlling
control panel item), the tools all paint at 1% of their normal ink
flow.  At the maximum pressure, the tools all paint with the
selected color or flow pattern.  For points in-between, a linear
interpolation is made.  Thus, if black was selected, and the force
used on the stylus was halfway between the stylus threshold
pressure and the maximum pressure, gray would be painted.

Note:  Paint color is only affected for the Normal, Minimum, and
Maximum modes.

When a pattern is used with this mode, each time the pen image is
painted, it is painted in a pattern which is a weighted average of
the background color and the selected paint pattern.

Pre-scan for DPI:  This preference affects the opening of picture
files.  With this preference on, the file's DPI setting is preserved.
With this preference off, files load at the DPI setting specified in the
New cel size dialog of the Options menu
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This selection causes all paint windows and the Current Frame
window use a grid.  All mouse actions in these windows use only
mouse positions at the intersection of grid lines.  If the mouse is
over the intersection of grid lines, the actual mouse position is used.
If not, the mouse position is used as if the mouse were really at the
grid line intersection nearest the actual mouse position, looking up
and to the left.

This option has effect whether or not the Visible grid option is in
use.

Step 1 Press ALT-N to get a new paint window.

Step 2 Press ALT-5 to bring up a grid, so that you can see what
you’re doing.

Step 3 Press ALT-4 to lock to the grid.  Although you can’t see
it at this point, the Snap to grid entry of the Options
menu just received a check mark.

Step 4 Paint.  Note that the lines always pass through the
intersection points of the grid lines.

Visible Grid

This selection causes all paint windows and the Current Frame
window show a grid.

Step 1 Press ALT-N to get a new paint window.

Step 2 Select Visible grid from the Options menu.  Notice
that the window fills with a grid of cyan lines.

Step 3 Use the mouse to pull down the Options menu.  Notice
that the Visible grid entry has a check mark to its left.
This signifies that Visible grid is in effect.

Step 4 To get rid of Visible grid, just release the mouse button
over Visible grid.

You can edit the grid spacing by selecting Preferences from the
Options menu, or by pressing ALT-2.
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Normally, the picture shown in a paint window is of the document
itself.  But, under some circumstances, other picture data will also
be shown in the window.  The Lightbox dialog of the Options
menu allows you to create a “lightbox” function, control how the
encrusting mode works, and control the “painting surface” through
texture (or bump) mapping.  The dialog appears as follows:

Each of the functions of this dialog use a menu which calls out other
windows.  If what you need is not already open as a window, you
can open it from this dialog using the Open button.  The document
will be opened behind the current one (out of the way), and will be
immediately available on the pop-up menus.
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The lightbox feature of The Animation Stand emulates a lightbox
used in animation studios.  This feature is most often used in
“inbetweening” (or “’tweening”) between two cels, to get a third cel
which is halfway between them in the action.  For instance, let’s say
that a character is to go from a standing position to a sitting
position in 15 frames.  First, you draw frame 1, then frame 15.
Next, draw frame 7 as an in-between between frames 1 and 15.
Next, draw frame 4 as an in-between between frames 1 and 7.  This
process continues until all 15 frames have been drawn.  To perform
these drawing operations, it would be useful to see frames 1 and 15
composited over frame 7 as you’re drawing it.  Also, for the example
above, it would be nice to have the chair picture available while
drawing the character in the sitting position.  To do this, follow
these steps:

Step 1 Create a new cel.

Step 2 Draw the character in a standing position.

Step 3 Save the cel as Frame 1.

Step 4 Create a second new cel.

Step 5 Draw the chair.

Step 6 Save the cel as Chair.

Step 7 Create a new cel, which will become frame 15.

Step 8 Invoke the Lightbox function of the Options menu.

Step 9 From the Light table 1 menu of the dialog, select Chair
as the source image and press Return.

Step 10 Draw the character in the sitting position on the chair.
You will notice that newly painted items, while they are
being painted, appear normally; but when you release
the mouse, the old image fades back in.

Step 11 Invoke the Lightbox function again.

Step 12 Select None for the Light table 1 menu option and
press Return.  Note that the chair image vanishes, and
the character drawing now appears as it was painted.

Step 13 Save the drawing as Frame 15.

Step 14 Create a new cel.

Step 15 Invoke the Lightbox function again.
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Step 16 This time, we need two light table images.  Select Frame
1 for the Light table 1 option, and Frame 15 for the
Light table 2 option; then, press Return.  The order of
the elements in the light table menus is unimportant at
this time.

Step 17 Draw frame 7.

Step 18 Save this as Frame 7.

Step 19 Repeat steps 14 through 18 until you are done.

Encrusting

When the Encrust mode is used in painting, you are painting a
part of one document onto another.  The document from which this
data comes from is called the encrust source.  You set the encrust
source using the Source windows dialog of the Options menu.
Just select the source window in the Encrust menu.  Each paint
document can have its own encrust source.

Texture mapping

Normally, The Animation Stand paints as if you have ideal ink
being placed onto ideal paper.  For instance, in the normal, opaque
paint mode, each pixel is drawn at 100% opacity.  In the real world,
however, painting does not always work like this.  For instance, in
drawing on a blackboard with chalk, you tend to get large areas of
100% opacity, with small areas of no chalk at all, and a few pixels'
worth of some values near 50%.  The Animation Stand gives you
two methods of having texturized drawing:

The Built-in Way:
Step 1 Open a document from the supplied Bump map

directory, for instance, Chalk.

Step 2 Create a new cel.

Step 3 Bring up the Source windows dialog.

Step 4 Select Chalk (for this example) from the Texture menu
and press Return.

Step 5 Draw.
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The User-defined Way:
Step 1 Take a picture of a surface, with a very low angle,

bright, stark light.

Step 2 Scan it into the Bump map directory.

Step 3 It's now “built-in”.  Proceed as above.

Step 4 Select Chalk (for this example) from the Texture menu
and press Return.

Step 5 Draw.

Group sets

There are four group set buttons.  Each affects the lightbox function
for all of the documents in memory.

Previous means that each item uses the previous item as its
lightbox.  For instance, XX05  would use XX04  as its lightbox
image.

Previous 2 means that each item uses the two previous items as
its lightbox images.  For instance, XX05  would use XX03  and XX04
as its lightbox images.

Previous and next would mean that XX0 5 would use XX0 4 and
XX06.

None turns off the lightbox feature for all open cels.

Effects

The following options are available in the Effects menu:

Resize — Allows you to resize and/or squash or stretch the
selected area, numerically.

Merge — Places the floating paste area into the document.

Unprotect — Drops any protected zones established by the Protect
tool or mode.

Discern line — Determines the exact location of a fuzzy line.

Patch lines —  Patches holes in lines
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Declutter  —  Removes scanner clutter

RGB block change — Changes the RGB values of an area.

HSV block change — Changes the HSV values of an area.

Legalize area and Legalize palette — Transforms colors to
NTSC-legal values.

Sort palette — Sorts the palette into name order

Invert alpha — In the selected area, all alpha channels are
inverted:  Transparent becomes opaque, and opaque becomes
transparent.

Separate alpha — Separates the document into RGB and alpha
components.

Merge alpha — Merges the first document (RGB) with the second
(alpha) to produce an alpha//RGB document.

Generate hard alpha — Automatically creates a hard-edge alpha
channel to mask out the background.

Generate soft alpha — Automatically creates a soft-edge alpha
channel to mask out the background.

Set alpha to white, Set alpha to black, and Set alpha to
red — Aid in the viewing of alpha channels.

Crop — Crops the image to the selected area.
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This function is used to control how and when a floating paste
object drops into the document.  A floating paste object occurs when
a clipboard image is pasted onto a paint window.  Rather than
becoming a true part of the document immediately, the paste object
floats above the document.  You can reposition it without changing
the document, but if you go to another window, or begin painting,
the object drops into the document at its current position, exactly as
it looks.  Using the Merge function, you can cause the floating paste
object to drop at a particular location immediately.  This function
uses the current paint mode to paste the image in.  For instance,
let's say that you wanted to paste in an image using the Blend
mode; here's what you do:

Step 1 Use ALT-V to paste in the image.  It is now floating.

Step 2 Position the object.

Step 3 Select the Blend mode.

Step 4 Select Merge from the Effects menu.

Discern Line

This selection is used to point out where the center of a line is in a
selected area, or in the entire document.  The area is scanned.  The
darkest portion of all lines, no matter how faint or how low in
contrast, are redrawn in the current color or pattern.  This feature
is especially useful in reading scanned images.  For instance, let’s
say that some of the lines are too faint to notice, or that you need a
border of a certain color for use with one of the Paint bucket tools.
Use this function to mark the lines.

Step 1 Select an area of the document with the Marquee or
Lasso tool, or have no selection range to discern lines in
the entire document.

Step 2 Select a color or pattern in which to render the line.
Normally, this will be the darkest color in use in the
document, or simply black.  Do not use a color too light,
or you will get doubling effects.

Step 3 Select Discern line from the Effects menu.  The area
will be analyzed and redrawn.  During this process, the
number of lines left to be computed is displayed in red in
the Status window.
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This selection is used to patch one pixel holes.  The holes are
patched in the selected area only, or the whole document, if there is
no selection.  Holes larger than one  pixel are not patched because
they’re so often significant to the art.  On the other hand, they’re
easily seen.  Pixels darker then 50% are considered black for this
function, and pixels lighter then 50% are considered to be white.

RGB Block Change

This selection is used to change a group of colors, as defined by
minimum and maximum RGB color values, to another range of
colors defined in the same way.  Each pixel in the selected area, or
in the entire document is examined, one by one.

If the pixel’s red component falls between the minimum and
maximum red value, and the pixel’s green component falls between
the minimum and maximum green value, and the pixel’s blue value
falls between the minimum and maximum blue value, then that
pixel is changed.

32 bits:  The change occurs by finding the distance the pixel’s red
component lies along the line from the minimum to the maximum
red value, and adjusting that red component to a similar percentage
along the line from the low new red value to the new high red value.
This is best shown by example.  If the minimum red is 39 and the
maximum is 78, and the new low is 117 and the new high is 233,
then a red value of 19 would not be used, as it lies outside the
range.  A red value of 54 would be used.  54 is 40% of the way from
39 to 78.  Thus, a new red value of 163 would be used, as 163 is 40%
of the way from 117 to 233.

64 bits:  The change occurs by finding the distance the pixel’s red
component lies along the line from the minimum to the maximum
red value, and adjusting that red component to a similar percentage
along the line from the low new red value to the new high red value.
This is best shown by example.  If the minimum red is 10,000 and
the maximum is 20,000, and the new low is 30,000 and the new
high is 50,000, then a red value of 5,000 would not be used, as it lies
outside the range.  A red value of 14000 would be used.  14,000 is
40% of the way from 10,000 to 20,000.  Thus, a new red value of
38,000 would be used, as 38,000 is 40% of the way from 30,000 to
50,000.
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The green and blue pixel values are changed similarly.

Step 1 Select an area of the document with the Marquee or
Lasso tool, or have no selection range to affect the entire
document.

Step 2 Select RGB block change from the Effects menu.  The
following dialog box appears:

Step 3 Click on the first color box to set the minimum color,
independently in each of red, green, and blue
components.

Step 4 32 bits:  Use the Color Picker to pick a minimum color.
For this example, choose a color with red, green, and
blue values each of 39.

Step 4 64 bits:  Use the Color Picker to pick a minimum color.
For this example, choose a color with red, green, and
blue values each of 10,000.

Step 5 Click on the second color box to set the maximum color,
independently in each of red, green, and blue
components.

Step 6 32 bits:  Use the Color Picker to pick a maximum color.
For this example, choose a color with red, green, and
blue values each of 216.

Step 6 64 bits:  Use the Color Picker to pick a maximum color.
For this example, choose a color with red, green, and
blue values each of 50,000.

Step 7 Click on the third color box to set the new low color
values, independently in each of red, green, and blue
components.

Step 8 Use the Color Picker to pick a new low color.  For this
example, choose black.

Step 9 Click on the last color box to set the new high color
values, independently in each of red, green, and blue
components.
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Step 10 Use the Color Picker to pick a new high color.  For this
example, choose white.

Step 11 32 bits:  Click OK to start the block change operation.
The area will be analyzed and redrawn.  During this
process, the number of lines left to be computed is
displayed in red in the Status window.  In this example
all pixels which contain red, green, and blue components
each between 39 and 216 will be shifted to the range 0 to
255, in effect increasing the contrast of those colors.

Step 11 64 bits:  Click OK to start the block change operation.
The area will be analyzed and redrawn.  During this
process, the number of lines left to be computed is
displayed in red in the Status window.  In this example
all pixels which contain red, green, and blue components
each between 10,000 and 50,000 will be shifted to the
range 0 to 65,535, in effect increasing the contrast of
those colors.

There is an alternate method of loading the first two color boxes.
When the Eyedropper tool is used, each color displayed by that tool
is used to broaden the scope of the minimum and maximum colors.
If the color “sucked up” by the syringe is not in the
minimum/maximum range, then that color is added to the range,
pulling down the minimum or increasing the maximum, as needed.

HSV Block Change

This selection is used to change a group of colors, as defined by
minimum and maximum HSV color values, to another range of
colors defined in the same way.  Each pixel in the selected area, or
in the entire document is examined, one by one.

If the pixel’s hue component falls between the minimum and
maximum hue value, and the pixel’s saturation component falls
between the minimum and maximum saturation value, and the
pixel’s value falls between the minimum and maximum value, then
that pixel is changed.
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32 bits:  The change occurs by finding the distance the pixel’s hue
component lies along the line from the minimum to the maximum
hue value, and adjusting that hue component to a similar
percentage along the line from the low new hue value to the new
high hue value.  This is best shown by example.  If the minimum
hue is 10 and the maximum is 20, and the new low is 30 and the
new high is 60, then a hue value of 5 would not be used, as it lies
outside the range.  A hue value of 14 would be used.  14 is 40% of
the way from 10 to 20.  Thus, a new hue value of 42, would be used,
as 42 is 40% of the way from 30 to 60.

64 bits:  The change occurs by finding the distance the pixel’s hue
component lies along the line from the minimum to the maximum
hue value, and adjusting that hue component to a similar
percentage along the line from the low new hue value to the new
high hue value.  This is best shown by example.  If the minimum
hue is 10,000 and the maximum is 20,000, and the new low is
30,000 and the new high is 60,000, then a hue value of 5,000 would
not be used, as it lies outside the range.  A hue value of 14,000
would be used.  14,000 is 40% of the way from 10,000 to 20,000.
Thus, a new hue value of 42,000, would be used, as 42,000 is 40% of
the way from 30,000 to 60,000.

The saturation and value pixel components are changed similarly.

The usage of HSV block change is identical to that on RGB block
change, including the use of the Eyedropper tool.

Legalize

These functions serve to avoid color problems on composite
monitors and recorders.  Composite color systems (as opposed to
RGB and ß-Cam systems) have a problem with colors that are too
saturated.  These functions drop the saturation level to no more
than 75%.

64 bits:  Using legalization really only pertains to NTSC TV, and
not to movies.  Thus, it is unlikely that you will be using this
function from the 64-bit version.

Legalize area will examine each pixel in a given area (or the
entire document, if no area is selected), and drop the saturation as
needed on a pixel-by-pixel basis.

Legalize palette will examine each color in the palette, and drop
the palette color saturations to no more than 75%.  This may result
in some duplicate colors on the palette.
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The following items are available on the Animate menu:

Play sound file — Plays the current (marked) frame's sound file
(if any).

Add layers — Adds frames or layers to the Exposure sheet.

Expand — Expands a movement marker to individual frames.

Check exposure sheet — Checks an exposure sheet for errors
that would be encountered when laying out the animation.

3/2 frame pulldown — Translates the exposure sheet from 24
frames to 30 frames per second.

3/2 field pulldown — Translates the exposure sheet from 24
frames to 60 fields per second.

Set playback — Sets playback options.

Generate TEXT file — Converts the exposure sheet to text format,
for export to other systems.

Page flip — Page-flips all open picture windows.

Play or record — Plays or records exposure sheet as specified by
Set playback.

Save as group — Lays out an animation file.

Reduce to Leica-reel — Keeps only frames bearing KEY in their
Notes field, and retains timing.  Leica-reel exposure sheets shoot to
tape much faster.

Reduce to storyboard — Keeps only frames bearing KEY in
their Notes field, and sets all frames to shoot once only.
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This selection is one of the means to add frames or layers to your
Exposure sheet.  To use this selection, you must have a layer or a
field selected or marked.

Step 1 Click on a Frame field.  The position you click shows
before which layer the insertion is to take place.  To add
frames to the end of the film, or into an empty
Exposure sheet, click on the End of film marker.

Step 2 Select Add Layers from the Animate menu.  A dialog
appears:

Step 3 Decide what to add:

To add one layer of one frame, do nothing for this step,
since that is the default.

To add many frames, each of one layer, just type in the
number of frames you wish to add. This number will
replace the default one frame, and show some number of
frames of one layer each.

To add one frame of many layers, click on the Layers
field, and enter the number of layers you would like.

To add many frames, each of many layers, first type the
number of frames you would like, then press Tab, and
then enter the number of layers you would like in each
frame.

Step 4 Click on OK to add the frames.  Frames will renumber
themselves according to the changes made.
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This selection is used to expand frames on an Exposure sheet
from a Move, Pantograph, or Spline into a series of frames.  When
you select one of these markers, and then select Expand from the
Animate menu, that effect is expanded to every frame and every
cel in those frames.  Normally, you would only have the layers
expanded if there was (a) something you wanted to do to a
particular frame of the set, or (b) if you are going to export the data
to another program.

For instance, let's say you have a Move, shown below:

When you use Expand, the Exposure sheet will show this Move
in expanded form:

There is a big difference in the size, look, and feel of this expanded
set.  In the iconic format, the expansion still happens, but you can’t
see the new data values.
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NOTE:  Once something is expanded, you can't unExpand it, except
immediately thereafter, using Undo from the Edit menu.  If you
have 7 frames, 3 lines each, that will always be 7 frames, 3 lines
each.  You can't change it back to one line, because these frames are
now separate entities.

Check Exposure sheet

Whenever a frame is displayed or recorded, there may be certain
errors which occur.  Other possible problems of playback include
bad interpolation sets (for instance, a spline with the wrong number
of layers) and invalid parameters.  Attempting to record overnight
with an error in the Exposure sheet can cause a wasted night, and
a wasted video disk.  The Check Exposure sheet function
immediately checks for all such playback errors, and reports any
problems found.  Multiple errors may be reported.

Set Playback

This function allows you to set all animation record, playback, and
display parameters through its dialog:

Each of these controls gives you control over some aspect of
playback, image composition, display, or recording.  The following
cards explain each function in detail.
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Frame Numbers:  With this preference on, your film will display a
small box in the upper left-hand corner that gives the frame
number and the elapsed time of each frame.  With this preference
off (the default), the frames are unencumbered.

Loop:  With this preference on, your film will loop continuously,
when played back on the screen using the Play or record function
of the Animate menu, and when output using the Save as full-
speed run function of the Animate menu.  This is useful when
testing a movement, or when preparing a demo to be shown over
and over.  If this preference is off (the default), your film plays only
once.  To get out of the loop, press escape.

Centered reg.:  If this option is set, the (0,0) point of the each
frame moves from the frame’s upper left-hand corner to the center
of the frame.  If this option is not set, the (0,0) point remains in the
corner.

Allow links:  If this preference is on, links to other Exposure
sheets are executed when encountered during the playback or
recording of a film.  If this preference is off (the default), links to
other Exposure sheets are not honored during the playback or
recording of a film.  Links are never followed when editing a film or
a frame.

Invert alpha:  If this preference is on, the alpha channel of
composited frames will be inverted.

Fast rotates:  When on, this setting disables edge antialiasing
during rotates.

Faster/Larger:  When Larger/Faster is off, increased resolution
takes increased time.  For instance, 4:1 resolution takes 4 times as
long as Normal resolution.  If Larger/Faster is on, then 4:1
resolution will take 4 times as much memory, but very little more
time.  In general, you should see a 200% speed improvement using
this switch.

Tape posn. field will be used to control the tape position.  Or, for
other hardware, SMPTE code is required to position the tape.  For
hardware that can work either way, either the SMPTE code or the
Tape posn. field is used to control the tape position, arbitrated by
the SMPTE coding preference.

The Tape posn. field is a count of the number of frames into
the tape at which recording is to start.

The SMPTE code field is the SMPTE hour, minute, second,
and frame numbers at which to start recording.  Hours range
from 0 to 23, minutes and seconds range from 0 to 59, and
frames range from 0 to one less than the framing rate (0-29
for NTSC, 0-24 for PAL, and 0-23 for film).
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SMPTE coding, the Tape posn. and SMPTE code fields control
where recording will next start.  If the hardware requires a specific
frame number into the tape, then the Port preference controls
which port is used in direct control of external devices.

The Frames field controls which frames will be shot or displayed.
The range can be entered in a variety of forms.  This is best shown
by example:

* means to shoot or display all frames.

5 means to shoot or display only frame 5.

5-10 means to shoot or display only frames 5 through 10.

5- means to shoot or display starting at frame 5, and
continuing on through the end of the film.

-10 means to shoot or display from the beginning of the film,
but to stop at frame 10.

The Layers field controls which layers will be shot.  The form of
this range is the same as that of the Frame field.

The Framing rate field:  Positive framing rates are stated in
frames/second.  Thus, a framing rate of 30 means that 30
frames/second will be shown.  Negative framing rates are stated in
seconds/frame.  Thus a framing rate of -5 means 5 seconds/frame.  A
framing rate of 0 means that frames are to be shown on demand,
i.e., once per mouse click.  Thus, framing rates of 0 make The
Animation Stand, or its full-speed run files act like a slide
projector.

NOTE:  A framing rate of 0 is also useful when you want to see
small differences in animation.  You can advance through a few
frames one at a time to see what changed.

The Framing rate is also used when calculating new SMPTE
codes.  For example, if 30 frames are shot, and the framing rate is
30 frames/second, then 1 second has been shot.  However, if the
framing rate is 25 frames/second, then 1 second and 5 frames has
been shot.

When shooting to video tape, video disk, or film, the framing rate is
used only to calculate SMPTE codes and the running time of the
animation.  There is one exception to this:  The Sony video disk
recorder can be set into PAL or NTSC mode from the computer.
The Animation Stand will set the Sony to NTSC mode when the
framing rate is 30, and into PAL mode when the framing rate is 25.

This field can also affect the full-speed run playback, but only if the
full-speed run was generated in the current execution of The
Animation Stand.
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You can handle slide shows in three ways:

• Set the framing rate somewhere between 5 and 12
seconds/frame (-5 to -12).  The screen will display imposed
frame after imposed frame, keeping each frame on the screen
for the specified length of time.

• Set the framing rate at 30 frames/second, for  example.  When
you want to display a frame for 10 seconds, give it a hold time of
300 frame times on the Exposure Sheet.  Fades, wipes, and
movements will proceed at a nice speed.

• Set the framing rate to zero to get the frames to hold until you
click the mouse, which you can then use the mouse as an
Advance Frame button (applies to both Play or Record and
Save as full-speed run).

The Where menu controls where the output of the Play or Record
function of the Animate menu will be sent.

64 bits:  Note that shooting from the screen gives you 32 bit
accuracy, even when the art is stored in 64 bits.  To get fully
accurate output, save your animation as RGB files, and have
it shot by a film printer.

Normal:  If this option is chosen, then the Play or Record
function of the Animate menu will show the test run in the
Current Frame window, with no special processing.

Full screen:  If this option is chosen, then the Play or
Record function of the Animate menu will show the test
run on the full screen.

Lyon-Lamb , Diaquest, V/LAN, ARTI, & BCD:  If any of
these options is chosen, then the Play or Record function of
the Animate menu will show each frame of the film, full
screen, and send it to a controlled video tape recorder (VTR).
The current Tape Posn. field or the SMPTE code field and
the current VTR and Node number selections are used.
The Framing rate is used in setting up the recorder.
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GPI pulses:  If this option is chosen, then the Play or
Record function of the Animate menu will show each frame
of the film full screen, and a single pulse of duration 9.3ms
will be sent from the Port’s data transmit pin.  This is
actually the normal transmission of a meta-delete character.
If you use an Abekas A60 or A64 recorder, then you can
connect the modem data transmit line to the recorder’s GPI
pin (and ground to ground).  Set the recorder’s macro to
record a single frame.  When The Animation Stand sends
the GPI pulse, the data will be recorded.  Similarly, the
Hitachi time-lapse VCR can take a GPI pulse connection to
its external trigger connection.  Set its timing mode to 00 (on
demand).

Sony disc:  If this option is chosen, then the Play or
Record function of the Animate menu will show each frame
of the film, full screen, and send it to a Sony video disc
recorder.  The current Tape posn. field or the SMPTE code
fields and the framing rate is used.  The framing rate must
be 25 or 30.

A66 serial and A66 serial 90%:  Both of these settings use a
serial cable to drive an Abekas A66 recorder.  The A66 serial
90% setting also squashes the entire image to 90% vertical
size before any resolution boost.

The What menu controls what is recorded.

Both is the default.  It means that sight and sound are
played back or recorded to files, and just the visual portion is
recorded when using external devices.

Sight means that sight is played back or recorded to files or
external devices.

Sound means that only the audio portion is played back or
recorded to files.
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The Edges menu controlling how edges will be processed during
frame composition.

None:  This selection turns off all antialiasing.  When a new
layer is added to a frame, no special action is taken.

True Antialiasing:  This selection turns on true
antialiasing.  When a new layer is posted on top of another
layer in a frame (during Play or Record, Save as full-speed
run, et cetera, functions of the Animate menu), Each pixel
position within the selection area stored within the layer is
examined.  If a pixel is seen to be part of a jagged edge (a
“jaggy”), then that pixel is drawn at 50% transparency.  This
process is a time-consuming one, and can take 30 seconds per
layer per frame on a plain Mac II, although the expected
number is normally less.  Use this function when the best
edge-following correction of painted images (images stored as
pixels) is required.

Maximum change:  This type of antialiasing is processed
once a frame is fully composited (during Play or Record,
Save as full-speed run, et cetera, functions of the Animate
menu).  Use this function to limit the speed of signal voltage
shifts in old video systems, or to perform a horizontal image
smoothing operation.  Each component of color is analyzed
for each pair of adjacent pixels in each frame of the film.  The
difference in pixel RGB component values is limited to 128.
Thus, if  a frame has a white pixel followed by a black pixel,
the white pixel value (255) will be displayed as white.  The
black pixel adjacent to it (value 0), if displayed as black,
would mean a pixel-to-pixel value change of 255, which is
over the limit.  Thus, the black pixel is changed to conform to
the limit, white (255) - 128 = gray (127).

64 bits:  Again, maximum change is not very useful against
64 bit files.  When this function is used, change is limited to
32,767.

Defocus:  This type of antialiasing is processed once a frame
is fully composited (during Play or Record, Save as full-
speed run, et cetera, functions of the Animate menu).  A
slight defocusing is done.  Use this function to make an
image look as if it was shot to film, and then transferred to
video.  This will make output of The Animation Stand and
images filmed appear to have come from the same medium,
and will lead to very smooth special effects.

130      The Animation Stand



Menu items      131

The Display menu controls how the contents of the Current
Frame window are to be displayed.

Normal:  When this option is selected, the frame will be
displayed normally, showing exactly what is called for in the
Exposure sheet.

Disabled notes:  When this option is selected, the Notes
field of the exposure sheet will have no effect for optical press
emulation:  The MATTE, FADER, and similar Notes
commands will be ignored, but the FRAME and numeric
commands will be effective.

Silhouettes:  When this option is selected, the Current
Frame will be drawn as picture silhouettes only.  The
frontmost picture will be drawn in black, and deeper cel
layers will be drawn in increasingly light shades of gray.
This allows you to set up movement quickly, without waiting
for your artwork to be read from the disk or drawn.  All
artwork, except that generated by The Animation Stand
and containing a select area will be drawn as a rectangle,
showing the area covered by the cel.  Picture files containing
a select area will be drawn in the size and shape of the select
area, allowing true silhouetting.  This option also has the
effect of the Disabled notes option.

Mask and Reversed mask:  When Mask is selected, the
Current Frame will be drawn as picture pure black mask
silhouettes only.  This allows you to set up masks, without
having your background artwork ready.  All artwork, except
that generated by The Animation Stand and containing a
select area will be drawn as a rectangle, showing the area
covered by the cel.  Picture files containing a select area will
be drawn in the size and shape of the select area, allowing
true silhouetting.  These options also have the effect of the
Disabled notes option.  For the reversed effect, the mask
area is drawn as white on black.

Notes=MINIMUM and Notes=WHITE:  When this mode is
selected, the current frame will be drawn in pencil test mode,
where all layers without a Note will be brought in in
MINIMUM or WHITE mode.
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The Resolution menu controls the resolution of the Current
Frame window.  The menu contains options ranging from Normal
through 256:1.  Use increased resolution to get subpixel antialiasing
and/or subpixel motion.  Subpixel antialiasing and subpixel motion
mean that images are drawn using 4 to 256 offscreen pixels per
screen pixel, and then averaged down, to form the screen image.
You get very clean antialiasing this way if your images were
scanned in at higher than screen resolution, painted at higher than
screen resolution, produced in a draw program (a program which
mathematically defines edges), or if the image was drawn larger
than needed, and is being brought in at less than 100%
magnification.  Subpixel motion means that movement rates are
less likely to cause jitter, as coordinates are rounded off to halves,
fourths, eighths, or sixteenths of a pixel, rather than to the nearest
pixel coordinate.  Of course, the higher the resolution, the better the
image, and the longer frames will take to generate.  Subpixel
antialiasing here is in addition to any edge processing mode chosen
in the Edge field of this dialog.

Normal:  Selecting this option means that there is one
pixel's worth of resolution (one off-screen pixel) for each pixel
shown on the screen or in the Current Frame window.

4:1 (or 16:1, 64:1, or 256:1):  Selecting this option means that
there are 4 (or 16, 64, or 256) pixels' worth of resolution (4 [or
16, 64, or 256] off-screen pixels) for each pixel shown on the
screen or in the Current Frame window.  Drawings are
made in the off-screen port, which in this case is 4 (or 16, 64,
or 256) times as big as usual, and then reduced and at the
same time averaged, for placement onto the screen or into the
Current Frame window, at all times except during frame
composition (exposure sheet set-up).  Before running the film,
set the Resolution to n:1.  This setting only takes effect for
playbacks, recordings, and prints made using the Play or
Record function of the Animate menu.  The Prepare full-
speed run function doesn't use this method, and always
behave as if Normal was selected.
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The Size menu controls how the contents of the Current Frame
window are to be displayed, as far as size is concerned.  Several
options appear on this menu, ranging from /16 to Normal.  Use
divisors to generate thumbnail views, get a quick representation of
your work, and have artwork run quickly into and out of full speed
run files.

Normal:  When this option is selected, the frame will be
displayed normally, showing exactly what is called for in the
Exposure sheet.

/2 (and /4, /8, and /16):  This option causes the frames to be
drawn at half (and quarter, eighth, and sixteenth) the
vertical and horizontal sizes, meaning that normal frames
will be drawn in the upper-left-hand quadrant (or other
portion) of the window or screen only.  This is also equivalent
to looking at everything at 50% (or 25%, 12.5%, or 6.25%)
magnification.

The Interleave menu controls how field interleaving is to be
performed.

None:  This is the default setting.  At this setting, Framing
rate controls both the computational framing rate and the
actual hardware framing rate.  Each frame shot consists of
two fields computed at the same time, for display at the same
time.  This is the ideal setting for computer monitors and
film.

AB AB etc.:  This setting performs standard field
interlacing.  First, a frame is computed, and all of the "A"
fields are stored.  These are computer lines 0, 2, 4, etc.  These
lines, in TV jargon, are known as lines 1, 3, 5, etc.  Next,
another frame is computed, and all of the "B" fields are
stored.  These are computer lines 1, 3, 5, etc., also known as
TV lines 2, 4, 6, etc.  The two fields are combined into a single
frame, and then shot on a frame-by-frame basis.  When
interleaving is in effect, the Framing rate you enter is the
number of frames computed per second.  The number of
frames shot per second is half that.  For instance, to
interleave for NTSC, set a Framing rate of 60 fps, which
will compute 60 fields per second, and shoot it at 30 frames
per second.  The frames are shot two fields at a time, so there
is no concern as to whether your recorder or controller can
handle fields innately.

BA BA etc.:  This setting is equivalent to the above, except
that the field ordering is reversed.
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This selection is available when there is more than one paint
window open.  On the full screen, all of the open paint documents
are shown in sequence, one at a time, at the current framing rate,
in the order the windows are displayed on the screen.  In this way,
The Animation Stand can act like page-flipping through a book
on animation sketches.

Page flipping continues until you abort the process.  Note that if
your framing rate is 0, you will have to press the mouse button each
time you want to see a new frame.

Step 1 Open a new paint window.

Step 2 Paint the number “3” into the window.

Step 3 Open a second paint window.

Step 4 Paint the number “2” into the window.

Step 5 Open a third window.

Step 6 Paint the number “1” into the window.

Step 7 Press ALT-MINUS to set playback parameters.

Step 8 Enter a framing rate of 1, for 1 frame per second.

Step 9 Click OK.

Step 10 Press ALT-, to flip the cells.

Step 11 Press escape to stop.

Save As

This function allows you to save the contents of an Exposure
sheet as a single file or a group of files.  You are presented with a
standard Save dialog.  If you select Full-speed run, then the Save
dialog determines the name of the file.  For other formats, you are
selecting the first file name, and subsequent files (for subsequent
frames) will be named incrementally.

Full-speed run saves the file in a hardware-independent form,
which will run extremely quickly.  This format is saved in 32 bits,
regardless of version.
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Other formats all generate a group of files, one file per frame.  You
supply the first file name, and The Animation Stand numerically
generates the rest.  For instance, if you record a 100 file animation,
and name the first file FRAME0001, then the last file will be named
FRAME0100.  If the first file is named FRAME1, the last will be
named FRAME100.

64 bits:  Only Animation Stand and RGB format are supported for
output, as only these formats can hold the data.
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Paint

Painting is performed in paint windows, and is controlled by the
Status window and the menus that pop up in the Status window.
The remainder of this section defines the Status window, its
subwindow, and what all of its various tools and modes can do for
you.
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This position shows the current pen in use, and controls a pop-up
list used to select and edit pens.  The palette which appears is:

Clicking on any of the selections selects the pen shown.  You can
edit a pen by center-clicking on any cell but the last.

The last cell is the special pen cell.  Center-clicking on that cell will
transfer the contents of the clipboard into the special pen cell and
select it as the current pen.

138      The Animation Stand



Paint      139

When editing a pen (note that you can't edit the last pen), you will
see the following dialog:

Pen Height and Width can be entered in pixels, inches, feet,
millimeters, centimeters, meters, or picas.

Spacing (also pixels, English, or Metric measurements) determines
the spacing (from upper left corner to upper left corner) of the pen
images when using one of the Dotted Draw tools.

When Round is on, the pen is circular or oval.  When off, it is
square or rectangular.
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This is actually a pop-up control and a pair of status indicators:
The foreground color/pattern (here show in black, the default
foreground color) indicator, and the background color (here shown
in white, the default background color) indicator.

Clicking in the color box brings up the palette subwindow.  The
palette subwindow is divided into two sections, the selector area,
which normally contains the palette, and the Palette mode control
box, containing 6 buttons:

Each of the buttons leads to a different sub-section of the palette:

Foreground color palette:  When you click on this button, the palette
area shows a list of colors, as shown above.

Clicking on any of the colors will select that color at the current
foreground color.  Center-clicking on any of the colors will edit that
color, using the color picker defined below, allowing you to set RGB
and Alpha values for the color.
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Background color palette:  When you click on this button, the
palette area shows the list of colors again.  This time, clicking on
any of the colors will select the color as the background color.

Named colors:  When you click on this button, the palette area will
show the color selection.  This time, there will be names with each
color, and colors will be displayed 32 at a time:

Clicking on this button again will show the next 32 colors in the
list, looping back to the beginning of the list after all 256 palette
entries are shown.  Clicking on a color or its name selects the color
as the foreground color.  Center-clicking on a color allows you to
edit the color and its name.  Center-clicking on a color name allows
you to change the name.
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Patterns:  When you click on this button, the 32 entries of the
current pattern set are displayed:
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Pattern edit:  If you leave the pattern edit mode, you can return to
it with this button.  It brings up a 600% magnification of the
pattern:

Clicking on a pattern element changes that portion of the pattern to
the current draw color.

Mixing palette:  Clicking on this last button brings up a white area.
If you move the mouse into this area, you will see the cursor change
into a syringe.  Clicking in this state picks up the color under the
cursor as the current draw color.  If you hold Shift while clicking,
you airbrush the current color into the area, creating spreads of
that color.  This spread is calculated at 32 bits, regardless of the
monitor type in use.  Holding Shift and center-clicking clears the
spread area.  Center-clicking without Shift selects the color into the
background.

Once the pattern editor is used, you can save the pattern by
selecting the color store tool, and clicking on a pattern cel.  This tool
can also be used to store a color into the palette.
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When you save a document, or use Save as when no document is
up, you can save palettes and/or patterns using the Save all,
Palette only, or Pattern only buttons.

Color Picker

32 bits:  The color picker lets you choose a color in RGB, HSV, HLS,
and CMY spaces simultaneously.  You can enter values
numerically, where 0 indicates the lowest possible value, and 255 is
the highest value.  You can also use the sliders.  The black triangles
show you the current setting, and the colors of the slider indicate
the color you will get by moving the box on the slider to a particular
location.  The color box at the lower left is the current color.  There
is one alpha slider, as all color spaces use alpha (transparency) the
same way.
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64 bits:  The color picker lets you choose a color in RGB, HSV, HLS,
and CMY spaces simultaneously.  You can enter values
numerically, where 0 indicates the lowest possible value, and
65,535 is the highest value.  You can also use the sliders.  The black
triangles show you the current setting, and the colors of the slider
indicate the color you will get by moving the box on the slider to a
particular location.  The color box at the lower left is the current
color.  There is one alpha slider, as all color spaces use alpha
(transparency) the same way.

Tools

This position shows the current tool in use, and controls a pop-up
window/menu to select and edit tools.

Modes

This position shows the current paint mode, and controls a pop-up
list in the Status window to select and edit the modes.  Select a
mode by clicking on it.  Edit a mode by center-clicking.

These modes can be divided into functional groups, and are
explained individually and in groups:

Normal mode:  New items are painted exactly as shown

Add and Subtract modes:  The new paint's RGB values are added
to or subtracted from the existing paint's RGB values.

Blend mode:  The new paint's RGB values are blended (in a
weighted blend) with  the old paint's RGB values.

Oil mode:  This mode blurs the edges of new paint, mixing in
slightly with the existing paint, giving the feel of oil paint.

Minimum and Maximum modes:  The Minimum mode compares
the color of each pixel of the new paint with the color or each pixel
of the old paint.  For red, green, and blue (independently), the
minimum value is taken, possibly resulting in a third color.  For
Maximum, the opposite is true.
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And, Or, and Exclusive or modes:  Each of these modes is an
arithmetic mode.  And is black if black is painted over black, white
otherwise.  Or is white if white is painted over white, black
otherwise.  Exclusive or is black if black is painted over white or
white is painted over black, and white if black is painted over black
or white is painted over white.

The Watercolor ramp modes:  Each of these modes washes new
paint over old paint, running from 100% opacity to 100%
transparency.  The opaque end is at the top, bottom, right, or left, as
shown by the black portion of the mode's icon.

User-defined watercolor mode:  This mode is initially a ramped
wash, varying between opacity and transparency four times
horizontally, with no variance vertically.  However, the real purpose
of this mode is to let you establish your own transparency/wash
type.

Circular wash mode is another form of watercolor wash.  This
wash is 100% opaque at the center, and transparent at the edges,
using a spherical fall-off pattern (which is most like the "real
world") or a conical fall-off pattern (which artists seem to like more).
This mode can be edited.

Partial color modes:  Center-clicking this mode gives a dialog in
which you can choose to use the Hue and/or Saturation and/or Value
and/or Lightness of your draw color or pattern, without modifying
the other color components.  This mode is useful for colorizing and
decolorizing an area.  The default setting for this mode is to use
Hue only.  Hue only is useful for colorizing, as is
Hue+Lightness.  Saturation only is useful for decolorizing.  The
other settings may or may not be useful to you.

The Palette cycle mode fills the area you are painting without
regard to the color or pattern you have currently selected, and fills
the object painted with colors from the palette.  It paints the outer
edge or ring of pixels in the painted shape, and paints those pixels
with the first color from the palette.  The next row of pixels in is
painted with the second palette color.  The next row of pixels in is
painted with the third palette color.  This process continues until
there are no more pixels to paint.  If the number of colors in the
palette is exhausted before The Animation Stand runs out of
pixels to paint, then it starts from the beginning of the palette
again.  Thus, if there are 256 colors in the palette, the object
painted must be at least 513 pixels wide before a color would be
reused.  When text is entered in this mode, the outer row of pixels is
one color, and the inner row of pixels (you seldom see a font with
any portion more than three pixels across) is a second color.
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Gel mode:  This mode paints like using gel layers.  The RGB values
of the new and old paint are multiplied (independently in red,
green, and blue).  Thus, black over black gelled with anything is
black, and white gelled with anything is that color, but (for
instance) 50% gray gelled with anything is that color grayed down
by 50%.

The Select mode draws with selection, rather than paint.
Anything covered by the "paint" will be added to the selected area,
but not in any way modified.  Once an area selected, you can use
various modification tools and menu selections to affect the selected
area.

The Undo mode undraws, rather than draws.  Anything covered
by the new “paint” is undone with data from the Undo buffer (the
default setting), or from the original disk file (the alternate setting).
Any changes made by this mode are permanent.  The settings can
be changed by center-clicking the mode icon.

The Protect mode draws with protection, rather than paint.
Anything covered by the “paint” will be added to the protected area,
but not in any way modified.  Once an area protected, you can't
change anything in it, until you unprotect it using Unprotect from
the Effects menu.

The Encrust mode draws into the current document with image
from another document, rather than new paint.  You can use this
mode to airbrush in another image, or a host of other effects.  Before
you can use this mode, however, you must set up a source document
for the current document using the Encrust menu in the Source
window dialog of the Options menu.

Blend edit

When you center-click the Blend mode icon, the Blend Edit dialog
appears, allowing you to set the blend percentage.  A blend
percentage of 100 means that new paint is opaque, and a blend
percentage of 0 means that new paint will not appear.  The default
setting is 50%.
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When you center-click the User-defined wash mode icon, the User
wash Edit dialog appears, allowing you to set up how this wash
works:

The boxes on the side and bottom are called “histograms,” and they
display your current color usage.  If the curve of your color use
extends up (in the lower box), or to the left (in the box at the right),
then more of your current paint color or pattern is used.  Use the
histograms to specify your opacity pattern.  You can draw in these
histograms directly, and every time you do, the large display box
will update to show the result.  If you hold down Shift as you draw
in the histogram boxes, the line you draw will be perfectly straight.

The large square shows you the pattern you are creating.  If you
click in this square, you will get an even wash based on this point.
The type of wash is a “2D spike” curve.

Clicking on the Center button is just like clicking in the exact
center of the large box.  It sets up a perfectly centered “spike” wash.

Clicking on the Clear button sets all values in the histogram
nearest the button to the 100% opaque values.  When one of the
histograms is completely at 100%, user-defined washes will be
much faster than otherwise.
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When you center-click the Spherical or Conical wash mode icon, the
Circular Edit dialog appears, allowing you to set up how this wash
works:

Using the box, you can edit these modes to specify the relative
location of the central point of the wash.  For instance, you may not
wish the wash to radiate out from a point that is dead-center (the
default setting), but from a point that starts in the upper left-hand
corner of the wash.  Click the mouse on a spot in the large box or
“bull's eye” from which you would like the opacity of the wash to
radiate.

The Center button presents you with an alternative.  Pressing this
button is equivalent to clicking in the exact center of the wash-
controlling box.

The Sphere checkbox allows you to switch between a conical fall-off
pattern (looks best), and a spherical fall-off pattern (more "real
worldly").
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When you center-click the Palette cycle mode icon, the Palette
cycle Edit dialog appears, allowing you to set up how this wash
works:

The set of colors currently selected for use in the Palette Cycle mode
is flashed, just to let you know what you are dealing with.

Let's say you want to fill newly painted items, cycling through the
palette, but that you only want to use the 5th through the 8th colors
in the palette.  Mouse down on the 5th color in the palette.  Still
holding down the mouse button, drag the mouse to the 8th color on
the palette, and release.  At this point, the dialog vanishes.  You can
cancel without selecting a color range with the Cancel button.

There are several interesting types of color cycles to try here.  For
each of these, you must first set up the palette, and then edit the
Palette Cycle mode.

• Set up a wide range of cells containing the rainbow.  This will
lead to objects being filled with some or all of the rainbow.

• Set up a narrow range of cells containing the rainbow.  This will
lead to objects being filled with many little rainbow bands.

• Set up eight to sixteen cells with similar metallic looks, but not
arranged in any order.  Use these to give objects a burnished
look.

• Set up a range of cells in an RGB spread between two
somewhat similar colors.  This will give you what appears to be
a region-following wash.
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When you center-click the Undo mode icon, you are presented with
an alert, allowing you to choose Undo mode, where the drawn area
will be replaced by older work from the Undo buffer, or the Revert
mode, where the drawn area will be replaced by older work from the
disk file.

Use HSV mode edit

When you center-click the Use HSV mode icon, you are presented
with an alert, allowing you to choose the partial color mode you
wish to use.  The buttons have the following meanings:

Hsv Draw hue only, and leave saturation and value unaffected.

hSv Draw saturation only, and leave hue and value unaffected.

hsV Draw value only, and leave hue and saturation unaffected.

HSv Draw hue and saturation, leaving value unaffected.

HsV Draw hue and value, leaving saturation unaffected.

hSV Draw saturation and value, leaving hue unaffected.

Hls Draw hue only, and leave luminance and saturation
unaffected.

hLs Draw luminance only, and leave hue and saturation
unaffected.

hlS Draw saturation only, and leave hue and luminance
unaffected.

HLs Draw hue and luminance , leaving saturation unaffected.

HlS Draw hue and saturation , leaving luminance unaffected.

hLS Draw luminance and saturation , leaving hue unaffected.
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You can use the free draw tool shown on the Status window by
clicking on it and releasing the mouse button very quickly.  If you
mouse down on this position and hold, the Free draw tool list
appears in the Status window.  To select and use a tool on the Free
draw tool list, click on the desired tool.

Each of these tools draws a line wherever you draw with the mouse
or a tablet.  The tools other than the pencil use the current color or
pattern, brush shape and size, and take tablet pressure into
account.  The pencil tool always draws a 1x1 line.

The tools shown dotted (the second and fourth) draw by stamping
pen images.  The distance between the pen images are controlled by
editing individual pens.

Selecting a "cross" tool constrains movement to one of the axes.

The last tool in this set is the line painting tool.    It uses a brush
three times as large as specified, without pressure sensitivity, and
in paint-over (maximum) mode.  Use it for painting over lines to get
color lines.

Arc tools

You can use the arc tool shown on the Status window by clicking on
it and releasing the mouse button very quickly.  If you mouse down
on this position and hold, the Arc tool list appears in the Status
window.  To select and use a tool on the Arc tool window, click on
the desired tool.  Tools can be edited by center-clicking them.

There are really three tool groups here:

The arc tool draws a quarter of an oval.  Mouse down and drag the
mouse to another position.  An arc will form stretching from the
starting to the ending mouse position.  If you use the center mouse
button or the second tool in this pair, the arc will be constrained to
a quarter of a circle.
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The 3-point arc tool allows you to modify the arc you paint.
Mouse down to begin defining a line.  At this point, the tool seems
just like the Line tool  If the center mouse button is used, the line is
constrained to the horizontal or vertical axis.  Release the mouse.
The cursor now appears in the shape of tweezers.  Move the
tweezers to an area of the arc and depress the mouse button.  Move
the mouse up and down.  The line then becomes an arc, and moves
in the direction in which you are moving the mouse.

The Spline tools in some ways behave as a set of tools, and in
some ways behave as a single tool with 5 modes.  Splines in The
Animation Stand differ from splines in other programs, so let's
start at the beginning.  A spline set is a set of spline curves which
are being edited.  While a spline set is being edited, its colors and
patterns, line sizes, and position are not firmly defined.  Each of the
points, lines, and curves can still be affected without affecting the
underlying document, since the spline set is still riding over the
document.  Each of the spline curves in the spline set (one or more)
contains a start point and an end point, shown in red.  These points
are called on points, since the curve must touch on that point.  A
spline curve may also have additional on points, through which the
curve is obliged to pass, and on which the curve may make an angle
turn.  Additionally, spline curves tend to have off points, shown in
blue.  The curve must approach an off point, but generally will not
touch it.  These points are also known as "gravity points".  Points
actually on the spline curve are shown in the current draw color or
pattern.  Also, lines from control point to control point are shown in
cyan.

The first tool, showing a line between two red points establishes a
new spline curve in the spline set.  Choose this tool and drag out a
line.  As soon as the line is created, you are switched to the third
spline tool, which establishes new off points.

The second tool, showing a line and an additional red point is used
to create new on points within a spline.  Mouse down on a line, and
drag to a new position.  The curve will pass through this new point.

The third tool, showing a line and an additional blue point is used
to create new off points within a spline.  Mouse down on a line, and
drag to a new position.  The curve will pass near this new point, but
will probably not touch it.  Also, a new set of cyan lines will form to
show the connections between this control point and its neighbors.

The last two tools are used to delete and move points, respectively.

When you choose a non-spline tool, the spline set is locked into
place, and becomes a part of the document.  The spline tools can be
selected using the letters Z, X, C, V, and B once a spline set is
started.  These letters correspond to the first through fifth spline
tools.
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All of the multi-click curve tools draw their curves as a large
number of small, straight lines.  You can edit the tools (using
center-click) to change the number of line segments in an arc
section.

Rectangle tools

You can use the rectangle tool shown on the Status window by
clicking on it and releasing the mouse button very quickly.  If you
mouse down on this position and hold, the Rectangle tool list
appear in the Status window.  To select and use a tool on the
Rectangle tool list, click on the desired tool.

Mouse down to establish a corner (or center for centered tools [those
showing a cross in their center]), and drag to establish another
corner.  Depending on the tool selected, you will get a rectangle or
square, outlined or filled.

Holding down Shift will fill the item, even if you are using an
outline tool.  The center mouse button will constrain the item to a
square.  Holding down ALT will center the item being drawn.

Text tool

The text tool allows you to add text to your document.  Once the
text tool is in use, clicking anywhere in the text edit area allows you
to edit your text edit.  Clicking outside the text edit area (above
and/or to the left) ends the current text edit and begins another.
The Edit, Font and Size menus can affect all or part of the text
being edited.

While the text tool is in use, ALT-Shift-V will insert the name of the
current window into the text edit.
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You can use the movement tool shown on the Status window by
clicking on it and releasing the mouse button very quickly.  If you
mouse down on this position and hold, the Movement tool list
appears in the Status window.  To select and use a tool on the
Movement tool window, click on the desired tool.

Use the Move tool whenever you wish to move a selected area or to
offset the entire document.  With it, you can drag the selected area
to a new location, where it will float until some action requires it to
drop back into the document  Newly uncovered areas are replaced
with the background color.  If the center mouse button is used, the
area is copied, rather than moved.

Use the Copy tool to copy, rather than move a selected area.

Resizing tools resize the marked area of the document, or the entire
document, if there is no selection active.  Whenever either resize
tools is active, the Status window shows the horizontal and vertical
magnifications in percent of original size, displayed in green.  Thus
a display of H: 100% V: 100% means that the area is unchanged,
while a display of H: 200% V: 100% would mean that the area has
doubled its size in the horizontal dimension only.  The center pixel
of any marked area does not move.  Grab any other pixel and drag it
to a new location, squashing or stretching the selected area.

The magnification tool works as above, except that the area is
magnified equally in its horizontal and vertical coordinates,
maintaining its aspect ratio.

Magnification tool

Use this tool to change the magnification of a document at a default
of four times the previous power, up to one pixel.  This tool can be
used to enlarge or reduce.

To enlarge around a particular pixel or location, click on that
location.  A new window is opened into the document, with the
clicked point in the center of the new window.  Two windows into
the same document are now open.  The magnification shows in the
Status window.
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You may now arrange the windows so that you have a normal and
400% view into the same area of the document.  If you draw into
one of the windows, you'll see the change occur in both windows,
because these windows are connected to the same document.  You
may magnify as many times as you wish.  No matter how many
times you magnify (and, therefore, no matter how many windows of
the same document are open), a change made in one window in a
document occurs in all of the other windows into the same
document.

All pens, tools, colors, and patterns work in the magnification
windows.

When done, close the magnification window.

You can edit the amount of magnification performed by the
magnification tool by center-clicking the tool icon.  An edit appears,
asking the power of future magnification, 12.5%, 25%, 50%, 200%,
400% (the default), or 800%.

If you center-click the document, the effect of the Magnify tool is
reversed, changing magnification to reduction, and vice versa.

Color tools

You can use the color tool shown on the Status window by clicking
on it and releasing the mouse button very quickly.  If you mouse
down on this position and hold, the Color tool list appears in the
Status window.  To select and use a tool on the Color tool list, click
on the desired tool

The Syringe tool:  Selects foreground and background colors, as
well as selects source ranges for the RGB and HSV block change
functions.

The RGB & HSV spread tools:  Create a palette spread

The Color wheel tool:  Pick a color

The Color store tool:  Save a color or pattern

The Brush loader:  Load a brush from a document

The Art Director tool:  Annotate a style sheet
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The Pick Color tool:  Pick a palette color by name

Syringe

You may have a complex painting and wish to find out what color is
used on a particular part.  You can use the Syringe tool to find out
the exact color contained in a pixel, and at the same time select it as
your current color.  Note that this tool also has an effect on the
Change RGB block and Change HSV block selections of the
Effects menu.

Step 1 Click on the Syringe tool.

Step 2 Move the mouse into the document area.  Notice that
the cursor becomes a syringe.

Step 3 Locate the syringe on the area whose color you wish to
determine and click the mouse.  Alternatively, you may
hold the mouse button down, and the Status window
will update each time the cursor passes over a new color.

32 bits:  Notice that the Status window then tells you which color
is selected, as R (red), G (green), and B (Blue) component values,
each between 0 (OFF) and 255 (100%).  You may now paint with
this color.  If the color is opaque, the color numbers are shown in
black.  If the color is fully transparent, the color numbers are shown
in red.  For partially transparent colors, the displayed numbers will
be somewhat red.

64 bits:  Notice that the Status window then tells you which color
is selected, as R (red), G (green), and B (Blue) component values,
each between 0 (OFF) and 65535 (100%).  You may now paint with
this color.  If the color is opaque, the color numbers are shown in
black.  If the color is fully transparent, the color numbers are shown
in red.  For partially transparent colors, the displayed numbers will
be somewhat red.

The Syringe tool is a “one-shot” tool.  That is, The Animation
Stand reverts back to the tool you were working with before you
clicked on the Syringe tool as soon as the tool is used.  Thus, you
can be painting with the Free draw tool, for instance, use the
Syringe tool to pick up a color, and then immediately continue using
the Free draw tool without reselecting it.

Center-clicking will load the color as the background color.
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Once you have loaded a color as you current color with this tool, you
may then use the Palette Store tool to store the color into your
palette.  This step is not required to draw with the color; it is only
used to save it.  Once the color is in your palette, you may ALT-click
it into your user-tool palette.

RGB and HSV spread

The RGB and HSV spread tools appear as a RGB and HSV spreads
from green to red.  They are immediate action tools which create an
RGB or HSV spread between any two palette cells.  When you click
on a spread tool.  The following dialog box displays:

If you drag a set of colors on the palette, all colors in the set
between the first dragged color cell and the last dragged color cell
will be “spread” from one color to the other, much like smearing
paint across a palette.

If you choose this tool in error, you can abort the process by clicking
Cancel when the dialog appears

Color picker

The Color Wheel tool allows you to select a color, whether or not the
color is on the palette.
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The Color/Pattern Store tool allows you to store colors into the Color
Palette, and to store patterns into the Pattern List.

Storing a Color into the Color Palette
Step 1 Click on the Color/Pattern Store tool.  The Palette

window displays, whether or not it had previously been
displayed.

Step 2 Click on a Color cell.  That cell will be replaced by your
current paint color.  If your current color is a pattern,
then the last actual color you had selected is stored into
the palette cell clicked.

Storing a Pattern into the Pattern List
Step 1 Click on the Color/Pattern Store tool.  The Palette

window displays, whether or not it had been previously
displayed.

Step 2 Click on a Pattern cell.  That cell will be replaced by the
pattern currently being edited.  If no pattern is being
edited, then that Pattern cell will be replaced by another
copy of the last pattern to be edited.  If no pattern has
been edited, then the clicked pattern cell becomes an all-
white pattern.  When the pattern is stored into the
Pattern List, the pattern edit in progress is considered
ended, and the pattern edit portion of the Palette
window is again hidden.

Brush loader tool

This tool, in the image of a brush, is used to load a special brush
into the Special brush cell of the Pen window, and at the same
time, select an item as a brush.

Step 1 Open a window containing your brush or brushes,
normally the document Special pens.  Alternatively, you
could create a new document and draw a brush.

Step 2 Select the Brush loader tool.

Step 3 Click on the image of a brush.

Step 4 Go back to your old document.

Step 5 Draw with your special brush.



Art Director tool
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This tool is used to annotate a style sheet with the color names
used.

Step 1 Paint a style sheet.

Step 2 Name all your colors, using the expanded form of the
palette window.

Step 3 Click on the art director tool.

Step 4 Go back to your old document.

Step 5 Drag a line from a colored area to a blank space.  A line
is drawn, and the name of the color is placed at the end
of the line.  Your current pen size and font specifications
all have effect.

Pick Color tool

This tool is used to pick a color by name.

Step 1 Click on the Pick Color tool.  A dialog appears asking
the name of the color.

Step 2 Enter the name of the color you want, as it appears on
the palette in the expanded, named form, and click OK.
Case is irrelevant.  This will be your new current color.

2D distortion tools

You can use the 2D distortion tool shown on the Status window by
clicking on it and releasing the mouse button very quickly.  If you
mouse down on this position and hold, the 2D Distortion tool list
appears in the Status window.  To select and use a tool on the 2D
distortion tool list, click on the desired tool.  Tools can be edited by
center-clicking on them, whether they appear on the 2D distortion
tool window, or on the Status window.
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The Rotation tools will rotate the selected area (or the entire
document, if there is no selected area).  The area will rotate around
its central pixel.  When you mouse down over the selected area, a
“clock face” display appears, showing the selected amount of
rotation.  Drag the mouse around the clock face to establish a
rotation angle.  The current amount of rotation appears in the
Status window.  Release the mouse to rotate the object.  Using the
tool showing the degree symbol, the rotation is always an integer
number of degrees.  The center mouse button will constrain
movement to 15° increments.

The flip tools will immediately flip the selected area (or document)
in the indicated direction.

The Bend tools will bend the selected area (or document).  Mouse
down on or near the selected area.  An outline will form showing
how the area will be bent.  Drag the mouse around to create the
desired bend, then release the mouse button.

The Twist tool allows you to twist a selected area about a vertical
line, twisting the object as little or as much as you like.  Mouse
down on or near the left or right edge of the selected area.  As you
drag the mouse, you will see a criss-cross pattern.  This shows how
the object will be twisted.  As you drag the mouse towards the top of
the selected area, the twisting effect becomes more and more
pronounced.  As you move to the bottom of the selected area, the
twisting will reach exactly 180°.  Extending the mouse below the
bottom of the selected area will result in a twist of less than 180°.
When you release the mouse button, the actual twist will take place.

The Tilt tools allow you to tilt a selected area (or document).
Mouse down in the selected area, and drag the mouse up and down
(or left and right).  As you do, an outline will show the prospective
tilt, and the status window will show the angle.  When you release
the mouse button, the tilt will occur.
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You can use the polygon tool shown on the Status window by
clicking on it and releasing the mouse button very quickly.  If you
mouse down on this position and hold, the Polygon tool list
appears in the Status window.  To select and use a tool on the
Polygon tool list, click on the desired tool.  Tools can be edited by
center-clicking on them.

The polygon tools paint either a closed or an open polygon.  Click
the mouse button to begin drawing the polygon.  As you move the
mouse, a line drags with it.  Each time you click again, you
establish another point in the polygon.  To end the polygon, double-
click a point, or click once on the point that started the polygon.

The blob tools are much like the free draw tools, except that when
you mouse-up, the area is closed and/or filled:  Mouse down, drag
out an outline, and release the mouse.

The Regular Polygon tools draw outlined or filled equilateral
polygons, hexagons, by default.  Mouse down on the point which is
to be the center of the polygon.  As you drag the mouse, a polygon
will form, with the center of the polygon staying where you first
moused-down, and one of the vertices always under the cursor.  To
edit the tools to draw polygons other than hexagons, center-click on
the tool's icon.  You may then enter the number of sides.

Registration tool

This tool allows you to set the registration point of a painting.  Click
in the document at the new registration point location.  The
registration point is used to control where items are placed using
the Top and Left fields in the Exposure sheet.  It is also the
center of magnification for the Mag and V.Mag fields, and the
center of rotation for the °R field.

Once the registration tool is used, all documents display their
registration points.  You can stop the registration point display by
center-clicking this tool.
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The scroll tool is used to scroll the document.  One means of moving
the contents of a window about is to adjust the scroll bars.  A second
means is to use the Scroll tool.  You may click and drag a pixel in
the window to another location, scrolling the window.  This does not
alter the contents of a document, only how the document is
displayed.

Line tool

The Line tool allows you to paint a straight line that can be
stretched and moved.  The center mouse button constrains the line
to the horizontal or vertical axis.

Oval tools

You can use the oval tool shown on the Status window by clicking
on it and releasing the mouse button very quickly.  If you mouse
down on this position and hold, the Oval tool list appears in the
Status window.  To select and use a tool on the Oval tool list, click
on the desired tool.

Mouse down to establish a corner of an invisible rectangle defining
an oval (or center for centered tools [those showing a cross in their
center]), and drag to establish another corner.  Depending on the
tool selected, you will get an oval or circle, outlined or filled.

Holding down Shift will fill the item, even if you are using an
outline tool.  Using the center mouse button will constrain the item
to a circle.  Holding down ALT will center the item being drawn.
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You can use the rounded rectangle tool shown on the Status
window by clicking on it and releasing the mouse button very
quickly.  If you mouse down on this position and hold, the
Rounded rectangle tool list appears in the Status window.  To
select and use a tool on the Rounded rectangle tool list, click on
the desired tool.  Tools can be edited by center-clicking on them.

Mouse down to establish a corner (or center for centered tools [those
showing a cross in their center]), and drag to establish another
corner.  Depending on the tool selected, you will get a rectangle or
square, outlined or filled.

Holding down Shift will fill the item, even if you are using an
outline tool.  Using the center mouse button will constrain the item
to a circle.  Holding down ALT will center the item being drawn.

Editing these tools allows you to define the curvature of the corners.
You can enter the curvature in pixels, or as English or metric units.

Selection tools

You can use the selection tool shown on the Status window by
clicking on it and releasing the mouse button very quickly.  If you
mouse down on this position and hold, the Selection tool list
appears in the Status window.  To select and use a tool on the
Selection tool list, click on the desired tool.  Tools can be edited by
center-clicking on them.

Each of these tools is used to select some or all of the document.
The standard marquee tool selects a rectangular area.  The lasso
tool allows you to draw out a selected area.  The Select Entire
Document tool (a document in a select box) immediately selects the
entire document.  The polygonal selection tool works like the
polygon tool, but selects, rather than fills an area.  If you select an
area without using Shift, that area is selected, and any previous
selection area is discarded (just the selection area, not the contents).
If you us Shift, the new selection is added to the old selection area.
If you use minus, the new selection is subtracted from the old
selection area.  Normally, each of these tools selects as explained
above.  However, you can edit each of these tools to modify the
selection process.  If you center-click on one of these tools, you are
presented with an alert:
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Select as drawn:  This button affects the tools so that they
immediately select exactly what you ask for.

Ignore background:  This button causes The Animation Stand
to ignore the current background color when selecting the area.
Every color which is the same as the background color is excluded
from the selection.

Use draw color only:  This button causes The Animation Stand
to ignore everything but the current draw color (or last draw color,
if the current draw “color” is a pattern) when making the selection.

Use background color only:  This button causes The Animation
Stand to use only pixels of the current background color in making
the selection.

Ignore draw color:  This button causes The Animation Stand to
ignore every pixel of the current paint color (or last paint color, if
the current paint “color” is a pattern) in making its selection.

Shrink to object:  This button uses another type of background
transparency in making its selections.  When this mode is selected,
the Marquee, Lasso, and Polygonal Select tools first let you draw
out the shape to be selected.  When you release the mouse button,
The Animation Stand looks at the pixel on which you moused
down.  That pixel, and all adjoining pixels of the same color are
excluded from the selected area.  Thus, the effect is that the
selected area will “clamp down” or “shrink onto” objects within the
drawn selected area.  When this button is used in conjunction with
the Select Entire Document tool, area, the pixel at the upper left-
hand corner of the document is excluded from the selection area, as
are all adjoining pixels of the same color.
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The Expand tool immediately causes the selected area to expand
by one pixel.  You can edit this tool to expand by some other number
of pixels, or set it to contract by some number of pixels by entering a
negative number.

The Shrink select tool is the same as the standard selection
marquee, except that it always uses the Shrink to object method,
but without an expansion area.

Paintbucket tools

You can use the Paintbucket tool shown on the Status window by
clicking on it and releasing the mouse button very quickly.  If you
mouse down on this position and hold, the Paintbucket tool list
appears in the Status window.  To select and use a tool on the
Paintbucket tool list, click on the desired tool

The first bucket is called Paint Bucket.  It takes the current color
or pattern and floods from the point the mouse touches down to all
contiguous points of the same color, much like pouring paint into an
area.  This tool is affected by the Color slop setting of the
Preference dialog of the Options menu.  This tool, like the other
paint bucket tools, may be edited.  Center-click on this tool to bring
up the edit:

Expand by controls how the paint will flow.  When Expand by is
set to 0, paint flows where it normally would.  If Expand by is set to
1, paint will flow 1 pixel past where it otherwise would, and so on
for higher numbers.  You may also use units, such as mm.  This
setting is most useful for painting scanned documents, where
grayscale line quality is used.  To effectively paint under a line, and
take its quality into account, set your mode to Minimum (fastest) or
Gel (most accurate), and Expand by to 1 (or in some cases 2).  The
paint will flow past the line, but go “under” it, since the line will be
protected by the Minimum mode.
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The second paint bucket is the Bounded Fill tool.  Rather than
filling the contiguous area of the same color, the Bounded Fill tool
uses the paint color or pattern to fill up to, but not including, the
boundary color.  Select a boundary color by clicking in a palette or
pattern cell.  Then, select a fill color or pattern by clicking in
another color or pattern cell.  Next, click in the document area.  The
cursor is, at this point, a paint bucket, with a painted-in boundary.
The Status window displays a circle of the current color or pattern
surrounded by corners of the boundary color:

The last color or pattern selected is the paint color.  The one before
that is the boundary.  Thus, the paint color and boundary color may
be chosen before, after, or before and after choosing the Bounded
Fill tool.  You can't use a pattern as a boundary, since no pixel
contains a pattern—all pixels are pure color.  As with the
Paintbucket tool, this tool is affected by the Color slop setting.

The third paint bucket is the Fill Selected Area tool.  This is an
immediate action tool; that is, it immediately fills the selected area.
If there is no selected area, it fills the entire document.

The fourth bucket is called the Fill with Protection tool.  It pours
an “enamel” over the area you are painting, in the same manner as
the Paint Bucket tool, to prevent the area from further modification.
For instance, if you click with this tool in a blue area, that entire
blue area will have “enamel” painted over it.  No further
modification will be possible on that area until you remove the
“enamel” by using Unprotect from the Effects menu.  The
protected area displays with a flashing border.  This let you know
that the enamel is there.  You may protect as many areas as you
like.  However, when you unprotect the areas, all the areas are
unprotected together.  As above, the Color bits setting is germane.

The next bucket is called the Fill with Selection tool.  It adds the
area of color to the selection area, in the same way as the Fill with
Protection tool adds an area to the protected zone.

The last bucket is called the Paint behind bucket.  It is
equivalent to the standard bucket, except that it always paints in
the Paint behind (minimum) mode, and always expands one pixel,
unless more pixels are selected.

The next four paintbuckets are used for auto-painting.  Auto-
painting allows you to paint a series of outlined or scanned cells,
and save them, as one smooth-flowing, continuous operation.  Since
this is best described as a whole, we will show the various tools
involved, give their names, and then describe auto-painting as a set
of operations, rather than describe the uses of individual tools.
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The Delete Bucket tool.

The Move Bucket tool.

The Edit Bucket tool.

The Auto-Paint tool.

Normally, you will use Auto-painter to paint a large number of cells
all at once.  The more you do at one time, the more efficient things
will be.  To draw your cels, draw a large number of cels on
registered paper, and then scan the cels in.  Take note of your
scanner setting.  When drawing or scanning, assign sequential
names.  For instance, we might do Fawn01 (or Fawn1) through
Fawn72.

If this is your first time though this, or even the second, you may
want to use the shell to make a copy of the whole group of drawings,
since Auto-paint is going to rewrite all of the cels.

Do the following for each cycle of cels:

Step 1 Use ALT-O to open the first cel of the cycle.

Step 2 Use the regular old draw tool to close any gaps in the
lines.  You may also color lines.

Step 3 Paint the character as you normally would, but use  only
the Paintbucket tool.  You may use any combination of
colors, patterns, modes, and overfill settings.  Note that
if you Undo anything, you will have to explicitly delete
something later, but we'll get to that, too.

Step 4 Save this cel and go on to the next one using Next cel
(ALT-8).
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Step 5 Do the following for each subsequent cel in the cycle:

Step 5a The cel has already appeared.  Use the draw
tool to fill in any holes in the lines.  You may
also color lines.

Step 5b Now, let's take a look at where the automatic
buckets will fill.  Select the Move buckets tool.
The Edit buckets tool or the Delete buckets
tool will also do, but they're not as safe.  A
diamond shape will appear in each location you
previously painted.  On subsequent cels
(numbers 3 and on), these will be corrected for
area motion and distortions.  If, for any reason,
the paint indicators have a problem, you can
correct them:

If the bucket marker is in the wrong place, you
can drag it to a new location, using the Move
buckets tool.  Mouse down on the bucket
marker and drag it to a new location.

If the bucket marker is for an area which no
longer appears, use the Delete bucket tool to
delete it from the paint list, by clicking on a
bucket marker.  The bucket marker will vanish.

If a new area has appeared, don't worry about
it yet.

If you want to change the color, mode, pattern,
or over-fill setting of a marker in the list, set up
as you normally would; then click a marker
with the Edit bucket tool.

Step 5cClick on the Auto-paint tool (the pink
immediate action tool of the set).  There will be
a pause, and all pre-existing areas of the
document will have been painted.

Step 5d Use the normal Paintbucket tool to paint any
newly appearing areas.  These areas will be
added to the paint list for the next cel in the
cycle.

Step 5e Advance or finish with Next cel (ALT-8).

Step 6 Use Clear all from the Edit menu to clear the old auto-
paint list out of memory.  Be sure you have no
documents open at this point.

Step 7 Go back and start the next character cycle, or you're
done!
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Center-clicking on any bucket except Delete Bucket gives you the
option patch holes before painting:

Center-clicking on the Delete Bucket deletes the entire auto-paint
list.

You can switch between the tools used in batch painting by using A,
S, D, and F.

The last paint bucket is the "Alpha inversion" paintbucket.  It
translates shades of gray into alpha, and alpha into shades of gray,
antialiasing or reverse aliasing in the process.  The effect of this is
that if you scan a document in at 72 DPI gray scale, set your
paintbucket expansion to one pixel, and then click in the
background, you will get a black background, which is alpha-
transparent.  The fall-off on this alpha channel will result in a
perfect compositing look when the document is later brought into
the exposure sheet using the COMPOSITE Notes command.

Eraser tools

You can use the eraser tool shown on the Status window by
clicking on it and releasing the mouse button very quickly.  If you
mouse down on this position and hold, the Eraser tool list appears
in the Status window.  To select and use a tool on the Eraser tool
window, click on the desired tool.

The Eraser tool erases what it touches and replaces it with white.
The eraser tool paints white squares, 15x15 pixels.  If you move the
eraser too fast, some areas might not be erased.  This method of
erasing gives you slightly more control of fine movements, but cuts
down on the ability to paint broad lines quickly.  If you need to
paint great swaths of 15x15 pixel lines, use a 15x15 pen, the Free
Draw tool, and white paint.  If the center mouse button is used, this
tool is constrained to the horizontal or vertical axis.  If you center-
click the Eraser tool, the entire document will be erased.
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The Magic Eraser tool erases the last change you made to the
document (other than a change made by the Magic Eraser tool).
The Magic Eraser tool is a special form of Undo. As such, the effect
of the Magic Eraser tool can't itself be Undone.

Step 1 For example, paint two squares of different colors in
your document, the corners of which overlap slightly:

Step 2 Click on the Magic Eraser tool.  The cursor will appear
as an eraser with a starburst in the center, reminding
you which tool you are using.

Step 3 Point the mouse at the upper left-hand corner of the
uppermost square.

Step 4 Press down on the mouse button and slide the mouse
diagonally through the squares.

Step 5 Release the mouse.

The first-painted square will not be affected.  The second-painted
square will be erased, showing both white and the first-painted
square behind it:

This erasing is actually accomplished by doing an Undo, like the
Undo from the Edit menu, but the undone area, rather than being
the entire document, is only the area swept out by the Magic eraser
tool.

If the center mouse button is used, this tool is constrained to the
horizontal or vertical axis.

Center-clicking the Magic Eraser tool is equivalent to selecting
Undo from the Edit menu.
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You can use the 3D tool shown on the Status window by clicking on
it and releasing the mouse button very quickly.  If you mouse down
on this position and hold, the 3D tool window appears.

To select and use a tool on the 3D tool window, click on the desired
tool.  Tools can be edited by center-clicking on them, whether they
appear on the 3D tool window, or on the Status window.

User-defined sphere

This tool allows you to “wrap” a selected area of the document onto
a created sphere, which you manually define.

Think of “wrapping” a sphere like taking a basketball and shrink-
wrapping it with a piece of cellophane.

Let's create a background with which to wrap a sphere.

Step 1 Start with a fresh document.

Step 2 Select a pattern from the Palette window.

Step 3 Select the Marquee tool from the Tool window.

Step 4 Select a small square in the center of your document,
taking up a few square inches at  the center ninth of the
screen.

Step 5 Select the Fill Selected Area immediate action tool to fill
this selected area with the selected pattern.

Step 6 Select the Wrap onto User-defined Sphere tool.

Step 7 Move the cursor, which now appears as a pointing
finger, to the center of your selected and filled area.

Step 8 Mouse down in the center of the area and drag out a
circle which covers only about half of the selected area.

Step 9 Now let the mouse go.  The Animation Stand will
wrap the pattern into the shape of the sphere you drew.
The result will be displayed when done.  Also, the Status
window shows a count-down in red.  This is the number
of scan lines left in the computation.

At this point, the result should look something like this:
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Note that the result of the wrap is still selected.

Step 10 Now, let’s undo the effect of the wrap.  Press ALT-Z to
reverse the effect of the wrap.

Step 11 Select the Wrap onto User-defined Sphere tool again.

Step 12 This time, mouse down in a corner of the document, and
drag the circle out as large as it will get before releasing
the mouse.  The Animation Stand will now attempt to
wrap this small bit of pattern onto a rather large sphere.
The result will be that there is not much  distortion.
The selected area maps itself as best it can to where the
marked portion would have been had it been a part of an
infinitely large select area, something like this:

This effect can be used to generate reflections on soap bubbles and
the like.

Step 13 Select the Magnify tool.

Step 14 Click on a portion of the wrapped area.  There are two
interesting things to note when the new magnified
window opens up.  First, note that the flashing effect of
the select area carries with the document.  Each window
into the document has the same selected area.  Also,
note that in some places, the lines of the pattern appear
to have been smudged, or brought partially out of focus.
This is because of antialiasing.  Antialiasing is a process
whereby the image is painted in such a way as to avoid
sharp edges.
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The Animation Stand performs such painting by calculating
where the light for each pixel came from, and then painting that
pixel.  Thus, objects are actually painted as multifaceted objects,
one facet per pixel.  While the computation is taking place, the
number of lines left to compute will be displayed in the Status
window in red.

Other user-defined

Like the sphere wrapping tool, there are tools to wrap an area of
the document onto cylinders, cones, and oblate spheroids.  Except
for the shapes that they draw (obvious from the icons), the
operation of these tools are identical to the operation of the User-
defined Sphere Wrap tool.

Fold onto cube

These tools fold a selected area onto the sides of a cube, the sides of
which are one-half of the maximum of the original area's height and
width, for the tool without the orange cross in it (which may leave
white space), or one-half of the minimum of the original area's
height and width, for the tool with the orange cross in it (which may
exclude more of the original image).

Step 1 Select an area with the Marquee.  If you wish to
duplicate the entire document onto the cube (meaning
that some of the document will be lost off the edges), do
not form a selected area.

Step 2 Select this tool.   Notice that the cursor now appears as
a finger.

Step 3 Mouse down in the document.  A square will appear in
the document, and a pair of angles (in blue) at the
bottom of the Status window.  As you move the mouse
down and/or to the right (without letting go of the mouse
button), the square will appear to actually be a cube,
which rotates under mouse control.  The angular
measurements in the Status window give you
reproducibility, where “R” stands for the degrees the
cube has rotated to the right, and “D” stands for the
degrees the cube has rotated downwards.
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NOTE:  Since the rotation of the cube is limited to 0 to 90°, you will
only see one, two, or three sides of the cube.  You will never see a
fourth side.

Step 4 Drag the cube into a desired position.

Step 5 Release the mouse.

The selected area will fold itself around the cube.  The number of
lines left to compute will be displayed in the Status window in red.

NOTE:  Because some of the painting is a folding operation, part of
the painting will be lost.

NOTE:  If the selected area is not square, holes will be left in the
final cube.

Copy onto cube

The Copy onto Cube tools are equivalent to the Fold onto Cube
tools, except for two differences.  First, the formed cubes are as
large as the selected area, rather than half as large, and second, the
selected area is stamped onto each face of the new cube, rather than
folded onto the cube.

Extrude—Relight

This tool is used to

• change a 2D picture into a lighted 3D item.  It applies the
lighting, as set to the selected area, and

• apply an additional light to generally round objects.

Step 1 Set up your lighting.  There are two ways of doing this.
One way, and by far the simplest at this point is to edit
the lighting by center-clicking on the User-Defined
Sphere tool, clicking on the 50/50 button, and then by
clicking OK..  Alternatively, read ahead to the Lighting
Edit description in the Editing Tools section later in this
chapter, and then come back to this point.

Step 2 Select an area with the Marquee or Lasso tool.
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Step 3 Select the Relight tool.  This is an immediate action tool,
so the effect will begin right away.  The lighting set up
in step 1 will be applied to the area.  Everything inside
the selected area will be considered part of the object,
and everything outside of the area is outside of the
object.  The shape of the select area is analyzed to
determine what the object must look like in 3D.  The
model used for this process works best for living things.
Thus, applied lighting on people and fruit will work
well.  Applied lighting on cars and toasters will not.  The
number of lines left to compute are displayed in red in
the Status window.

Best-fit tools

For each of the user defined 3D tools (sphere, cylinder, cone, and
oblate spheroid), there is an equivalent Best-fit tool.  The best fit
version of each of these tools will immediately (without further user
interaction) wrap the selected area (or document) onto the largest
sphere (or cylinder, cone, or oblate spheroid) onto which it will fit.
Generally, this means that for something N pixels across, the new
object will be about 35% smaller.
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When you center-click on one of the 3D tools, the following dialog
appears:
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The “map”:  This drawing is a Mercator map of the object’s view of
a light source.  The white rectangle denotes the edges of the object’s
field of view, and the black circle represents the direction from
which the light is originating.  You can use the mouse to drag this
lighting source to various positions.  As you drag the lighting source
around, the current right ascension and declination (angular
measurements used for view angles) are displayed in blue in the
Status window.  When the black circle is at the center of the
ellipse, lighting comes from directly in front of the object.  When the
black circle is at the left or right of the ellipse, lighting comes from
directly behind the object.  When the black circle is half-way in from
the left of the ellipse, lighting is from the object’s left.  When the
black circle is half-way in from the right of the ellipse, lighting is
from the right of the object.  When the black circle is at the top of
the ellipse, lighting is from above the object.  And when the black
circle is at the bottom of the ellipse, lighting is from below the
object.  The color of the ellipse, while white now, actually indicates
the color and brightness of the room lighting.  The color of the small
circle, while black now, actually indicates the color and brightness
of the spotlight, or lighting source.

The Room light button allows you to set the room light color
yourself by bringing up the Color Picker.

The Spotlight button allows you to set the spot light color yourself
by bringing up the Color Picker.

The Room light only button is a preset, which sets the room light
color to white and sets the spot light color to black.  When this
button is selected, and the lighting color is white, The Animation
Stand has a special case, which allows it much faster operation.

The 50/50 button sets the room light and spot light colors to 50%
gray.

The Spotlight only preset button sets the room light color to black
and the spot light color  to white.

Diffuse spot:  When this checkbox is checked, a normal diffuse
lighting component is used; that is, the object will show diffused
lighting from an infinite distance.  There is absolutely no reflection
or glint from the bulb seen from this lighting component.  This is
the type of lighting you see when you look at the moon.

Bulb/point spot:  When this checkbox is checked, a glint or glare is
applied; that is, there is glare from the direction of the light source,
in the color of the light.  The amount of glare also depends on the
flat/glossy setting (explained below).  The glossier an object is, the
more glare the object reflects.
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Flat/glossy slider:  This item controls glossiness of the object.
Fully flat means that the object reflects light back only to the extent
that the illuminating red lighting matches the object’s red values,
that the illuminating green matches object green, and blue for blue.
Fully glossy means that the object reflects all light, without regard
to the object’s own color.  Real world objects tend to be in the 25% to
75% glossy range.

Bulb/point slider:  This item controls the size of the reflected light
source, if the light source is to reflect back at all.  When the light
source setting is at the left, a rather large and indistinct bulb
reflection is used.  When the slider is at the right, a sharp point
glare reflection is used.  You have a wide range of reflections to
work with here, and as usual, 25% to 75% settings will probably
seem most real-world.

Pixelization tools

You can use the pixelization tool shown on the Status window by
clicking on it and releasing the mouse button very quickly.  If you
mouse down on this position and hold, the Pixelization tool list
appears in the Status window.  To select and use a tool on the
Pixelization tool list, click on the desired tool.  Tools can be edited
by center-clicking them.

The Blur tool immediately blurs the selected area, by averaging
nearby pixel values.  This tool can be edited to take a varying
number of pixels into account.

The Smudge tool works like a finger on charcoal, and allows you to
blur an area using the current pen nib as the size and shape of the
smudging tool.  The best pen size seems to be from 5 to 11 pixels
across.  You’ll have to experiment to see which pen nib suits your
taste for this tool.  Every place you paint is smudged in the direction
of motion.  If the center mouse button is used, this tool is
constrained to the horizontal or vertical axis.  This tool can be
edited to take a varying number of previous pixels into account.

The Pixelize tool takes an area and reformats the color in the area
to make it look like the area contains giant pixels of various colors.
The number of pixels in a “giant pixel” is controlled by editing this
tool.

The Blur, Smudge, and Pixelize tools can be edited as follows:
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Step 1 Center-click on the Blur tool.  The following dialog
appears:

The normal setting here is 2 pixels per square; that is, a
distance of pixels is considered in computing the effect of
each of the tools.  For example, setting this number to 3
would mean that a distance of 3 pixels would be
considered in computing the effect of the Blur, Smudge,
and Pixelization tools on the selected area.

Step 2 Enter the new value.

The Blur tool uses this number as follows:  At a setting of 1, only
one pixel is considered, and no real blurring takes place.  At a
setting of 2, another ring of pixels is considered.  That is, the
central pixel is considered, along with a second band.  At a setting
of 3, a third band is considered.  All of the pixel values in the
considered range are averaged to produce the resultant pixel.  Thus,
the higher this number, the more blurring occurs.

NOTE:  As you double this setting, the Blur tool will take four times
as long to function.

The Smudge tool uses this number as follows:  At a setting of 1,
only one pixel is considered, and no real smudging takes place.  At a
setting of 2, another set of pixels is considered.  At a setting of 3, a
third set is considered.  All of the pixel values in the considered
direction of motion are averaged to produce the resultant pixel.
Thus, the higher this number, the more smudging occurs.

NOTE:  As you double this setting, the Smudge tool will take twice
as long to function.

The Pixelize tool uses this number as follows:  At a setting of 1,
squares one pixel across are painted, and no real pixelization takes
place.  At a setting of 2, squares two pixels across are painted.  At a
setting of 3, squares three pixels across are painted.  All of the pixel
values in the square are averaged to produce the resultant painting.
Thus, the higher this number, the more pixelization occurs.

NOTE:  As you double this setting, the Pixelize tool will take 1.4
times as long to function.
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Step 3 To complete this edit and allow the Blur or Pixelize
Selected Area tool to operate (if selected), click OK.  To
complete this edit, but to prevent the Blur or Pixelize
tool from operating, press center-click OK .  To abort
this edit but allow the Blur or Pixelize Selected Area
tool to operate with the old values, click Cancel.  To
abort this edit and prevent the Blur or Pixelize Selected
Area tool from operating, center-click Cancel.

Water-drop smudge acts like dripping or injecting water from a
moving dropper or syringe onto your document., giving an effect like
real water.  You can edit this tool, too.  Select Wet, Medium, or
Dry.

These two tools, Decrease saturation and Increase saturation,
each increase or decrease the saturations of the colors in the
selected area.  If there is no selected area, they affect the entire
document.

This tool, Invert luminosity, acts on the selected range, or on the
entire document if there is no selected range.  Each pixel affected
has its value inverted.  Thus, light colors change to dark colors, and
dark colors change to light colors.  This is not like making a
negative, since the hue and saturation remain unchanged by this
process.  This technique is extremely useful in changing lightened
highlights to darkened highlights, or vice versa.

PF tools

You can use the PF (programmable function) tools, which appear on
the keyboard as F1 through F6.

PF tools are tools which you can write in The Animation Stand's
PF language, or get from someone else.  Just what happens when
you press a PF key or draw with it may vary, since PF tools can be
completely redefined.

The PF tool language is described in a separate section.  Note that
no programming is required to use The Animation Stand, unless
you want to establish your own extensions to the program.
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The Airbrush tool spray paints using a realistic airbrush effect, or
using a pixel-spray, using the current color or pattern and pen
shape and size.

If you leave the mouse in one place, a lot of paint will build up.  If
you move the mouse slowly, you will paint with a very dark and
thick airbrush line.  If you move the mouse quickly, you will paint
with a light and thin airbrush line.  If you move the mouse too
quickly, you will paint a series of dots.

If the center mouse button is used, this tool is constrained to the
horizontal or vertical axis.

For other airbrush effects, use Airbrush Edit, obtained by center-
clicking this tool's icon.

The Airbrush tool can operate in two basic modes.  In its pixel
mode, it sprays pixels randomly into the area allowed by its nozzle
(pen) shape and size.  In its modeled mode, it paints using a
mathematical model of how paint is to flow, in atomized form, from
an Airbrush nozzle.  The dialog window for this edit is shown below:

The large box shows you the actual size, shape, and pattern of the
spray-can in use (unless you have random pixels).
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The smaller box allows you to define, by hand, what sort of fall-off
pattern is to be used.  The bottom of this box represents no paint
flow.  The top of the box represents the fastest possible paint flow.
The left side of the box represents the paint flow under the
Airbrush’s nozzle.  And the right side of the box represents the
paint flow 127 pixels away from the Airbrush’s nozzle.  Each time
you draw in this box and release the mouse, the large box will
update to show you the current fall-off pattern from the Airbrush.
Note that wide patterns take a long time to draw into the
document.  If you hold down Shift while drawing, the mouse’s path
will define a straight line in this control box, rather than a curve.
To try that, start drawing in this box, then hold down Shift, then
draw some more, then release Shift, draw some more, and then
release the mouse button.  Drawing in this control box turns off the
Random pixels setting.

When Random pixels is on, the Airbrush paints by placing
randomly placed pixels within the confines of the Airbrush nozzle,
as defined by the current pen.  Since this type of painting is a
“normal” painting operation, the current mode setting is in effect.
When this control is off, the fall-off pattern, as shown in the
Airbrush dialog window has effect, superseding any modes in effect.
This box is turned off by all other controls in the dialog.

The Straight button loads a straight fall-off pattern into the fall-off
histogram.  Note that this fall-off is probably too wide for normal
use, and should be thinned before use.

The Sphere button loads a spherical fall-off pattern into the fall-off
histogram.  Note that this fall-off is likely too wide for  normal use,
and should be thinned before use.

The 1/r button loads a curve where the paint density is inversely
proportional to the distance from the nozzle into the fall-off
histogram.  This fall-off is probably too wide for normal use, and
should be thinned before use.

The 1/r^2 (“One over R squared”) button loads a curve where the
paint density is inversely proportional to the square of the distance
from the nozzle into the fall-off histogram.

The Sine button loads a sinusoidal fall-off pattern into the fall-off
histogram.  This fall-off is probably too wide for normal use, and
should be thinned before use.

The Bell button loads a bell-curve into the fall-off histogram.  This
type of curve most closely approximates how real paint leaves an
Airbrush.  For many uses, the bell-curve drawn by this button is a
bit wide, so you might want to thin the curve before use.

The Flatter button flattens the fall-off histogram.  The effect of this
is that the paint will flow more slowly from the Airbrush.
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The Higher button amplifies the fall-off histogram.  The effect of
this is that the paint will flow more quickly from the Airbrush.

The Wider button widens the fall-off histogram.  The effect of this
is that the area painted by the Airbrush will be wider, without
affecting the flow rate at the center of the pattern.  Note that some
of the fall-off curve (the portion at the right) may be lost when this
button is clicked.

The Thinner button thins the fall-off histogram.  The effect of this
is that the area painted by the Airbrush will be thinner, without
affecting the flow rate at the center of the pattern.  This button will
be used several times, under normal use, just after pressing one of
the preset buttons.

All of the buttons turn off the Random pixels setting.

User toolbox

Mousing down here brings up an empty toolbox area on the status
window, called the user toolbox.  It is called this because its 32
empty slots are available for you to configure your own tools into.
To bring a tool, mode, pen, color, or pattern into the user toolbox,
just hold down ALT and click the item into the user toolbox.  You
can remove items from the user toolbox using ALT too—just ALT-
click the item.
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Opticals

An optical press is a device used for creating optical and special
effects, usually by projecting light through frames of one reel of
film, through the frames of a second reel of film (getting a filtering,
gel, or matting effect) onto a third, target, reel of film, exposing that
target reel.  This is called a stage of the optical press.  The target
reel may then pass into another stage, where more reels of film
expose onto it, creating double exposures, glows, and mattes.  The
Animation Stand contains a complete optical press emulator.

In the Exposure Sheet, the Notes field can be used for more than
notes to yourself.  If the first word (starting in the first character
position) of the Notes field is all in upper case, then that word is
actually a command to The Animation Stand.  Most of these
commands perform “optical printing” functions, or functions that
would normally be performed on an optical press.

In the examples that follow, the spreadsheet version of the exposure
sheet is shown.  This is so that you may see all of the data in use.
In the iconic form, optical Notes commands appear as their icon (if
no file is used in the layer), or as a red box around the layer’s
thumbnail picture.

Backgrounds

If ALPHA-BG is entered into the Notes field of the first layer of a
frame, then the entire background of the frame is set to alpha.  This
means that all otherwise undrawn areas will be alpha.  On some
cards, this means that there will be video transparency, and on
others, it just means that there will be an alpha output.  To use
alpha blanking in this manner, you must be using a true 32 bit
display card, and not just a 24 bit display card.  No file name is
used.

If BLACK-BG is entered into the Notes field of the first layer of a
frame, then the entire background of the frame is set to black.  No
file name is used.
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Each of the antialiasing functions helps in compositing one layer
(saved using the Save area function of the File menu) over the
frame so far.  These antialiasing techniques assume that some sort
of antialiasing has occurred to the edge of the image being
composited before this step.  Thus, they are all second-chance
functions, and are not as good as COMPOSITE or COMPOSITE*.
Remember:  The longer you put off edge-antialiasing, the better the
look you get.

DARKEST assumes that the outer edge of the layer being
composited is mostly dark, or that white is insignificant in the edge.

DARKEST BLEND is equivalent to using DARKEST and
BLEND at the same time.

LIGHTEST assumes that the outer edge of the layer being
composited is mostly light, or that black is insignificant in the edge.

FADED assumes nothing, and fades the edge in, Quantel style.

Boolean modes

When AND is placed into the Notes field of a layer, it changes how
the layer is drawn.  Normally, new information is just drawn over
the old.  When AND is used, the file for the current layer is
rendered as a picture, and then “anded in” to the existing picture.
Areas outside the layer's file are not affected.

Similarly, OR causes new data to be “orred in”.

XOR causes new data to be "exclusive orred" in.

Transparency modes

When BLACK is used, new files are read in over old ones, with the
exception that all pixels which are black (exactly black) will be
transparent.

Similarly, WHITE causes all white pixels to be read as transparent.

BLACK-ONLY causes all pixels except black to be considered
transparent.
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BLUE and GREEN emulate bluescreen and green-screen.  The
Sloppiness value controls color comparison.  Shadows cast onto the
blue or green screen will be shadowed onto the composite image.

Blending

The BLEND Notes command causes the new layer to be blended in
with the existing frame, just as if it were being pasted in with the
paint side's Blend mode.  Like the Blend mode, it uses the current
blend level, which is 50% by default.  You can use BLENDLEVEL
to set The Animation Stand's blend level setting to some other
percentage.  Just put BLENDLEVEL in the Notes field, and your
percentage in the magnification field (with nothing in the picture
field), usually on a layer just before the layer using the BLEND
Notes command.

The example above uses the file Foreground at 50% and 33% blend
levels, respectively.

Matting

Matting is a process whereby various portions of various pictures
are composited onto a single frame.  In simple matting, various
portions of one image are used, and portions not used from the first
picture are taken from a second picture.  The portions taken are
controlled by “mattes”.  These two portions are taken together to
form a final image.

In complex matting, various portions of various images are taken.
The portions taken are controlled by mattes.  The final image is a
composite of all of these.
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All of this is best shown by example:  Shown below is a frame from
an Exposure Sheet, the constituent layers, and the final result.

Exposure Sheet frame:

Horizontal stripes:

Vertical stripes:

Crosshatch:
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Left circle:

Right circle:

Final result of the combination of the three mattes:

MATTE may not be mixed with FADER within a single frame.

Matting, as described, involves all layers of the frame.  However,
you can tell The Animation Stand to compute the frame as
specified so far, and then composite more layers onto the frame
normally, by specifying COMPUTE in the Notes field.  To use this
feature, call out your matte as you normally would, then code
COMPUTE, and then composite additional frames onto your
frame.  This functionality is known as "nested opticals".
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When 3D programs, PhotoShop, and certain other programs
generate an image into a picture file, they often write an alpha
channel into the file.  The purpose of this alpha channel is to state,
on a pixel by pixel basis, whether each pixel is a part of the image,
and if so, to what degree.  Thus, using the alpha channel for this
purpose, The Animation Stand can perfectly and very rapidly
composite an image from one of these programs, complete with edge
antialiasing.  This antialiasing is completely separate and disjoint
from all other forms of antialiasing, subpixel resolution, or edge
processing.

Just place the word COMPOSITE in the notes field, and the layer
will be read using its alpha channel to control antialiasing.
COMPOSITE* is to be used with files from programs which use an
inverted alpha channel.  If COMPOSITE BLEND or
COMPOSITE* BLEND is used, the current blend level is also
taken into account.

Paint Effects

When paint effects are placed into the Notes field, the layer is not
used.  The frame, as it exists so far, is image-processed.

DECLUTTER examines the frame for black specs, which are
removed.

PATCH examines the frame for holes in lines, which are patched,
and white specs, which are removed.  This  occurs only during
playback.

LEGALIZE examines the frame, pixel-by-pixel for colors which are
not NTSC-legal.  Each such color is remapped to the nearest
available NTSC-legal color.
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This optical Notes command gives you direct control over fades,
and allows you to have action proceed while a fade occurs.  In a
FADER layer, the Mag. field is used to control the blend
percentages.  The image list specified above the FADER layer is
taken at a fade or blend level as specified in the FADER layer, and
the image list specified afterwards is taken at 100% less that
amount, much like a double exposure.

This is best shown by example.  In the following frame, #1 is taken
at 25% value, and #2 is to be taken at 75% value.  This is equivalent
to being 25% through a fade set, or a 1:3 double exposure.

FADER may not be mixed with MATTE or with another FADER
within a single frame.

Cross-fading, as described, involves all layers of the frame.
However, you can tell The Animation Stand to compute the frame
as specified so far, and then composite more layers onto the frame
normally, by specifying COMPUTE in the Notes field.  To use this
feature, call out your cross-fade as you normally would, then code
COMPUTE, and then composite additional frames onto your
frame.  This functionality is known as nested opticals.

Focusing effects

The focusing effects are used to emulate the rack focus effects
possible on a true multiplane animation stand.

The BLUR command blurs all of the frame composited so far.  It
appears in the Notes field on its own layer.  The Mag. column is
used to control the amount of blurring.  A value of 0 represents the
minimal amount of blurring.  Values of 1 through 3 are most useful.
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The RACK command blurs a foreground layer in over the frame as
composited so far.  Bring in the layer as normally specified, and
place RACK in the Notes column.  The alpha channel and saved
area both serve to limit the area of the cel file which is blurred and
composited when RACK is used.  The amount of blurring is set by
the current pixelization level, which can be set using the edit of the
pixelization tools, or using the PIXLEVEL Notes command.

The PIXLEVEL Notes command sets the current pixelization level
on the fly.  As it is encountered, the value of the Mag. column is
retained as the new pixelization level.

The following frame composites a background layer, some trees, and
a character.  Everything but the character is defocused:
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The FRAME and #  Notes commands are used to change the
coordinate system of the frame.  All of the remaining layers
following the FRAME command, up to and including the last layer
of the frame, are offset by the Top, Left, Mag, and V.Mag amounts
specified in the FRAME command.  Thus, if a FRAME command is
used in a Move, all of the layers following the Move will be moved.
This is useful for entering “camera moves” — moving the animation
camera while the cel art goes through its motions.

For example, the following two scenes are equivalent, since panning
is accomplished either through movement of the individual layers,
or through panning of the entire frame.

and
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The following two scenes are equivalent, since zooming (or trucking)
is accomplished either through movement of the individual layers,
or through zooming of the entire frame.

and

You can enter field positioning short-hand into the Notes field, too.
The basic format of this short-hand is:

#fields distance direction-distance direction (basis)

The fields and basis arguments tell the virtual camera how many
fields to show in the field of view.  For instance, if you enter

#8 0N-0W (16)

this means that you want to zoom in to 8 visible fields, out of a
possible 16.  This is the same as coding a FRAME command with a
magnification set at 200%.  And, so that all items can be handled in
numeric fields for interpolations, The Animation Stand will
convert # commands to FRAME commands.  If you omit the basis
argument, 12 is assumed.  Thus,

#9

is equivalent to

#9 0N-0W (12)

or a FRAME command at 75% magnification.
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You can move the camera up and down, or left and right using
distances, and N, S, E, and/or W.  For instance,

#6 2N-3E

zooms in on your frame 200%, and at the same time moves the
"camera" 2 fields North (up) and 3 fields East (right).

Gels

This command allows the use of “filters” or “gels”.  The best
example of this type of effect is a character's point of view while
putting on some sunglasses.

If a cel layer is used normally as a layer in a cell, then all “painted”
areas in the cell completely replace corresponding portions of the
frame’s contents.  When a layer is marked as a gel, by placing GEL
in the Notes field of the layer, then the layer is used as a gel or a
filter, rather than an overlay.

Thus, in the following frame, we have a scene, and some sunglasses:

Background contains:



196    The Animation Stand

Sunglasses contains:

The result of this gelling or filtering effect is:

By placing OVER-GEL in the Notes field, you will get the same
effect, except that only the immediately-preceding cel will be
affected.

Glow

With the GLOW Notes command, you can add a glow or light to a
frame.  For dull or slight glows, paint the glow as a dark color on a
black background.  For very bright glows, paint the glow as a bright
color on a black background.  Then, bring the file in as a layer, and
place the word GLOW in the notes field.

By placing OVER-GLOW in the Notes field, you will get the same
effect, except that only the immediately-preceding cel will be
affected.

The BACKLIGHT Notes command emulates a backlighting effect.
Place BACKLIGHT in the Notes field of the layer, and the layer
will be backlighted.  So that backlights can be used in the most
types of ways possible, the BACKLIGHT Note only places the
backlight fringe.  To get the fringe and the image, use
BACKLIGHT and a second layer without.  The extent of the glow
is controlled by the current pixelization level (PIXLEVEL
command and pixelization tool edit).  The saved area and alpha
channel both control the “cutout” size and shape.
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When you place the LOAD command into the Notes field, the
meaning of the layer completely changes.  The file called out in such
a layer is not used to build the picture.  Rather, it is used to load an
image into a holding area in memory, and all operations involving
that file will occur much more quickly, at the cost of available
memory.  When you use LOAD without a name, the holding area is
emptied.  This command can't generate an error message, it is an
advisory command, telling The Animation Stand to use memory
in a certain way, but only if it can.

This command can greatly speed output.  For instance, let's say
that you will use background BG from frames 100 to 199.  In frame
100, use LOAD to load BG into memory, speeding operations.  At
the end of frame 199, or the beginning of frame 200, use LOAD to
clear memory.

Maximum & Minimum

MINIMUM and MAXIMUM modes are Mac arithmetic modes.  In
this case, the file called out in the layer is composited over the
existing frame.  On a pixel by pixel basis, the new layer is
composited on the existing frame, taking the minimum or
maximum of the RGB values of the respective pixels.  There is no
direct correlation between this effect and any real-world effect.

Off

When OFF is placed into the Notes field, the layer is not used.
Using OFF, you can temporarily turn off a layer.  When you want
to use that layer again, remove the OFF command.

PF-keys

Any of the commands PF1 through PF6 will invoke a compiled PF-
key function, passing it the Top, Left, Mag, and V.Mag values.
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When this Notes command is used on a layer, the selection area
stored with the layer will not be used to antialias the layer.  The
picture component only will be used.  This is useful if the layer is
not to be modified by edge processing, or as a speed boost if you
know beforehand that edge processing will have no effect on a layer;
for instance, true antialiasing on a square object.

Shadow

This command does not apply a shadow to a layer; rather, it uses
the layer, as and where specified as a shadow.  It does this by (a)
considering only the outline of the layer, as defined by the Save
area command from the File menu, (b) calculating where this goes
using the Top, Left, Mag, and V.Mag fields, and (c) using the layer
as if it were a gray gel.  The density of the gel is controlled by the
BLENDLEVEL command.

Subtract mode

With this Notes command, you can add a shadow or stain to a
frame.  For dull or slight stains, paint the stain as a dark color on a
black background.  For very striking stains, paint the stain as a
bright color on a black background.  Then, bring the file in as a
layer, and place the word SUBTRACT in the notes field.

Game compositing

You may bring a layer in as a "game layer".  A game layer is a layer
which maintains a black outer boundary, and also maintains the
internal lines.  A game layer may not take on any new colors when
growing or shrinking.  To enforce these rules, code GAME in the
Notes field of the layer.  Game layers are controlled by their saved
area.  GAME is ignored for layers which were not saved with Save
area.  An alternate method, GAME2, simply insures a black
boundary on the characters, and processes much faster.
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Programming

Introduction
IT'S NOT REQUIRED THAT YOU LEARN THE PROGRAMMING
LANGUAGE TO USE THE ANIMATION STAND.  THE
INFORMATION IN THIS CHAPTER IS ONLY USEFUL IF YOU
ARE GOING TO ADD YOUR OWN TOOLS OR EFFECTS.

Note:  In all of the following examples, [ and ] denote optional
portions of a construct.  For instance “X [Y]” could mean “X” or “X
Y”.

This chapter shows you how to write your own paint tools for The
Animation Stand.  Once your tools are created, you can use them
yourself, as well as distribute these tools to others.

It is assumed that you know some computer language, and have
programmed before.  The language used here is very simple.

Normal Sequence
Step 1 Decide what the PF key is supposed to do & design your

application.

Step 2 Open a new text window.

Step 3 Code your new tool.

Step 4 Compile the code, assigning it to one of the PF keys.

Step 5 Save the PF key text.

Step 6 Optionally, save the compiled PF key code in with your
preferences file.

Running PF-Key Programs
Various types of actions occur in a program, and all of these actions
occur in response to some sort of stimulus.  Each time the tool is
invoked, a variable, REASON, is set.  It is set to 0 for press, 1 for
ALT-press, 2 for use, and 3 for use from the exposure sheet.

Your PF-key program may have a section which is invoked when
the tool is selected.  You would use this sort of code to implement an
immediate action tool, a tool that does something with an ALT-
press, or perhaps something we haven’t even imagined.

PF-key programs may also have a section that is executed when the
mouse is used within a document.  You would use this to implement
“normal” tools.
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Note that since you can have both a “tool pressed” code section, and
a “mouse clicked” code section, so that your PF-key tools can be at
once immediate action and “normal” tools.

Editing
Step 1 Open a new window as you would a window in any text

editor.  Use New text from the File menu to Open a
new window directly, or use ALT-O to Open an existing
text file.

Step 2 Use normal text editing.  All of the normal functions,
such as clicking, dragging, and using the sliders work
here as you might expect.  All of the items in the Edit
menu have their normal functions.

Step 3 All of the normal File menu functions having to do with
file dispositions can be used to save the file.

Note that the entries and changes you make have no effect until
you compile the program.

Compiling
Under the Options menu is the Compile command.  When you use
Compile,  your program will be compiled.  If there are any errors,
the first error will be shown to you, and compilation will stop.  In
this case, fix the error and compile again.  If all went well, the
following will appear:

Press one of the F keys, or click Cancel.

Saving the PF-Key Program Code
There are two items of data associated with PF key code:  The
textual PF key program text is stored in a text file.  The compiled
PF key program  is saved as a separate item, whenever you use PF
keys only or Save all from the Save or Save as dialog.
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Normally, you will save all of your preferences by having a set of PF
key files compiled, then with no other files Open, use Save all to
save all of your preferences, patterns, palette, and PF keys, but no
document.

Variables
As with any computer language, this language has variables.
Variables are storage locations for numbers.  Each variable has a
name.  These names are from one to 255 characters long.  The first
letter of a variable must be a letter, while the following characters
may be letters and/or numbers, but there must be no intervening
blanks or other characters in the name.  The capitalization of a
variable is irrelevant.

Each variable may contain an integer value., and occupies static,
uninitialized storage.

In addition, the variables SPOTRA and SPOTD contain the
current spotlight angles, in degrees.  If you change these values,
you are actually changing the spotlight angles, and TOP, LEFT,
MAG, and VMAG contain exposure sheet fields, when a PF-key
program is called from the exposure sheet.

There is one additional restriction on the names of variables.
Variables may not share the names of statements or of functions.
Thus, you cannot name a function LINE, because there is a
statement by that name.  You cannot name a variable SIN, because
there is a function by that name.

Comments
A comment is a portion of the program that the compiler ignores.
You use comments to leave reminders to yourself or others on how
portions of the program work, or why they are written the way they
are.  In The Animation Stand, comments begin with ; and
continue until the end of the line, no matter what is inside the
comment.

Spacing and Capitalization
Spacing is irrelevant.  Anywhere this manual shows a space or a
carriage return, one or more spaces, tabs, comments, and/or
carriage returns may be used.  Additionally, there are places in
which no space is shown in examples where there could be spaces.

Capitalization is irrelevant.  In these examples, everything is
shown in upper case.  This is for clarity only.  You may use upper
and/or lower case interchangeably in all variable names and
statement names.

Computations
To set a variable to a value, code

variable = expression
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This leaves us with the question of what an expression  is.  An
expression is a constant, or a more complex expression, such as
7*ABS(X/Y)+1

Statements

Rather than just list out the statements, we have listed them in
functional categories.  Each category leads to an article which
describes all the statements in that category.  If you are going to do
PF programming, it is probably best to read through this section
once, from front to back, and then use this section for reference.

In many of the statements that follow, there will be a requirement
for a point or a rectangle.  A point is a horizontal coordinate, a
comma, and a vertical coordinate.  A rectangle is a top coordinate,
bottom coordinate, left coordinate, and right coordinate, all
separated by commas.  If the top & bottom or left & right
coordinates are reversed, they are handled as if in the right order.
Horizontal coordinates are zero at the left edge of the document,
and increase to the right.  Vertical coordinates are zero at the top
edge of the document, and increase as you go down.  Rectangles
include their own top & left coordinates, but exclude their bottom
and right coordinate.  Thus, if top is 0 and bottom is 100, the
rectangle is 100 pixels tall, occupying lines 0 through 99.

Cursor handling

The cursor handling routines are used to hide and/or show the
cursor.

HIDE hides the cursor from view.  The cursor will not be seen
again until either the PF key program terminates, or the SHOW
statement is executed.  HIDE statements have no effect if the
cursor is already hidden.

SHOW makes the cursor reappear, if it was invisible.
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Several statements allow you to change the current color.

LOADCOLOR is used to load the color of a particular pixel in the
document as the current PF key program’s color.  The format of this
statement is:

LOADCOLOR point

If the coordinates specify a pixel that is not in the document, the
color loaded is white.

LOADOLDCOLOR is similar to LOADCOLOR, except that the
pixel value is loaded from the Undo area.

RGB is used to set the current color to a particular RGB value.  The
format of the RGB statement is:

RGB red component, green component, blue component

32 bits:  The requested color is used.  The allowable ranges for each
of the components are integers between 0 and 255, inclusive.
Negative numbers will be used as zero.  Numbers higher than 255
will be used as 255.

64 bits:  The requested color is used.  The allowable ranges for each
of the components are integers between 0 and 65,535,
inclusive.  Negative numbers will be used as zero.
Numbers higher than 65,535 will be used as 65,535.

SETPIXEL is used to set a particular pixel to the current color.
The format of this statement is:

SETPIXEL point

The pixel coordinates follow the rules from above, with two
exceptions.  The pixel is only set on the offscreen version of the
document, not on the screen.  If the coordinates specify a pixel not
in the document, nothing is done.
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LIGHTING is used to set a particular pixel to the current color,
and to apply the current lighting conditions at the same time.  The
format of this statement is:

LIGHTING point, directed_cosine_in_hundredths

The pixel coordinates follow the rules as above.  You must also
supply the directed cosine between the vector normal to the surface
of the plane of the pixel, and the vector from the pixel to the
lighting source.  Unless you are very familiar with solid trig, this is
best shown by example.  Let’s say that we want to paint the pixel at
72,144, and that pixel is supposed to be blue.  We somehow decide
that that pixel represents a portion of the surface of an object, and
that that object is slanted 45° down as the user views it, but is not
slanted in the left-to-right direction.  Let’s assume that the light is
coming from 15° of declination, 0° right ascension.  This would
mean that a line coming off the surface of the object at that point is
60° off from the direction of the incident light.  The cosine of this
angle is 0.5.

32 bits:  Thus, to paint this pixel, we would use

RGB 0, 0, 255
LIGHTING 72, 144, 50

 64 bits:  Thus, to paint this pixel, we would use

RGB 0, 0, 65535
LIGHTING 72, 144, 50

USERCOLOR is used to set the current color or pattern back to
the state it was in before the PF-key function began execution.
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The environmental control statements allow you to control the
painting environment, allowing you to choose modes, pens, where to
paint, and the like.

MODE allows you to set the painting mode to be used when
painting lines, rectangles, circles, et cetera.  The format of this
statement is:

MODE n

The argument specifies the mode’s icon position in the Mode
window, 0 to 30.  If the number is <0 or >30, Normal Mode, (mode
0) is used.   If you do not specify a mode, then the PF key program
uses the mode already selected by the user.

PEN allows you to set the pen size & shape to be used when
painting lines, rectangles, circles, et cetera.  The formats of this
statement are:

PEN height, width

and

PEN diameter

A pen of the specified height and width or diameter is used for
painting.  The minimum pen height, width, and diameter are each
one pixel, if zero or negative values are specified, 1 will be used.  PF
key programs begin execution using the current user brush or pen.

SCREEN causes painting performed by the OVAL, RECT,
FRAMEOVAL, FRAMERECT, and LINE statements to be painted
on-screen only.  When PF key programs begin execution, all of their
painting is on-screen only.  Thus, nothing painted by the listed
commands has any effect on the document.  Painting occurs in the
frontmost window only.  The SETPIXEL command is not affected by
this statement, as it always paints into the off-screen memory
holding the document.

OFFSCREEN causes painting performed by the OVAL, RECT,
FRAMEOVAL, FRAMERECT, and LINE statements to be painted
to the off-screen document memory only.  When PF key programs
begin execution, all of their painting is on-screen only.  If any
painting occurs, the document will be updated when execution ends.
The SETPIXEL command is not affected by this statement, as it
always paints into the off-screen memory holding the document.
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BOTH causes painting performed by the OVAL, RECT,
FRAMEOVAL, FRAMERECT, and LINE statements to be painted
to the off-screen document memory, as well as to the frontmost
document window.  When PF key programs begin execution, all of
their painting is on-screen only.  If any painting occurs, the
document will be updated when execution ends.

Direct painting

All of these statements paint something.  Depending on the current
settings, the painting will be done on the frontmost window, or into
the off-screen memory.  If any painting occurs, the document will be
updated when execution ends.

Experienced programmers:  When painting into the current
document window, the positions of the scroll bars, the position of
the window, the size of the window, obscured portions of the
window, portions of the window hanging off the screen, portions of
the window spanning multiple screens, and magnification are all
handled for you.  When you paint, you may just assume that you
are painting into the off-screen buffer, since there is no difference in
the way you paint.

All of these statements use the current pen setting, the current
color or pattern, and the current mode.  These settings all start out
as the user setting, but can be modified by the PF key program.

If any of the offscreen painting is made outside of the document, or
onscreen painting is made past the visible portion of the window,
that portion of the painting is ignored.

LINE is used to paint a line between the points you specify.  The
format of this statement is:

LINE starting point, ending point

The coordinates specified are the coordinate of the upper left-hand
corner of the pen.  The pen extends downward (by the pen height or
pen diameter) and to the right (by the pen width or pen diameter)
from this point.

RECT is used to paint a filled rectangle.  The format of this
statement is:

RECT rectangle

If a filled rectangle is painted with a special pen, or brush as the
current pen, then the current color is used to fill the rectangle, and
the pen shape is ignored.
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FRAMERECT is used to paint an outlined rectangle.  The format
of this statement is:

FRAMERECT rectangle

OVAL is used to paint a filled oval.  This statement is similar to
RECT, except that in OVAL, the coordinates define the boundaries
of the oval.

FRAMEOVAL is used to frame an oval.  This statement is similar
to FRAMERECT, except that in FRAMEOVAL, the coordinates
define the boundaries of the oval.

UPDATE is used to update the frontmost window to agree with the
off-screen version of the document.  If any painting occurs, all
windows of the document will be updated when execution ends.

Flow control

The flow control statements each allow you to execute, conditionally
execute, or re-execute a portion of your program.

IF allows your program to make decisions.  The format of this
statement is:

IF expression
   statements
[ELSE
   statements]
END

In the first format shown, the expression is evaluated.  If it is true
(it has a nonzero result), then the first statement or group of
statements (whatever is between the expression and ELSE) is
executed, and the second statement or group of statements
(between ELSE and END) are ignored.  If the expression evaluates
false (to a zero value), then the reverse occurs; the first group of
statements is ignored, and the second group is executed.

In the second format shown, the statement or statements are
executed only if the expression has a true (nonzero) result.  If the
expression is false (zero) then nothing happens, and execution
continues with whatever follows the END statement.
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For example, the following sets X equal to the greater of Y and Z,
and beeps if Y is used:

IF y>z
   x = y
   BEEP
ELSE
   x = y
END

This could just as well have been written as

if Y>Z X=Y beep else X=Z end

As another example, the following code beeps if X is nonzero:

IF x
   BEEP
END

WHILE allows you to have one or more statements executed a
number of times.  An expression is used to control the loop.  The
format of this statement is:

WHILE expression
   statements
END

The following steps are followed by The Animation Stand:

Step 1 The expression is evaluated.  If the value is false (zero),
then execution of the loop is over, and the statement
after END will be executed.  If not, Step 2 follows.

Step 2 The statements within the loop are executed.

Step 3 If escape is pressed, execution of the loop terminates,
and execution continues after the END statement.  If
not, execution continues at Step 1.

For example,

WHILE x=1
   statements
END

Here, the loop will execute while X is 1.

LEAVE ends execution of the innermost loop containing it.

For example, in

WHILE x=1
   WHILE y=1
      statements
      LEAVE
   END
END
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LEAVE will leave the inner loop each time it is executed,
continuing execution between the two END statements.  The outer
loop will continue to execute.  Thus, in this example, the outer loop
will execute, but the inner loop will never complete.

DONE ends execution of the PF key program.

For example, in

WHILE x=1
   WHILE y=1
      statements
      DONE
   END
END

DONE will terminate execution of the entire program.  Thus, in
this example, nothing will complete.

Other statements

These are the statements that fit into no well-defined category.

BEEP causes the system bell to sound, unless the system sound
has been turned off from the control panel.  In that case, the menu
bar will flash.

CLEARSELECT causes the select area (the area surrounded by
the “marching ants”) to be cleared.

SELECT adds a rectangle to the select area.  The format of this
statement is

SELECT rectangle

SAVE saves a portion of the document as an area, replacing the
previous undo area.  The format of this statement is

SAVE rectangle

Operators

In The Animation Stand, there are monadic operators (which act
on one number), and dyadic operators (which act on two numbers).
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These operators act on a single number, which appears to its right.
For instance, -1.

- negates the value to its right, exactly as in normal
arithmetic.

! takes the logical compliment of the value to its right.
The logical compliment of zero is 1.  The logical
compliment of all other numbers is zero.

These operators are evaluated before the dyadic operators, and are
evaluated right to left.  For example:

x = 0
y = 5
z = -!x + y

In this case, !X is evaluated to 1, and -1+Y is 4.  If we wanted to
change the order of evaluation, this could be done with parentheses:

z = -!(x + y)

Here, X+Y is evaluated to 9.  !9 is 0, and the result is 0.

Dyadic operators

These operators act on two numbers.  For instance, X-1.

| results in zero if both of its operands are zero, and a nonzero
value otherwise.  Thus, it is called “or” since it is “true” (a
nonzero value) if either of its operands is “true”, and “false”
(zero) otherwise.

& results in a nonzero value if both of its operands are nonzero,
and zero otherwise.  Thus, it is called “and” since it is “true” (a
nonzero value) if both of its operands are “true”, and “false”
(zero) otherwise.

<=, >=, <, >, =, and <> each result in a nonzero value if the relation
is true, and zero otherwise.

+, -, *, and / each represent the standard arithmetic operators.
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% represents the arithmetic modulus operator.  The modulus of
two numbers is computed by dividing the first number by the
second number, and rather than returning the result of the
division, return the remainder.  Thus,

a % b

is equivalent to

a - INT(a / b) * b

Order of precedence

The Animation Stand's programming language follows the same
rules as standard algebra.  When an expression is evaluated, the
following steps are followed:

Step 1 Evaluate everything in parenthesis and function
arguments as separate expressions.

Step 2 Evaluate the function results.

Step 3 Evaluate the results the monadic operators, proceeding
right to left.

Step 4 Evaluate the results of *, %, and /, proceeding left to
right.

Step 5 Evaluate the results of + and -, proceeding left to right.

Step 6 Evaluate the results of >=, <=, <, >, =, and <>,
proceeding left to right.

Step 7 Evaluate the results of &, proceeding left to right.

Step 8 Evaluate the results of |, proceeding left to right.

For example, in

a = 1
b = 2
c = 3
d = 4
e = 5
f = 6
g = 7
z = a<>b & c<>d | e=f & g=a*b+c*d
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The evaluation goes through the following steps:

z = 1<>2 & 3<>4 | 5=6 & 7=1*2+3*4
-! z = 1<>2 & 3<>4 | 5=6 & 7=1*2+3*4
*/ z = 1<>2 & 3<>4 | 5=6 & 7=2+12
+- z = 1<>2 & 3<>4 | 5=6 & 7=14
=<>… z = nonzero & nonzero | 0 & 0
& z = nonzero | 0
| z = nonzero

Functions

Niladic functions
Niladic functions appear in usage to be variables.  To get the value
of a niladic function, just use its name.  For instance, to set X equal
to the value of the MOUSEPRESSURE function, just code

x = MOUSEPRESSURE

All of these functions are used to return some sort of status
information.

MODE returns the current mode number, 0 to 23.

MOUSEPRESSURE returns a nonzero value when the mouse
button is down and the stylus is not in use, or when the stylus is in
use and at full pressure.  This function returns 0 when the stylus is
below it's threshold pressure while in use.  The function returns
values between 1 and 255 for pressures between the stylus'
threshold and maximum pressures.  These values are returned
whether or not the Pressure affects flow or Pressure affects
width items are set from the Preferences dialog.

MOUSEX reports the mouse’s horizontal position within the
window.  The position reported is the number displayed in the
status box after X=.  This function also takes note of the mouse’s
vertical position within the window.  The vertical position is noted,
but not yet reported.
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MOUSEY reports the mouse’s vertical position within the window.
The position reported is the number displayed in the status box
after Y=.  The position reported is not the current position.  Rather,
it is the position of the mouse the last time MOUSEX was called.
This is so that coordinates will be reported in consistent pairs.
Thus, calls to MOUSEX and MOUSEY should occur with MOUSEX
first, and normally in pairs.  Do not use MOUSEX and MOUSEY
together within a statement that requires several arguments, such
as LINE and OVAL, each of which take four arguments.  There is
no guarantee which of the arguments will be interpreted first.
Thus, rather than

LINE 0, 0, MOUSEX, MOUSEY

use

x = MOUSEX
y = MOUSEY
LINE 0, 0, x, y

DOCHEIGHT reports the document (not window) height, in pixels.
Thus, the number reported is the number of the first line of pixels
past the extent of the document.

DOCWIDTH reports the document (not window) width, in pixels.
Thus, the number reported is the number of the first column of
pixels past the extent of the document.

PENHEIGHT reports the pen height, in pixels.  If the pen is
round, this is the same as the pen diameter.

PENWIDTH reports the pen width, in pixels.  If the pen is round,
this is the same as the pen diameter.

PENROUND returns a nonzero (true) value if the pen is round,
and zero (false) if it is not.

MODE reports the number of the current painting mode, 0 to 31.

SELECTTOP returns the number of the first line of pixels in the
select area.  If there is no select area, this function will return zero.

SELECTBOTTOM returns the number of the first line of pixels
not in the select area, actually the number of the line of pixels just
past the last line of pixels in the select area.  If the select area is
empty, this function returns zero.

SELECTLEFT returns the number of the first column of pixels in
the select area.  If there is no select area, this function will return
zero.
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SELECTRIGHT returns the number of the first column of pixels
not in the select area, actually the number of the column of pixels
just past the last line of pixels in the select area.  If the select area
is empty, this function returns zero.

BLENDLEVEL returns the current Blend level setting of the
Blend Mode.  This value is set in the blend dialog, which appears
when the Blend Mode is edited.  The result will be between 0 and
100.

PIXLEVEL returns the current Pixelization level setting.  This
value is set in the Set Pixelization dialog, which appears when the
Blur, Pixelize, or Smudge Tool is edited.

32 bits:  RED returns the value of the Red component of the
current color, if there is one.  If the “current color” is actually a
pattern, a negative value is returned.  Normal results are between 0
and 255.

GREEN returns the value of the Green component of the current
color, if there is one.  If the “current color” is actually a pattern, a
negative value is returned.  Normal results are between 0 and 255.

BLUE returns the value of the Blue component of the current color,
if there is one.  If the “current color” is actually a pattern, a
negative value is returned.  Normal results are between 0 and 255.

64 bits:  RED returns the value of the Red component of the
current color, if there is one.  If the “current color” is actually a
pattern, a negative value is returned.  Normal results are between 0
and 65,535.

GREEN returns the value of the Green component of the current
color, if there is one.  If the “current color” is actually a pattern, a
negative value is returned.  Normal results are between 0 and
65,535.

BLUE returns the value of the Blue component of the current color,
if there is one.  If the “current color” is actually a pattern, a
negative value is returned.  Normal results are between 0 and
65,535.

? returns a random number, somewhere between zero and 255.  All
numbers are equally as likely.

REASON returns the reason the PF-key program was run, 0 for
tool selection, 1 for tool edit, 2 for tool use, and 3 for use from the
exposure sheet.
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Monadic functions
Each of the monadic functions consists of a function name, and then
an expression in parenthesis.  Each of these functions performs a
standard mathematical function.  As in standard mathematics, all
trigonometric functions use radians, rather than degrees.

For example, to set X to the absolute value of Y, use

x = ABS(y)

ABS(x) returns the absolute value of a number.

SIN(x) returns 100 times the sine of the angle in degrees.

COS(x) returns 100 times the cosine of the angle in degrees.

Dyadic functions
The dyadic functions break down into two categories.  Some
(POWER, MIN, MAX, and ATAN2) function mathematically on a
pair of arguments.  The form of these functions is:

function name(first argument, second argument)

Other functions (INSELECT and INMASKED) determine
attributes of a point.  The format of these functions is:

function name(horizontal coordinate, vertical coordinate)

POWER(b,p) raises its first argument to the power specified by the
second argument.  For instance,

POWER(x,3)

raises X to the third power.

MIN(x,y) returns the lesser of its two arguments.

MAX(x,y) returns the greater of its two arguments.

ATAN2(x,y) takes two arguments.  The first argument is
proportional to the sine of some angle, while the second argument is
proportional to the cosine of the same angle.  This function returns
the angle which generated the two arguments, in degrees.

INSELECT(x,y) returns a nonzero (true) value if the point
specified is in the select area (the “marching ants”), and zero (false)
if not.

INMASKED(x,y) returns a nonzero (true) value if the point
specified is in the protected area (the “flashing”), and zero (false) if
not.
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The distribution tape contains several sample programs.
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Key Meaning
Esc Cancel or Stop
Tab Use Syringe tool
Delete Clear area
Caps Lock Suspend updates of Current Frame Window
Shift Add to area or first alternate function
- Subtract from area
Left mouse Select item when clicked

Select sub-item menu when held
Middle mouse Second alternate function or Edit item
Right mouse Menu
Ctrl Hide cursor
A Select Paintbucket tool
S Select Delete bucket tool
D Select Move bucket tool
F Select Edit bucket tool
Z Select Start spline tool
X Select Add on-point tool
C Select Add off-point tool
V Select Delete spline point tool
B Select Move spline point tool
ALT Invoke menu item
ALT-A Select all
ALT-C Copy
ALT-D Merge
ALT-E Expand
ALT-F Field guide
ALT-G Change text fields
ALT-Shift-G Change numeric fields
ALT-H Resize
ALT-J Play or Record
ALT-K Compile
ALT-L Add layers
ALT-M Save animation (Save as from Animate menu)
ALT-N New cel window
ALT-O Open
ALT-Shift-O Open as palette
ALT-P Print exposure sheet
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ALT-Q Quit
ALT-R New film/current frame windows
ALT-Shift-R New text window
ALT-S Save
ALT-V Paste
ALT-Shift-V Paste file name
ALT-W Close

Key functions (continued)

ALT-X Cut
ALT-Y Unprotect
ALT-Shift-Y Discern line
ALT-Z Undo
ALT-1 Set new cel size
ALT-2 Preferences
ALT-3 Set DPI
ALT-4 Snap to grid
ALT-5 Visible grid
ALT-6 Lightbox
ALT-8 Next cel
ALT-Shift-8 Previous cel
ALT-9 Play sound file
ALT-- Set playback
ALT-= Save area
ALT-[ Check exposure sheet
ALT-] Paste before
ALT-Shift-] Insert
ALT-` Declutter
ALT-; Generate hard alpha
ALT-, Page flip
ALT-/ Generate soft alpha
ALT-\ Set alpha to white
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Response Meaning
1 Operation complete
2 Communications error
3 Lid open
5 Frame not found
6 No frame number
7 Mark return (should not occur)
10 Executing
11 Can't execute
-128 Not a real error code, but indicative of an

improper baud rate setting in the
recorder.  Turn the recorder off, set it to
9600 baud, and turn it on again.

Note that when a failure occurs, The Animation Stand may be
unable to switch the recorder back to E/E mode, so in single monitor
configurations, you might not see error codes.  In this case, your
only hint will be that the system stops running.  To alleviate this
situation, and to see the resulting error message, you will have to
return the recorder to manual operation, set E/E mode, and then
return to remote operation.
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Response Meaning
? Invalid VTR type or numeric transmission
A Unexpected command termination
B Lost VIFC during preroll
D Recording finished
E Preroll complete
F Frame located (should not occur)
G Ready for Grab program (should not occur)
H Ready for SMPTE Grab (should not occur)
I Acknowledgment
K Frame too far for search
M Preroll failed
N Frame not found/missing VIFC
O Timed out waiting for computer
P Ready to accept programming
Q Ready for SMPTE programming
R Ready
S Playback done/rewound (should not occur)
U Ready for pure time code (should not occur)
V No input video
X Record cut-in
Y Record cut-out
Z At signal (should not occur)
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Response Meaning
A3 Ampex VPR-3
A6 Ampex VPR-6
A8 Ampex VPR-80
AB Abekas A60
AT Ampex VPR-80 w/SMPTE
H3 Hitachi HR-230
JU JVC CR-850 series, PR-900 E
JV JVC BR-S810E, S811U
P5 Panasonic AU60, AU650
P6 Panasonic AU660
P7 Panasonic AG-7550
PS Panasonic AG-7500
S5 Sony VO-5850, 5850P
SB Ampex CVR-40, Sony BVW-40
SC Sony BVH-2000 series
SD Sony BVH-2500
SF Sony BVH-3000
SG Sony BVU-950
SH Sony BVU-950 w/SMPTE
SL Sony LVR-5000 (use direct connection, rather than

controller)
SM Sony VO-9850, 9850P
SN Sony VO-9850 w/SMPTE
SP Ampex CVR-70, 75, Sony BVW-70, 75, PVW-2800
SR Sony DVR-1000
SS Sony DVR-10
SU Sony BVU-800 series
SV Sony BVU-800 series w/SMPTE
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Still have some questions?  You may find the answer here.

Why doesn't my program start?  It just says something about a
serial number.  This is indicative of running on the wrong machine
or installing the wrong tape.  Reinstall, and try again.  If there is
still a problem, call your dealer, or Linker Systems at 714-552-1904.

What is the limit on the number of files and their combined
size?  You may use 32,767 files in any one Exposure sheet, with
no size limit.  Any number of Exposure sheets may be linked
together.

Which file types can be read?  Our own, plus TIFF, Targa, and
virtually every Unix format.

What is the best way to antialias all the cels?  See the article
on high-resolution painting & scanning.

How do I set up Chroma Key?  Chroma Key is a hardware
function.  You’ll have to check your hardware manuals for that.  To
set up Alpha Blanking, choose alpha as your background color.  You
may also have to do certain hardware-related functions.

How do I generate Super-Black or Sub-Black?  These are both
a name for an NTSC composite signal value which is represented by
a negative luminosity value.  The usage of superblack is often to
control matting.  In the digital setting, we generally use the alpha
channel.  See above.  Depending on your hardware configuration,
you can use the alpha channel to (a) control mixing within the
computer, (b) use an alpha output line to control your studio mixer,
or (c) use an encoder to translate alpha to superblack.

When I move one layer over another layer, the foreground
layer has a white, rather than transparent, background,
obscuring my background layer.  How do I correct for this?
In each layer of the Exposure sheet in which the file name appears,
place the key-word WHITE in the Notes field.

If I have a character going through motions, where is the
best place to put the character’s registration point?
Depending on the type of action, between the eyes, at the heart, or
at the soles of the feet.
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Can I transfer an image to a matte?  Yes, but don't.  Use the
Faded Edges or True Antialiasing modes in the Set Playback
dialog of the Animate menu.

When I use a smooth Move, why does my image seem to
jitter?  You need higher resolution.

Why doesn’t The Animation Stand do automatic
inbetweening (tweens)?  There's no substitute for a good artist.

Why do antialiased images created in PhotoShop have a
white fringe?  PhotoShop delivers a perfect  visual image, and a
perfect antialiased image.  Unfortunately, what you need is a
perfect antialiased image and an edge-biased visual image.  Do the
biasing yourself by painting your PhotoShop document on a
background almost the same color as your image.  For instance, if
you're painting black text, paint it on a 99.5%-black  background.

Which scanner should I use?  For finished art, use a flatbed or
auto-feed scanner.  If you use a flatbed scanner, any one will do.
It’s nice to have variable scan resolution.  Also, glue a set of Acme
pegs onto it, using rubber cement.  You may have to drill holes in
the cover.  If you want a nice, fast bulk-load scanner, use the
Fujitsu M3097G.
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A
BEEP 154
Before You Begin 1
Bell 133

A66 93 Bend 117
AB AB 96 Best-fit tools 128
Abekas 2 BLACK 51, 80, 136
Aborting an Operation 4 Black and white 68
About 63 BLACK-BG 51, 135
ABS 158 BLACK-ONLY 136
Add 106 BLEND 51, 106, 136, 139
Add layer 54 Blend edit 107
Add layers 88 BLENDLEVEL 51, 136, 145, 157
Adding a Layer to the End of a Frame 33,
43

blob 117
BLUE 136, 157

Adding Special Effects 18, 27 Blur 129, 140
Advanced Techniques 61 Boolean modes 136
Airbrush 58 Both 93, 151
Airbrush tool 131 Bounded Fill 121
Allow links 91 Brush loader 114
Alpha compositing 139 Brush loader tool 116
ALPHA-BG 51, 135 Bulb/point slider 129
AND 51, 106, 136 Bulb/point spot 129
Animate 63, 88

CAnimation 29
Animation tools 44
antialias 165 Calculate 63
Antialiasing 135 Caps Lock 51
Apply shadow 54 CDROM 1
arc 111 Center 108, 109
Arc tools 111 Centered reg 91
Art Director 114 Change 73, 76
Art Director tool 116 Changing the Top and Left Fields 37
ARTI 93 Character shading 56
ATAN2 158 Check exposure sheet 88, 90
Auto-Paint 122 Chroma Key 165
Avoiding Jitters 61 Circular wash 57, 106

B
Circular wash edit 109
Clear 73, 108
Clear all 73

BA BA 96 CLEARSELECT 154
Background color 80 Clipping levels 67
Backgrounds 135 Close 64, 69
BACKLIGHT 144 Color 68
BCD 93



226    The Animation Stand

Color handling 150 DONE 154
Color Picker 105, 115 DPI 68, 78
Color slop 78, 120 Drawn path 48
Color store 114

EColor tools 113
Color wheel 114

Edge antialiasing 79Comments 149
Edges 94Compile 77
Edit 63, 73COMPOSITE 51, 123, 135, 139
Edit Bucket 122COMPUTE 51
Effects 63, 84Content Area 52
Encrust 107Contrast 67
Encrusting 83Control Area 52
End of Film Marker 33Copy 54, 73, 74, 113
Environment control 151Copy onto cube 127
Eraser 123COS 158
Eraser tools 123Creating Animation  & Playing It 9
escape 4Creating Final Output 19
Exact match 76Creating the Elements 9
Exclusive or 106Crop 67, 84
Expand 88, 89, 120Cross dissolve 51
Expand by 121Current Frame 30
Exposure sheet 30Current Frame window 51
Extrude 127Cursor handling 149

F
Cut 73, 74

D Fade in from black 51
Fade in from white 51DARKEST 135
Fade to black 51De-regionize 64, 72
Fade to white 51Declutter 68, 139
FADED 135Declutter  84
FADER 51, 139Decrease saturation 131
Faders 139Defocus 94
Fades 49, 50Delete Bucket 121
Fast forward 54Deleting Lines 33, 43
Fast rotates 91Depth 68
Faster/Larger 91Determining scan DPI 56
Feeder 68Diaquest 93
Field guide overlay 77Dies 68
Fields 31Diffuse spot 129
File 43, 63Direct painting 152
File Field 35Disabled notes 94
Files Included 3Discard 70
Fill Selected Area 121Discern line 84, 85
Fill with Protection 121Display 94
Fill with Selection 121distortion tools 117
Film 34DOCHEIGHT 157
Filter 69Document info 64, 72
filters 36DOCWIDTH 157
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Flat/glossy slider 129
IFlatter 133

flip 117
Icon animation 80Flow control 152
Iconic Format 42Flow of Work 58
Iconic interface 21Focus Effects 59
IF 153Focusing effects 140
Ignore background 120Fold onto cube 126
Ignore draw color 120Fonts 63
Image Files 4Frame 42, 51, 141
inbetweening 165Frame Field 32
Increase saturation 131Frame moves 141
INMASKED 158FRAMEOVAL 152
INSELECT 158FRAMERECT 152
Insert 73, 74Framing rate 92
Insert empty frame 44Free draw tools 110
Insert empty layer 44frisket 58
Insert frames 50Full screen 93
Inserting a cycle 41Full-speed run 97
Inserting lines 33, 43Functions 63, 156
Installing an external controller 2

G Installing The Software 1
Intensity 67

GEL 51, 57, 107, 142 Interleave 96
Gels 142 Interpolations 44
General 63 Invert alpha 84, 91
General Topics 55 Invert luminosity 131
Generate 84

KGenerate TEXT file 88
Getting started 1

Key functions 161GLOW 51, 57, 143

L
GPI pulses 93
Grays 68
GREEN 136, 157 Label 43
Grid size 78 Label Field 34
Group sets 83 Layers 33, 92

H
Learn 67
LEAVE 154
Left 37, 148height 77, 101
Legalize 88, 139HIDE 149
Legalize area 84High Resolution Painting & Scanning 55
Legalize palette 84Higher 133
Leica 88Hitachi 2
Lightbox 77, 82Hls 110
Lightbox dialog 81Hold 38, 68, 69
LIGHTEST 135Hsv 110
LIGHTING 150HSV block 114
Lighting edit 128HSV block change 84, 87
limit 165HSV spread 114
LINE 152
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Line Art 8 Next cel 64, 72
Line tool 118 None 83, 94, 96
Links to Another Exposure sheet 35 Normal 93, 94, 95, 106
LOAD 51, 144 Notes 41, 63
LOADCOLOR 150 Notes= 95
Loading Multiple Files 36

OLOADOLDCOLOR 150
Logarithmic zoom 46

OCR 69Loop 91
OFF 51, 144Lyon-Lamb 93, 163
OFFSCREEN 151

M Oil 106
Open 64

Mag 39, 148 Open as palette 64, 66
Magic Eraser 123 Open document at 78
Magnification 39, 113 Operators 154
Magnification tool 113 Opticals 135
Management Reporting 20 Options 63, 76
Manipulating the Elements 14, 21 OR 51, 106, 136
map 128 Order of precedence 155
Mask 95 Other user-defined 126
MATTE 51, 138 Output 8
Matting 137 OVAL 152
MAX 158 Oval tools 118
MAXIMUM 51, 106, 144 OVER-GEL 58
Maximum change 94 OVER-GLOW 58, 143
Memory control 144

PMenu items 63
Merge 74, 84

Page flip 88, 96Merge alpha 84
Paint 99MIN 158
Paint behind bucket 121MINIMUM 51, 95, 106, 144
Paint Effects 139minus 119
Paintbucket tools 120Mod 40
Palette 71, 101MODE 151, 156, 157
Palette cycle 107Modes 106
Palette cycle edit 109MOUSEPRESSURE 156
Palette Files 3MOUSEX 156
Pantograph 33, 45MOUSEY 156
Pantograph Edit 47Move 33, 45, 54, 113
Partial color 106Move Bucket 121
Paste 73, 74Movement tools 112
Paste before 73, 74Multiple scans 68
Patch 68, 85, 139

N Patch lines 84
Pattern Files 4

Name 69 Patterns 71
New Cel 63, 64 Pegs 68
New film 63, 64 PEN 151
New text 63, 64 Pencil Testing 8
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PENHEIGHT 157 Regionize 64, 68, 72
PENROUND 157 Register by 68
Pens 100 Registration tool 118
PENWIDTH 157 Regular Polygon 118
PF keys 71 Relationship of the Exposure Sheet &

Current Frame Windows 31PF tools 131
PF-keys 144 Relight 127
PIC-ONLY 51 Remove layer 54
Pick Color 114 Resize 54, 84
Pick Color tool 116 Resizing 113
Picture only 144 Resolution 95
Pictures 35 Reversed mask 95
Pixelization tools 129 Revert 64
Pixelize 130 Rewind 54
PIXLEVEL 140, 144, 157 RGB 114, 150
Play 54 RGB and HSV spread 115
Play or record 88 RGB block 114
Play sound file 88 RGB block change 84, 85
Polygon tools 117 Room light 129
Portrait 68 Room light only 129
POWER 158 Rotate 54
Pre-scan for DPI 80 Rotation 40, 117
Preferences 71, 77, 78 Round 101
Pressure affects flow 80 Rounded rectangle tools 119
Pressure affects width 80 RS-422 2
Preview 67

SPrevious 83
Previous cel 64, 72

Sample programs 159Print 73
Sanyo 3Product Support 3
Save 70, 154Programming 147
Save  64Protect 107
Save all 71pulldown 88
Save area 64, 70

Q Save as 88, 97
Scan 64, 66, 67

questions 165 Scan-based antialiasing 55
Quit 64, 73 scanner 166

R
SCREEN 151
Script 7
Scroll tool 118

RACK 140 Select 107, 154
Random pixels 132, 133 Select all 73
REASON 158 Select as drawn 120
Recolor 54 SELECTBOTTOM 157
RECT 152 Selecting Frames 32
Rectangle tools 112 Selection tools 119
RED 157 SELECTLEFT 157
Reduce to 88 SELECTRIGHT 157
Reference 161 SELECTTOP 157
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Self-colored line 58 Store tool 115
Send back 54 Storing a Color into the Color Palette 115
Send forward 54 Storing a Pattern into the Pattern List

116Separate alpha 84
Set alpha to 84 storyboard 88
Set DPI 77 Straight 132
Set new cel size 77 Stretch 54
Set playback 88, 91 Sub-Black 165
SETPIXEL 150 Sub-pixel antialiasing 55
Setting Up the Exposure sheet 13, 21 SUBTRACT 51, 106, 145
SHADOW 51, 145 Super-Black 165
Shoot frame 44 Syringe 114
SHOW 149

TShow clipboard 73
Shrink select 120

Tape posn 91Shrink to object 120
tar 1Sight 93
TAS 5Silhouettes 94
technical support 3SIN 158
Testing the Animation 17, 26Sine 133
Text tool 112Size 63, 95
Texture Files 4Sloppiness 136
Texture mapping 83SMPTE 92
The Steps in Animation 7Smudge 130
Thinner 133Snap to grid 77, 80
Tilt 117Sony 2, 93, 162
Title Area 32Sort palette 84
Tools 53, 106Sound 93
Top 37, 148Sound Files 36
transfer an image to a matte 165Sound-Track 7
Transitions 44, 49Spacing 101
Transparency modes 136Spacing is irrelevant.  Anywhere this

manual shows a space or a carriage
return, 149

True Antialiasing 94
Tutorial Files 3
tweens 165Special Effects Lines 33, 43
Twist 117Sphere 109, 132
types 165Spline 33, 45, 111

U
Spline Edit 48
SPOTD 148
Spotlight 129 Underlying image 80
Spotlight only 129 Undo 73, 107
SPOTRA 148 Undo mode edit 110
Spreadsheet Format 30 Unprotect 84, 121
Spreadsheet Interface 9 UPDATE 152
Starburst Fade 61 Use background color only 120
Start-up options 5 Use draw color only 120
Statements 63, 149 Use HSV mode edit 110
Step back 54 User toolbox 133
Step forward 54 User-defined sphere 125
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User-defined wash edit 108
User-defined watercolor 106
USERCOLOR 151
Using a  variable-timing picture file set
41
Using a series of Picture files 40

V

V.Mag 39
V/LAN 93
Variables 63, 148
Vertical Magnification 39
Video 34
View 67
Visible grid 77, 81
VMAG 148

W

Wash to 79
Water-drop smudge 131
Watercolor ramp 106
What 93
When to Composite 60
Where 93
WHILE 153
WHITE 51, 80, 136
WHITE  95
Wider 133
Width 77, 101
Wipes 49
Writing Optical Notes 8
Writing the Exposure sheet 8

X

XOR 51, 136


